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Concepts and glossary

In this chapter

• Concepts on page 12

• Glossary on page 26
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Concepts
In this section

• Message on page 12

• Design Center Projects on page 12

• Platforms on page 13

• Message configurations on page 13

• Runtime configurations on page 15

• Input connectors on page 17

• Output connectors on page 17

• Input queues on page 18

• Output queues on page 18

• Resources on page 18

• Resource sets on page 18

• Platform layers on page 19

• Output modes on page 20

• Output mode Process on page 20

• Output mode Document on page 21

• Output mode Job on page 22

• Input Analyzer on page 23

• Project export and deployment on page 24

Message
A Message is a tree structure of tagged fields and blocks. The Message is used 
internally by the StreamServer when transforming input documents into output 
documents.

The Message is independent of the input and output format. This means the 
StreamServer can receive input in any format, transform the input into a Message, 
and then transform the Message into any output format.

Design Center Projects
A Design Center Project constitutes the configuration used by a StreamServer 
application to collect, transform, and deliver data. In Design Center, you create 
and configure the Project. Then you export the Project, and deploy it to the 
appropriate StreamServer application.

A StreamServe Project contains the following main components:

• Platform (see Platforms on page 13)
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• Message configuration (see Message configurations on page 13)

• Runtime configuration (see Runtime configurations on page 15)

• Resource set (see Resource sets on page 18)

Platforms
The Platform represents the StreamServer application to which the Project is 
deployed, and contains the environment settings for that StreamServer 
application. This includes available connectors, queues, and paths used to find 
local resources. 

The Platform is divided into one generic layer (settings that apply to all physical 
environments) and one physical layer per target environment (development, test, 
etc.). See Platform layers on page 19 for more information about layers.

Message configurations
A Message configuration defines:

• How to identify documents in the input job.

• Which parts of an input document to extract.

• How to create a Message.

• How to use the Message to create the output documents.

The part of the Message configuration that extracts the input documents and 
creates the Message is called Event, and the part that creates output documents is 
called Process.

A Project normally contains several Message configurations, where each 
Message configuration corresponds to a specific document type. For example, 
one Message configuration for invoices, another for orders, etc.

References

• Message on page 12

• Events on page 13

• Processes on page 14

Events
An Event defines how to identify documents in the input job, which parts of an 
input document to extract, and how to create the Message.

Trigger patterns

An Event is triggered by patterns in the input data. When a matching pattern is 
found, the Event starts to extract data from the input and creates the Message.
StreamServe Persuasion SP5 Design Center User Guide Rev B
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Message definition

The instructions on how to create the Message, i.e. a tree structure of named fields 
and blocks, are defined in the Event. When the data is extracted from the input, 
the Event uses these instructions to map non-recurring input data to fields at root 
level, and recurring data to fields in blocks.

Different input formats

There are different types of Events adapted to different types of input:

• Page based

• Field based

• Record based

• XML based

• Preformatted (e.g. PDF)

Event tools

You use different types of Event tools to configure Events.

Processes
A Process defines which fields and blocks in the Message to use, and how to 
organize the fields and blocks in the output documents.

Different output formats

There are different types of Processes adapted to different types of output:

• Page based

• Record based

• XML based

Page layout and text formatting

Processes for page based output also defines the page layout (position of text, 
graphics, etc.) and text formatting (font, font size, hyper links, etc.).

Event tool Input format

PageIN Page based.

StreamIN Field and record based.

XMLIN XML structured.

PreformatIN Preformatted (e.g. PDF).

MessageIN XML structured.
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Process tools

You use different types of Process tools to configure Processes. 

Runtime configurations
A Project can contain several Runtime configurations, for example one Runtime 
configuration per document type (Message configuration). The Runtime 
configurations in a Project connects Message configurations to the Platform, i.e. 
they specify the document types to be handled by the StreamServer application.

The Runtime configuration view

Each Runtime configuration is represented by a Runtime configuration view in 
Design Center. This view includes all connectors created in the Platform, and all 
Message configurations added to the Runtime configuration.

Collection of input jobs

For each Message configuration, you must specify from where to collect the input 
job. You do this in the Runtime configuration view by connecting the input 
connector that retrieves the input job, to the Event that extracts documents from 
the input job.

Delivery of output documents

For each Process in a Message configuration, you must specify where to deliver 
the output. You do this in the Runtime configuration view by connecting the 
Processes to the appropriate output connectors.

Runtime jobs and Post-processors

See Runtime jobs on page 16 and Post-processors on page 16.

Process tool Output format

PageOUT Page based.

StoryTeller Page based

StreamOUT Record based.

XMLOUT XML based.

MailOUT Text or HTML based. Used for sending emails. Files can 
be attached.

MessageOUT XML based.

RedirectOUT Same as the input format.

SMSOUT Text based. Used for sending SMS messages.
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Runtime jobs
A Runtime job is a grouping of one or several Message configurations in a 
Runtime configuration.

Job scope

A Runtime job starts when the first of its documents is found in the input job, i.e. 
when the first Event in the Runtime job is triggered.

A Runtime job ends when the last of its documents retrieved from the input job 
has been processed and delivered from the Processes.

Document definitions

For each Runtime job and output connector, you can define Documents. A 
Document includes output from Processes in the same Runtime job. See Output 
mode Document on page 21 for more information.

Connector settings

The Runtime job enables you to configure connector settings that apply to all 
included Processes:

• Job Begin settings – applied before the Runtime job starts.

• Job End settings – applied after the Runtime job ends.

• Document Begin settings – applied before each Document. 

• Document End settings – applied after each Document.

Sorting

The Runtime job enables you to sort the documents extracted from the input job 
before the output jobs are created. For example, when using output mode 
Document, you may have to sort the input documents before the output 
documents are created. See Sorting documents on page 165 for more information 
about different types of sorting.

Post-processors
A StreamServer can store page formatted documents in a Post-processor 
repository. These documents can later be retrieved and processed by any 
StreamServer with access to the repository. To retrieve documents from a Post-
processor repository, you must add a Post-processor to the Runtime 
configuration.

Process links

A Post-processor always includes a default Process Link, which is used as the 
connection point to the output connector. To enable Process specific or Page 
specific output connector settings, you must add a new Process Link to the Post-
processor job. This Process Link must be linked to the Process that stored the 
corresponding document in the Post-processor repository.
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Input connectors
Input connectors are the channels through which input jobs are received. You 
create the input connectors in the Platform, and in the Runtime configuration you 
specify to which Events to deliver the input jobs.

Connector type

There are different types of input connectors. Which type to select depends on 
how the input jobs are retrieved from the source application. For example, if the 
source application stores output files in a directory, you can use a Directory input 
connector to retrieve the files from the same directory.

Queue

You can connect input queues to the input connectors. The input queue stores 
input jobs before they are processed by the StreamServer.

Output connectors
Output connectors are the channels through which output jobs are delivered. You 
create the output connectors in the Platform, and in the Runtime configuration 
you specify from which Processes to collect the output.

Connector type

There are different types of output connectors. Which type to select depends on 
how the output jobs are delivered to the target application. For example, if the 
target application is a printer, you can use a Spool output connector to deliver the 
output to the printer.

Driver

If the output connector delivers page formatted output to the target application, 
you must add the appropriate device driver to the output connector. For example, 
if the target applications a PCL printer, you must add the appropriate PCL device 
driver to the output connector.

Queue

You can connect output queues to the output connectors. The output queue stores 
the output jobs before they are delivered to the target application.

Output mode

You must specify the appropriate output mode for each output connector. See 
Output modes on page 20 for more information about output mode.

Runtime configuration connector settings

The connector type and device driver settings you configure in the Platform are 
the default settings that will be applied in all Runtime configurations in the 
Project. In each runtime configuration, you can override the default settings.
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In the Runtime configurations, you can also configure connector settings that will 
be applied before or after the Runtime job, and before or after each Document in 
the Runtime job. For example sheet layouts, OMR codes, and enveloping.

Input queues
An input queue stores input jobs before they are processed by the StreamServer. 
It queues input jobs if more jobs are sent to the StreamServer than it can process. 
In case of an unexpected StreamServer shutdown, the queue also provides 
robustness since it enables the StreamServer to reprocess the input jobs when it is 
restarted.

Several StreamServer applications can share the same input queue. This provides 
possibilities for scaling over multiple StreamServer applications.

Output queues
An output queue stores the output jobs before they are delivered to the target 
applications (printers, faxes, etc.). It queues output jobs if the StreamServer 
creates more output jobs than it can deliver. In case of an unexpected 
StreamServer shutdown, it also provides robustness since it enables the 
StreamServer to reprocess the output jobs when it is restarted. 

Several StreamServer applications can share the same output queue. This 
provides possibilities for scaling over multiple StreamServer applications.

Resources
All external files that you refer to when you configure a Project must be available 
to the Project as resources. A resource in this context is a file with an embedded 
source file. For example, to be able to use the image file logo.gif in a Project, 
this file must be embedded in a resource. Resources are stored on disk, for 
example in the local Project directory, or in a directory shared by several Projects.

Resource examples

• Overlays – layouts to include in page formatted output.

• Images – images to include in page formatted output.

• Filter chains – a collection of filters that can be used by a connector.

Resource sets
Resources (overlays, images, filter chains, etc.) must be available to the Project 
components (Platforms, Message configurations, and Runtime configurations) 
via resource sets. A resource set is a set of links to physical resource files stored 
on disk.
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For example, if you want to add the overlay resource ovlHeader.lxf to a 
PageOUT Process, a link to this resource must be included in a resource set 
connected to the PageOUT Process (i.e. to the Message configuration that 
includes this Process). The PageOUT Process will then use this link to access the 
actual resource.

The default resource set

When you create a Project, a default resource set is automatically added to the 
Project. This resource set is automatically connected to all Project components 
you create from within the Project. This means all resources added to the default 
resource set are available to all Project components. If you want to use other 
resource sets, you must manually connect them to the Project components.

Platform layers
The Platform is separated into one generic layer and one physical layer per target 
environment. For example, you may have the following target environments:

• Development

• Test

• QA

• Production

In this case the Platform must have four physical layers – one for the 
Development environment, one for the Test environment, etc.

Runtime configuration layers

A Runtime configuration is based on the Platform, and inherits the generic and 
physical layers from the Platform. For example, if the Platform is separated into 
a Development, Test, QA, and Production layer, the Runtime configuration will 
also be separated into the same layers.

Generic layer settings

The generic layer includes settings that must be the same in all target 
environments. These settings must be tested in all development and test 
environments before the production layer is deployed. For example, you cannot 
develop and test output using a PDF driver, and then use an AFP driver in the 
production environment. In this case you must use an AFP reader in the 
environments that have no access to the actual printer.

Physical layer settings

The physical layers include environment specific settings. For example, the paths 
for input and output jobs will probably not be the same in the development and 
production environment.
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The same Design Center Project in all target environments

The separation of the Platform into layers enables you to use the same Design 
Center Project in all target environments. When you export the Project, all 
physical layers are included in the same export file. When you deploy the Project 
to a StreamServer application, you specify which physical layer to deploy and 
run.

Reuse of Platform settings

The generic Platform layer contains settings that apply to all target environments. 
This means you only have to configure these settings once, no matter how many 
physical layers you must create. When you create a new physical layer, you create 
a copy of an existing physical layer. Then you only have to edit the environment 
specific settings in the new physical layer.

Output modes
The output mode specifies how to group documents before they are delivered via 
the output connector to the target application. There are three different output 
modes:

• Process – See Output mode Process on page 20.

• Document – See Output mode Document on page 21.

• Job – See Output mode Job on page 22.

Which output mode to use depends on the type of output and target application. 
The default output mode Process can be used in different types of scenarios. In 
other scenarios you may have to use output mode Document or Job.

Output mode Process
In output mode Process, the output connector delivers the output as it arrives from 
a Process. This means each output document is delivered separately.

Process mode scenario

In this scenario, you have a Runtime job that contains one Process that delivers 
invoices to a printer via a Spool output connector. If you select output mode 
Process, the output connector delivers each invoice separately.

Figure 1 Output mode Process.
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Output mode Document

What is a Document?

A Document is an output job sent via an output connector to the target application. 
It includes output from Processes in the same Runtime job, and the scope of the 
Document is specified using a Document trigger. The Document enables you to 
group documents per customer number, delivery address, etc. before delivering 
the output to the target application.

What is output mode Document?

In output mode Document, the output is delivered as Documents. This means the 
output connector waits until the Document is complete before it delivers the 
output. Use this mode if you want to group documents per customer number, 
delivery address, etc.

Document mode scenario

In this scenario, you have a Runtime job with two Processes that create hardware 
invoices and software invoices:

• procHardware

• procSoftware

Both Processes deliver output via the same fax output connector. If you select 
output mode Document, the hardware and software invoice are grouped per 
customer before they are faxed. This means each customer will receive one fax.

Figure 2 Output mode Document – one fax per customer.
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Same scenario using output mode Process

If you select output mode Process instead of Document, each invoice is faxed 
separately. This means each customer will receive two faxes.

Figure 3 Output mode Process – two faxes per customer.

Document trigger
A Document trigger is a variable that determines the scope of the Document. For 
example, if you assign the variable $customerNumber to the Event field 
customerNumber, you can use $customerNumber as Document trigger. In this 
case, all documents with the same customer number in the input job are included 
in the same Document.

Beginning and end of a Document

The Document trigger determines the beginning and end of a Document. The 
current Document ends, and a new Document begins, when the Document trigger 
variable changes.

Sorting the input

Since a Document ends when the Document trigger changes, the input must come 
in the right sequence. For example, if customer number is used as Document 
trigger, all documents with the same customer number must be handled in 
sequence. This means you may have to sort the input before the Documents are 
created. See Sorting documents on page 165.

Output from several Runtime jobs

If the output connector handles output from several Runtime jobs, you must 
specify a Document trigger for each Runtime job. This means a connector can 
have several Document triggers – one trigger per Runtime job. Note though that 
you can use the same trigger variable (customer number, customer name, etc.) for 
all Runtime jobs.

Output mode Job
In output mode Job, the output connector waits until the whole Runtime job is 
finished before it delivers the output. Use this mode if you want to create one 
group for the output from all Processes in a Runtime job.
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Job scenario

In this scenario, you have a Runtime job that contains one Process that prints 
invoices to an AFP file via a File output connector. The AFP file is used for 
production printing, and all invoices in the Runtime job should be printed to the 
same AFP file. To achieve this, you must select output mode Job.

Figure 4 Output mode Job.

Input Analyzer
An input connector can be used for different input types, and deliver data to 
several Events. For example, the same input connector can receive XML 
structured, page formatted, and record based input, and deliver data to an XMLIN 
Event, a PageIN Event, and a StreamIN Event.

The Input Analyzer is the component responsible for delivering data to the 
appropriate Event type. For example, if an input connector is connected to an 
XMLIN Event and a PageIN Event, the Input Analyzer ensures that XML 
structured input is delivered to the XMLIN Event, and that page formatted input 
is delivered to the PageIN Event.

Figure 5 The Input Analyzer directs XML structured input to an XMLIN Event.

How the Input Analyzer works

Each input connector is associated with a list of input types. This list includes all 
input types handled by the input connector, and is used by the Input Analyzer to 
find a matching Event for the input data. The following steps describe how the 
Input Analyzer finds a matching Event:

1 An input job is received by an input connector.

2 The Input Analyzer checks the input type list associated with the input 
connector.

3 The Input Analyzer starts with the first input type in the list, and sends the 
data to the corresponding Event.

4 The Event tries to identify the input data to see if it is the right input type.
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– If it is the right input type, the Input Analyzer is notified, and the Event 
starts processing the data.

– If it is not the right input type, the Input Analyzer is notified and 
continues with the next input type in the list.

5 The Input Analyzer continues through the input type list until it finds a 
matching Event.

How the input type list is defined

You define the input type list when you link the input connector to Events in the 
Runtime configuration. Each time you link the connector to a new Event, the list 
is updated with the corresponding input type.

For example, if a connector is linked to a StreamIN Event (input type RecordIN) 
and an XMLIN Event, the input type list includes the input types RecordIN and 
XMLIN. If you link this connector to a PageIN Event, the input type list is 
updated with the input type PageIN.

Input types supported by the Input Analyzer

The following input types are supported by the Input Analyzer:

• FieldIN (StreamIN)

• RecordIN (StreamIN)

• MessageIN

• XMLIN

• PageIN

Input types not supported by the Input Analyzer

The following input types are not supported by the Input Analyzer:

• PreformatIN

• Agent (StreamIN)

• Movex (StreamIN)

• StrsXML (StreamIN)

• XML (StreamIN)

This means that if you link an Event using any of these input types, you cannot 
link any other type of Event to the same input connector.

Project export and deployment
A Project consists of a set of Project files. These files include all the information 
needed by the StreamServer application to collect, transform, and deliver data. To 
make this information available to the StreamServer application, you must first 
export the Project, and then deploy the exported Project to the StreamServer 
application.
StreamServe Persuasion SP5 Design Center User Guide Rev B



Concepts 25
Concepts and glossary
Project export

When you export a Project, you create an export file (*.export) that includes all 
the configuration files needed by the StreamServer application. The export file 
includes the configuration files for all Platform layers defined in the Project.

Deployment

When you deploy a Project to a StreamServer application, you must specify 
which Platform layer to deploy. All the configuration files are then extracted from 
the export file, and stored in the working directory of the StreamServer 
application. See the Control Center documentation for more information on how 
to deploy Projects.
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Glossary

Alias Method used to configure settings dynamically. There are two types of 
aliases:

• Script alias, where you use scripting to determine which 
alternative to select.

• Lookup alias, where you use lookup tables to determine which 
alternative to select.

Document A Document (capital D) is a grouping of documents per customer 
number, delivery address, etc.. The scope of the Document is specified 
using a Document trigger.

Document trigger A variable that determines the scope of the Document.

Event An Event defines how to identify documents in the input job, which 
parts of an input document to extract, and how to create a Message.

Event tool Each Event type has its own Event tool (PageIN, StreamIN, XMLIN, 
etc.) where the Event is configured.

Export When you export a Project, you create an export file (*.export) that 
includes all the configuration files needed by the StreamServer 
application. The export file includes the configuration files for all 
Platform layers defined in the Project.

Filter chain A collection of filters that can be used by a connector.

Generic Platform 
layer

The generic Platform layer (also referred to as logical layer) includes 
settings that must be the same in all target environments.

Input Analyzer Enables input connectors to receive input in different formats, and to 
deliver the input to the appropriate Event.

Input connector Input connectors are the channels through which input jobs are received.

Input job A stream of data, with a distinct beginning and end, received via an 
input connector, and processed by the StreamServer.

Input queue An input queue stores input jobs before they are processed by the 
StreamServer.

MailOUT Process used to create email output.

Message A tree structure of tagged fields and blocks used internally by the 
StreamServer when transforming input documents into output 
documents.
StreamServe Persuasion SP5 Design Center User Guide Rev B



Glossary 27
Concepts and glossary
Message 
configuration

A Message configuration defines:

• How to identify documents in the input job.

• Which parts of an input document to extract.

• How to create a Message.

• How to use the Message to create the output documents.

MessageIN Event for StreamServe XML input data.

MessageOUT Process for output data sent to a MesageIN Event. The MessageOUT 
Process makes it possible to extend the processing chain over multiple 
StreamServers.

Output connector Output connectors are the channels through which output jobs are 
delivered.

Output job An output job is equivalent to a file, created by the StreamServer, and 
delivered via an output connector to a target application (printer, fax, 
etc.). The scope of the output job is set by the output mode, and in some 
scenarios by using script functions (e.g. SetDestPath).

Output mode The output mode specifies how to group documents before they are 
delivered via the output connector to the target application.

Output mode 
Document

In output mode Document, the output is delivered as Documents. This 
means the output connector waits until the Document is complete before 
it delivers the output.

Output mode Job In output mode Job, the output connector waits until the whole Runtime 
job is finished before it delivers the output.

Output mode 
Process

In output mode Process, the output connector delivers the output as it 
arrives from a Process. This means each output document is delivered 
separately.

Output queue An output queue stores the output jobs before they are delivered to the 
target applications (printers, faxes, etc.).

PageIN Event for page based input data.

PageOUT Process for page based output data.

Physical Platform 
layer

A physical Platform layer includes environment specific settings.

Platform The Platform represents the StreamServer application to which the 
Project is deployed, and contains the environment settings for that 
StreamServer application.

Post-processor Used to retrieve documents from a Post-processor repository.

PreformatIN Event for preformatted (e.g. PDF) input data.
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Process A Process defines which fields and blocks in a Message to use, and how 
to organize the fields and blocks in the output documents.

Process tool Each Process type has its own Process tool (PageOUT, StreamOUT, 
XMLOUT, etc.) where the Process is configured.

Project The configuration used by a StreamServer application to collect, 
transform, and deliver data. In Design Center, you create and configure 
the Project. Then you export the Project, and deploy it to the appropriate 
StreamServer application.

RedirectOUT Process used to redirect input data directly to an output connector, and 
skip the processing steps in the StreamServer. 

Resource All external files that you refer to when you configure a Project must be 
available to the Project as resources. A resource in this context is a file 
with an embedded source file.

Resource set A resource set is a set of links to physical resource files stored on disk.

Runtime 
configuration

The Runtime configurations in a Project connects Message 
configurations to the Platform.

Runtime job A Runtime job is a grouping of one or several Message configurations 
in a Runtime configuration.

StoryTeller Process for page based output data.

StreamIN Event for record based and field based input data.

StreamOUT Process for record based output data.

StreamServer The server that uses the configuration created in Design Center to 
collect, transform, and deliver data.

StreamServer 
application

The StreamServer can run several StreamServer applications, where 
each StreamServer application is dedicated to a specific Design Center 
Project.

XMLIN Event for XML based input data.

XMLOUT Process for XML based output data.
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interface

This chapter describes the work environment and the interface elements you will 
encounter while you are using Design Center. You will find a comprehensive 
reference of all Design Center menus, menu commands, and dialog boxes in 
Menus, menu commands, and dialog boxes in Design Center on page 185.

In this chapter

• Windows and views overview on page 30

• Platform view on page 35

• Message view on page 36

• Runtime configuration view on page 38

• Resource set view on page 41
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Windows and views overview
The Design Center graphical user interface (GUI) consists of four windows, and 
one view per Project component (Platform, Message, Runtime configuration, and 
resource set). The component views are displayed in the main window.

Figure 6 The Design Center GUI

Showing/hiding windows

You can use the View menu to show/hide windows (you cannot hide the Main 
window).

Window Description

Project browser The Project browser is where you create and structure 
your Project.

Main The Main window is where you configure the Project 
components.

Property The Property window displays properties for the active 
view in the Main window.

Search results The Search results window displays the search results 
after submitting Edit > Find.
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Project browser
The Project browser is where you create and structure the Project. The Project is 
displayed as a tree, and all Project components are added as nodes to the Project 
tree.

Figure 7 The Project browser.

Folders

You can use folders to structure the Project nodes.

Project nodes

You add the Project nodes either at root level, or to the appropriate folders. 

Moving nodes

You can drag and drop Project nodes between the folders.

Activating Project component views

You can double-click a Project node to activate the corresponding view in the 
Main window. This applies to the following types of Project nodes:

• Platform node – Activate the generic layer in the Platform view.

• Physical Platform layer node – Activate the corresponding physical layer 
in the Platform view.

• Message node – Activate the corresponding Message configuration in the 
Message view.
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• Runtime configuration node – Activate the generic layer in the Runtime 
configuration view.

• Physical Runtime configuration layer node – Activate the corresponding 
physical layer in the Runtime configuration view.

• Resource set node – Activate the corresponding resource set in the 
resource set view.

Project menu commands

There are several Project specific menu commands. See Project browser shortcut 
menu commands on page 196.

Main window
The Main window is where the component views are displayed.

Figure 8 The Main window.

You can open the following component views in the Main window:

• Platform view

• Message view

• Runtime configuration view

• Resource set view

Activating component views

To open and activate a component view, you can double-click the corresponding 
node in the Project browser. If several component views are open in the Main 
window, you can use the window tabs to activate a component view. The tabs are 
displayed below the main window, and can be enabled/disabled from the View 
menu.
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Property window
When you activate a view in the Main window, the view’s properties are 
displayed in the Property window.

Figure 9 The Property window.

Active view and selected item

The Active view is the active view in the Main window, and the Selected item is 
the item selected in the active view. In the Property window example above, the 
Active view is a Runtime configuration, and the Selected item is a Process 
selected in that Runtime configuration view.

If no item is selected in the active view, the Selected item refers to the active view, 
i.e. the corresponding node in the Project browser.

Note tab

On the Notes tab, you can add notes to the Selected item.

Dependencies tab

There are dependencies between the nodes in the Project browser. For example, 
a Runtime configuration is related to settings in the Platform, resource sets, 
Messages, and physical layers. On the Dependencies tab, you can see the 
dependencies for the Active view, i.e. the corresponding node in the Project 
browser.

File properties tab

Each node in the Project browser is stored as a Design Center file in a Project 
directory. When you activate a node, its file properties are displayed on the File 
properties tab. These properties include the absolute path to the file, and version 
control status if the Project is connected to a Version Control System via Design 
center.
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Search results window
The Search Results window displays the search results after submitting Edit > 
Find.

Figure 10 The Search results window.

The search results are displayed in a list. You can double-click a line to activate 
the corresponding view.
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Platform view
The Platform view is where you configure the Platform settings.

Figure 11 The Platform view.

Connectors

All connectors used in the Project are added to the Platform view. The connectors 
are displayed as shown in Figure 11. The connector contains labels that helps you 
identify the main features specified for the connector. The connector labels are 
described in the table below. 

Navigating between layers

The generic layer and all physical layers are activated in the same Platform view. 
The banner at the top of the view shows which layer is active. You can use the 
drop-down list in the banner to navigate between the different layers.

Figure 12 Drop-down list for navigation between layers.

Platform menu commands

There are several Platform specific menu commands. See Platform menu 
commands on page 212 and Platform view shortcut menu commands on page 213.

Label Description

Name The name given to the connector.

Type The connector type. For example Directory input 
connector and File output connector.

Queue The name of the queue used by the connector.

Driver The type of device driver used by the output connector.
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Message view
The Message view is where you configure Messages.

Figure 13 The Message view.

Events and Processes

Each Event and Process is displayed as a separate object in this view. You can 
open the Event/Process tool by double-clicking the corresponding Event/Process.

Message

The actual Message is displayed between the Events and Processes.

Message menu commands

There are several Message specific menu commands. See Message menu 
commands on page 249 and Message view shortcut menu commands on page 249.

Script indicators

You can add different types of scripts in the Message view. Script indicators on 
the Event, Message, and Process objects indicate where scripts are added.

Figure 14 Script indicators.
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Event order indicators

Event order indicators on the Event objects indicate the Event order (First, 
Repeating, or Last) for each Event in the Message.

Figure 15 Event order indicators.
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Runtime configuration view
The Runtime configuration view is where you connect Message configurations to 
the Platform, and configure Runtime configuration specific settings.

Figure 16 The Runtime configuration view.

Input connectors

The input connectors are created in the Platform and displayed in the Runtime 
configuration view. The connections between input connectors and Events are 
indicated by lines in the Runtime configuration view.

Figure 17 Connection between input connector and Event.

Output connectors

The output connectors are created in the Platform and displayed in the Runtime 
configuration view. The connections between Processes and output connectors 
are indicated by lines in the Runtime configuration view.

Figure 18 Connection between Process and output connector.
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Runtime jobs

A Runtime job is created by default when you create a Runtime configuration. 
You can add new jobs to the Runtime configuration if you need to.

Figure 19 Runtime job.

Message configurations

You add a Message configuration to a Runtime job, and connect its Events and 
Processes to the appropriate input and output connectors. 

Figure 20 A Message configuration in a Runtime job.

Post-processors

You must add a Post-processor to the Runtime configuration in order to retrieve 
documents from a Post-processor repository.

Figure 21 Post-processor.

Runtime configuration menu commands

There are several Runtime configuration specific menu commands. See Runtime 
menu commands on page 254 and Runtime configuration view shortcut menu 
commands on page 255.
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Script indicators

You can add different types of scripts in the Runtime configuration view. Script 
indicators on the Runtime jobs and Post-processors indicate where scripts are 
added.

Figure 22 Script indicators on a Runtime job.

Navigating between layers

The generic layer and all physical layers are activated in the same Runtime 
configuration view. The banner at the top of the view shows which layer is active. 
You can use the drop-down list in the banner to navigate between the different 
layers.

Figure 23 Drop-down list for navigation between layers.
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Resource set view
The resource set view is where you administer the resources in a resource set.

Figure 24 The resource set view.

Resource set node

When you create a resource set, it only contains a resource set node. This is the 
root node of the resource set, and you add all resources and folders below this 
node.

Folders

You can use folders to organize the resources in the resource set. A folder can 
contain any number of resources and subfolders. When you save the Project, the 
folders and subfolders are automatically added to the resource paths.

Local resources

Local resources are resources created from within the resource set. These 
resources are stored in the Project directory.

Shortcuts to resources

You can add resources from other Project directories to a resource set. The icons 
for these resources contain shortcut symbols to indicate that they are not local 
resources.

If you create a local resource, and then move it to another folder in the resource 
set, the corresponding resource file stored on disk will not be moved. The icon for 
a moved resource will also contain a shortcut symbol.

Resource set menu commands

There are several resource set specific menu commands. See Resources menu 
commands on page 284 and Resource set view shortcut menu commands on page 
285.
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Creating and structuring Projects

In this chapter

• Creating a new Project on page 44

• Adding components to a Project on page 45

• Structuring Projects using Global, Sub, and Main Projects on page 56

• Copying and reusing Project components on page 59

• Configuring the Input Analyzer on page 69

• Managing notifications on page 71

• Using custom commands and keywords on page 72

• Scheduling actions on page 74

• Listing used fonts on page 75

• Packing and unpacking Projects on page 76

• Project templates on page 79

• Exporting a Project to disk on page 80
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Creating a new Project
You can create a new Project from scratch, or you can use a Project template. See 
Creating a Project using a template on page 79 for more information about 
templates.

To create a new Project

1 Select File > New > Project. The Project Settings dialog box opens.

2 Specify the settings.

• Project name – The name of the Project.

• Default code page – The default code page you specify here will be 
the default code page in all code page drop-down lists in the Project.

• Default Resource set – The default resource set of the Project. This 
resource set is automatically connected to all Platforms, Message 
configurations, and Runtime configurations you create from within the 
Project.

• Project folder/directory – The path to the Project directory. The 
Design Center Project files created from within the Project are stored 
in this directory.

3 Click OK. The new Project is displayed in the Project browser.

At this stage, the Project contains the Project node and a resource set node. You 
must now continue and add a Platform, folders, Runtime configurations, and 
Message configurations to the Project. See Adding components to a Project on 
page 45
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Adding components to a Project
In this section

• Naming Project components on page 45

• Adding folders to the Project tree on page 47

• Adding a Platform to a Project on page 47

• Adding a Message configuration to a Project on page 48

• Adding a Runtime configuration to a Project on page 49

• Adding a resource set to a Project on page 50

• Adding a physical layer on page 51

• Linking components into a Project on page 52

Naming Project components
You can use any name for the components in your Design Center Project with the 
exceptions shown below.

Maximum number of characters

The maximum number of characters in a name is 63.

Invalid characters

The following ASCII characters are invalid.

Invalid strings

The following text strings cannot be used as names.

In ASCII table Character

Character 0-31 null to unit separator

34 “

42 *

47 /

58 :

60 <

62 >

63 ?

92 \

124 |
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• AUX

• CLOCK$

• COM1

• COM2

• COM3

• COM4

• COM5

• COM6

• COM7

• COM8

• COM9

• CON

• LPT1

• LPT2

• LPT3

• LPT4

• LPT5

• LPT6

• LPT7

• LPT8

• LPT9

• NUL

• PRN
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Adding folders to the Project tree
You can add folders to the Project tree. The folders help you organize the Project 
components, i.e. you can create folders for Project components that are logically 
connected.

Figure 25 Folders in Project browser.

To add a new folder

1 Right-click the Project node where you want to insert the folder, and select 
New > Folder. A new folder is added to the Project tree.

2 Rename the folder.

Adding a Platform to a Project
You can create a Platform from within the Project, and you can also link an 
existing Platform from another Project to your Project. See Linking components 
into a Project on page 52 for information on how to link a Platform to your 
Project, and Structuring Projects using Global, Sub, and Main Projects on page 
56 for information on when to do so.
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To create a new Platform

1 Right-click the Project node where you want to insert the Platform, and 
select New > Platform. A new Platform node and a physical layer node are 
added to the Project tree.

2 Rename the Platform and physical layer node.

Naming the Platform and physical layers

The name of the Platform should follow the naming standard used in your 
organization, for example include company name, OS, etc. The name of the 
physical layer should reflect the target environment in which it should be used – 
Development, Test, etc.

Configuring a Platform

Now you have an empty Platform with one physical layer. To complete the 
Platform, you must add and configure connectors, specify Platform settings, etc. 
See Platform configuration procedures on page 81 for information on how to 
configure a Platform.

Adding new physical layers

To be able configure Platform settings for other target environments, you must 
create a new physical layer for each target environment. See Adding a physical 
layer on page 51for information on how to add a new physical layer to your 
Project.

Adding a Message configuration to a Project
You can create a Message configuration from within the Project, and you can also 
link an existing Message configuration from another Project to your Project. See 
Linking components into a Project on page 52 for information on how to link a 
Message configuration to your Project, and Structuring Projects using Global, 
Sub, and Main Projects on page 56 for information on when to do so.
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To create a new Message configuration

1 Right-click the Project node where you want to insert the Message 
configuration, and select New > Message. A new Message node is added to 
the Project tree.

2 Rename the Message node.

Naming Message configurations

The name of the Message configuration should follow the naming standard used 
in your organization, for example include the document type (invoice, order, etc.) 
handled by the Message configuration.

Configuring a Message

Now you have an empty Message configuration. To complete the Message 
configuration, you must add and configure the Events and Processes. See 
Message configuration procedures on page 105 for information on how to 
configure a Message.

Adding a Runtime configuration to a Project
You can create a Runtime configuration from within the Project, and you can also 
link an existing Runtime configuration from another Project to your Project. See 
Linking components into a Project on page 52 for information on how to link a 
Runtime configuration to your Project, and Structuring Projects using Global, 
Sub, and Main Projects on page 56 for information on when to do so.

To create a new Runtime configuration

1 Right-click the Project node where you want to insert the Runtime 
configuration, and select New > Runtime. The Select Platform dialog box 
opens.
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2 Select the Platform you want to use for your Runtime configuration, and 
click OK. A new Runtime configuration node and one or more physical 
layer nodes are added to the Project tree.

3 Rename the Runtime configuration node.

Naming Runtime configurations

The name of the Runtime configuration should follow the naming standard used 
in your organization, for example include the document type (invoice, order, etc.) 
handled by the Runtime configuration.

The physical layers are created in the Platform, and inherited by the Runtime 
configuration. If, for example, the Platform contains a Development and Test 
layer, the Runtime configuration will also contain a Development and Test layer.

Configuring a Runtime configuration

Now you have an empty Runtime configuration. To complete the Runtime 
configuration, you must add the appropriate Message configurations, connect the 
Message configurations to the connectors, etc. See Runtime configuration 
procedures on page 117 for information on how to configure a Runtime 
configuration.

Adding a resource set to a Project
When you create a Project, a resource set is created by default. This resource set 
is automatically connected to all components you create from within the Project. 
This means all Project components will have access to all resources in the default 
resource set.

You can also create additional resource sets. For example, you can create a 
resource set that contains resources used by a number of Message configurations 
in the Project. In this case, you must manually connect the resource set to the 
Message configurations.
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To create a new resource set

1 Right-click the Project node where you want to insert the resource set, and 
select New > Resource set. A new resource set node is added to the Project 
tree.

2 Rename the resource set node.

Naming resource sets

The name of the resource set should follow the naming standard used in your 
organization, for example include the document type (invoice, order, etc.) of 
Message configurations using the resource set.

Adding resources to a resource set

Now you have an empty resource set. To complete the resource set, you must add 
and configure the resources. See Resource set management procedures on page 
135 for information on how to add resources to a resource set.

Adding a physical layer
When you create a Platform, one physical layer is created by default. This 
physical layer is normally used for the Development environment. To be able 
configure Platform settings for other target environments, you need to create a 
physical layer for each target environment.
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Platform and Runtime configuration

You add new physical layers to the Platform. When you add a new layer to the 
Platform, a new layer is automatically added to the Runtime configurations in the 
Project. For example, if you add a layer called Test to the Platform, a layer called 
<Runtime configuration name> (Test) is automatically added to the Runtime 
configurations.

Figure 26 New Test layer in Platform and Runtime configuration.

Copy of existing layer

When you create the new layer, you create a copy of an existing layer. This means 
all settings in the existing layer are copied to the new layer.

To add a new physical layer

1 In the Project browser, right-click the Platform node and select New 
Physical Layer. The Select base dialog box opens.

2 Select the physical layer you want to copy, and click OK. The new physical 
layer is added to the Platform and to the Runtime configurations.

Linking components into a Project
Project components can be shared by several Projects. For example, you can 
create a Global Project that contains a Platform and resource set shared by several 
Projects (see Structuring Projects using Global, Sub, and Main Projects on page 
56). To use an external Project component in your Project, you have to link it into 
your Project.

To link a component into a Project

1 Right-click the root node or folder where you want to insert the component, 
and select Add to Project. The Add to Project dialog box opens.

2 Click Browse. A file browser opens.
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3 In Files of type, select the type of component (Platform, Message, 
Runtime, or Resource Set) to search for.

4 Browse to, and double-click the file to link to your Project. The component 
is added to your Project.
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Where the Design Center Project files are 
stored

All Project components are stored as files on disk. Components that you create 
from within the Project are stored in the Project’s Project directory.

Figure 27 Example – The Project Granvinge AB and its Project directory.

As you see in Figure 27, the folders in the Project browser are added to the save 
path for the components.

File names

A Project file is named the first time you save it. If you rename a Project 
component in the Project browser after you have saved it, the corresponding 
Project file is not renamed. 

For example, if you name a Message configuration to Invoice and save it, the 
corresponding Project file will be saved as Invoice.dcmessage. If you later 
rename the Message configuration to msgInvoice and save it, the name of the 
corresponding Project file will still be Invoice.dcmessage.
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Moving components in the Project browser

A Project file is not moved if you move the corresponding component in the 
Project browser. For example, if you create the Message configuration 
msgInvoice at root level in the Project browser, the corresponding Project file 
will be stored at root level in the Project directory. If you move msgInvoice to the 
Invoices folder in the Project browser, the corresponding file is not moved. 

Linked in components

If you link in components to your Project (see Linking components into a Project 
on page 52), these components will not be included in the Project directory – they 
are linked from another Project’s Project directory. In Figure 27 on page 54 the 
Platform components in the Project browser are linked from another Project. As 
you see, the corresponding Project files are not included in the Project directory.

Shortcut symbols in the Project browser

The tree structure in the Project browser is an image of the file storage tree 
structure. If there is a mismatch between the two, for example if a component is 
linked from another Project, or if a component has been moved in the Project 
browser, this is indicated by a shortcut symbol attached to the node in the Project 
browser.

Figure 28 Shortcut symbols attached to Project browser nodes.
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Structuring Projects using Global, Sub, and 
Main Projects

When you create a Project, you may come to a point where the Project is too large 
to handle – too many components are displayed in the same Design Center view, 
it is difficult for several developers to work with the same Project, etc. The best 
way to solve this problem is to divide the Project into several Sub Projects, and 
then link the Sub Projects to a common Main Project.

One Platform for all Projects

All Projects that are to be run by the same StreamServer application must be based 
on the same Platform. You should create a separate Global Project that only 
contains the Platform and corresponding resource set. Then you link this Platform 
to the other Project modules. This ensures that all Project modules are based on 
the same Platform.

One Sub Project per Developer

Several developers should never work with the same Project at the same time. 
You must therefore divide the Project into Sub Projects, where each Sub Project 
is handled by one Developer at a time.

Project directory structure

You create each Project module in Design Center according to standard 
procedures, and store each module in a separate Project directory. The figure 
below illustrates a directory structure example for the Project Project_A and the 
following Project modules:

• Global_A

• Sub_A1

• Sub_A2

• Main_A

Figure 29 Project folder structure for Project_A.

About the Project modules
There are three types of Project modules:

• One Global Project

• Several Sub Projects
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• One Main Project .

The Global Project

The Global Project contains the Platform and corresponding resource set and 
resources. These are the global objects that will be used by all other Project 
modules..

Figure 30 Global Project – Example.

The Sub Projects

A Sub Project contains Message configurations that are logically connected to 
each other. For example, there can be one Sub Project for invoices, another for 
shipping documents, etc. The same Platform is linked from the Global Project to 
all Sub Projects, and the appropriate Message configurations, Runtime 
configurations, and resource sets are created in each Sub Project.

Figure 31 Sub Project – Example (  indicates linked objects).
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The Main Project

The Main Project is the compete Project – it includes the Global Project and all 
Sub Projects.

Figure 32 Main Project – Example (  indicates linked objects).
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Copying and reusing Project components
Design Center uses internal keys to identify the different components used in the 
Design Center Projects. This applies to all Design Center components represented 
by files:

• Platform (*.dcplatform)

• Physical Platform layer (*.dcphyspf)

• Runtime configuration (*.dcruntime)

• Physical runtime configuration layer (*.dcphysrt)

• Message configuration (*.dcmessage)

• Process (*.dcprocess)

• Resource (*.dcres)

• Resource set (*.dcrset)

This means all Design Center Project files must have unique keys. If several files 
have the same key, Design Center cannot identify which file to use where.

Copying components

If you copy/paste component files on disk, the keys are copied as well. This means 
the original file and the copy will have the same key, and Design Center cannot 
tell them apart. This will most likely lead to failure when you try to run the 
StreamServer application after exporting and deploying the Design Center 
Project.

If you want to copy a component in a Design Center Project, and use it in the same 
Project or in another Project that has any relations to the original Project, you 
must make sure the original component and the copy have unique keys. If you do 
it the right way, Design Center will generate new unique keys for the new 
components.

In this section

• Copying Events on page 60

• Copying Processes on page 61

• Sharing Processes on page 63

• Copying Message configurations on page 63

• Sharing Message configurations on page 65

• Copying resources on page 65

• Sharing resources on page 68
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Copying Events

In this section

• Copying an Event in a Project on page 60

• Copying an Event to another Project on the same computer on page 60

• Copying an Event to a Project on another computer on page 61

Copying an Event in a Project
This section describes how to copy an Event from one Message configuration to 
another in the same Design Center Project.

To copy an Event

In this procedure, Source Message contains the original Event, and Target 
Message is where to include the copy.

1 In Design Center, open the Source Message and the Target Message.

2 Right-click the Event in the Source Message and select Copy.

3 Right-click the Target Message and select Paste. The Event is pasted into 
the Target Message.

Copying an Event to another Project on the same computer
This section describes how to copy an Event from a Message configuration in a 
Design Center Project to a Message configuration in another Design Center 
Project. Both Design Center Projects are located on the same computer.

To copy an Event

In this procedure, Source Message contains the original Event, and Target 
Message is where to include the copy.

1 In Design Center, open the Target Message.

2 Select File > Open. A file browser opens.

3 Browse to and open <Source Message>.dcmessage. The Source Message 
opens in Design Center.

4 Right-click the Event in the Source Message and select Copy.

5 Right-click the Target Message and select Paste. The Event is pasted into 
the Target Message.

6 Exit the Source Message.
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Copying an Event to a Project on another computer
This section describes how to copy an Event from a Message configuration in a 
Design Center Project to a Message configuration in another Design Center 
Project. The Design Center Projects are located on different computers.

To copy an Event

In this procedure, Source Message contains the original Event, and Target 
Message is where to include the copy.

1 Transfer <Source Message>.dcmessage from the Source computer to the 
Target computer.

2 In Design Center, open the Target Message.

3 Select File > Open. A file browser opens.

4 Browse to and open <Source Message>.dcmessage. The Source Message 
opens in Design Center.

5 Right-click the Event in the Source Message and select Copy.

6 Right-click the Target Message and select Paste. The Event is pasted into 
the Target Message.

7 Exit the Source Message.

Copying Processes

In this section

• Copying a Process in a Project on page 61

• Copying a Process to another Project on the same computer on page 62

• Copying a Process to a Project on another computer on page 62

Copying a Process in a Project
This section describes how to copy a Process from one Message configuration to 
another in the same Design Center Project.

Note: You should not copy StoryTeller Processes that are used with, or will be 
used with, Composition Center.

To copy a Process

In this procedure, Source Message contains the original Process, and Target 
Message is where to include the copy.

1 In Design Center, open the Source Message and the Target Message.

2 Right-click the Process in the Source Message and select Copy.

3 Right-click the Target Message and select Paste. The Process is pasted into 
the Target Message.
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Copying a Process to another Project on the same computer
This section describes how to copy a Process from a Message configuration in a 
Design Center Project to a Message configuration in another Design Center 
Project. Both Design Center Projects are located on the same computer.

Note: You should not copy StoryTeller Processes that are used with, or will be 
used with, Composition Center.

To copy a Process

In this procedure, Source Message contains the original Process, and Target 
Message is where to include the copy.

1 In Design Center, open the Target Message.

2 Select File > Open. A file browser opens.

3 Browse to and open <Source Message>.dcmessage. The Source Message 
opens in Design Center.

4 Right-click the Process in the Source Message and select Copy.

5 Right-click the Target Message and select Paste. The Process is pasted into 
the Target Message.

6 Exit the Source Message.

Copying a Process to a Project on another computer
This section describes how to copy a Process from a Message configuration in a 
Design Center Project to a Message configuration in another Design Center 
Project. The Design Center Projects are located on different computers.

Note: You should not copy StoryTeller Processes that are used with, or will be 
used with, Composition Center.

To copy a Process

In this procedure, Source Message contains the original Process, and Target 
Message is where to include the copy.

1 Transfer <Source Message>.dcmessage from the Source computer to the 
Target computer.

2 In Design Center, open the Target Message.

3 Select File > Open. A file browser opens.

4 Browse to and open <Source Message>.dcmessage. The Source Message 
opens in Design Center.

5 Right-click the Process in the Source Message and select Copy.

6 Right-click the Target Message and select Paste. The Process is pasted into 
the Target Message.

7 Exit the Source Message.
StreamServe Persuasion SP5 Design Center User Guide Rev B



Copying and reusing Project components 63
Creating and structuring Projects
Sharing Processes
This section describes how to share a Process between several Message 
configurations in the same Project or in different Projects. 

Sharing a Process means the Message configurations share the same Process file 
(*.dcprocess). Any modification made to the Process in one Message 
configuration is applied to all Message configurations that share the Process.

To add a shared Process to a Message configuration

1 In Design Center, open the Message configuration.

2 Right-click the Message configuration and select Add Process > Existing 
Process. A file browser opens.

3 Browse to and open the Process (*.dcprocess). The Process is added to the 
Message configuration.

Copying Message configurations

In this section

• Copying a Message configuration in a Project on page 63

• Copying a Message configuration to another Project on the same computer 
on page 64

• Copying a Message configuration to a Project on another computer on page 
64

Copying a Message configuration in a Project
This section describes how to copy a Message configuration in a Design Center 
Project.

To copy a Message configuration

In this procedure, Source Message is the original Message configuration, and 
Target Message is the copy.

1 In Design Center, open the Source Message.

2 Create a new Target Message and rename it.

3 Copy the Events and Processes from the Source Message to the Target 
Message (see Copying Events on page 60 and Copying Processes on page 
61).

Post requisites

• Before and After Message scripts are not copied. If you want to reuse 
scripts defined in the original Message configuration, you must add them 
manually to the Target Message (e.g. copy from Source Message and paste 
into Target Message).
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• The document type connection is not copied. If you want to set a document 
type for the Target Message, you must do it manually.

Copying a Message configuration to another Project on the same 
computer

This section describes how to copy a Message configuration in a Design Center 
Project to another Design Center Project. Both Design Center Projects are located 
on the same computer.

To copy a Message configuration

In this procedure, Source Message is the original Message configuration, and 
Target Message is the copy.

1 Create a new Target Message and rename it.

2 Select File > Open. A file browser opens.

3 Browse to and open <Source Message>.dcmessage. The Source Message 
opens in Design Center.

4 Copy the Events and Processes from the Source Message to the Target 
Message (see Copying Events on page 60 and Copying Processes on page 
61).

5 Exit the Source Message.

Post requisites

• Before and After Message scripts are not copied. If you want to reuse 
scripts defined in the original Message configuration, you must add them 
manually to the Target Message (e.g. copy from Source Message and paste 
into Target Message).

• The document type connection is not copied. If you want to set a document 
type for the Target Message, you must do it manually.

Copying a Message configuration to a Project on another computer
This section describes how to copy a Message configuration in a Design Center 
Project to another Design Center Project. The Design Center Projects are located 
on different computers.

To copy a Message configuration

In this procedure, Source Message is the original Message configuration, and 
Target Message is the copy.

1 Transfer <Source Message>.dcmessage from the Source computer to the 
Target computer.

2 Create a new Target Message and rename it.

3 Select File > Open. A file browser opens.
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4 Browse to and open <Source Message>.dcmessage. The Source Message 
opens in Design Center.

5 Copy the Events and Processes from the Source Message to the Target 
Message (see Copying Events on page 60 and Copying Processes on page 
61).

6 Exit the Source Message.

Post requisites

• Before and After Message scripts are not copied. If you want to reuse 
scripts defined in the original Message configuration, you must add them 
manually to the Target Message (e.g. copy from Source Message and paste 
into Target Message).

• The document type connection is not copied. If you want to set a document 
type for the Target Message, you must do it manually.

Sharing Message configurations
This section describes how to share a Message configuration between several 
Projects. 

Sharing a Message configuration means the Projects share the same Message 
configuration file (*.dcmessage). Any modification made to the Message 
configuration in one Project is applied to all Projects that share the Message 
configuration.

To add a shared Message configuration to a Project

1 In Design Center, select File > Add to Project.

2 Browse to and open the Message configuration (*.dcmessage). The 
Message configuration is added to the Project browser.

Copying resources

In this section

• Copying a Resource in a Project on page 65

• Copying a resource to another Project on the same computer on page 66

• Copying a resource to a Project on another computer on page 66

Copying a Resource in a Project
This section describes how to copy a resource in a Design Center Project. The 
procedure for copying a resource from one resource set to another is the same as 
copying a resource in the same resource set.
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To copy a resource

1 In the resource set, right-click the resource and select Copy.

2 In the resource set, right-click the root node or the appropriate folder and 
select Paste. A new resource is added to the resource set.

3 Rename the resource.

When copying to another resource set

When you paste a resource into another resource set, the resource name is 
identical to the name of the original resource. If you do not rename the resource, 
one of the resources (original or copy) is overwritten after export. The resource in 
the resource set that is exported first is the one that is overwritten.

Copying a resource to another Project on the same computer
This section describes how to copy a resource in a Design Center Project to 
another Design Center Project. Both Design Center Projects are located on the 
same computer.

To copy a resource

In this procedure, Source Resource Set contains the original resource, and Target 
Resource Set is where to include the copy.

1 In Design Center, open the Target Resource Set.

2 Select File > Open. A file browser opens.

3 Browse to and open <Source Resource Set>.dcrset. The Source 
Resource Set opens in Design Center.

4 Right-click the resource in the Source Resource Set and select Copy.

5 Right-click the Target Resource Set and select Paste. The resource is 
pasted into the Target Resource Set.

6 Exit the Source Resource Set.

Copying a resource to a Project on another computer
This section describes how to copy a resource in a Design Center Project to 
another Design Center Project. The Design Center Projects are located on 
different computers.

You can use three different methods to copy resources:

• Extract the resource to file from the Source Project, transfer the file to the 
Target computer, and import the file to a resource set in the Target Project. 
A new unique key is generated for the copy. See To copy a resource (import 
file) on page 67.

Note: This method is not applicable to all resource types.
StreamServe Persuasion SP5 Design Center User Guide Rev B



Copying and reusing Project components 67
Creating and structuring Projects
• Copy the resource file (*.dcres) from the Source Project, transfer the file 
to the Target computer, and add the resource to a resource set in the Target 
Project. See To copy a resource (add resource) on page 67.

Note: No new key is generated for the copy, which means the original 
resource and the copy have the same key.

• The third method is an add-on to the previous method. To create a new 
unique resource, you can copy the added resource, paste the copy into the 
resource set, and then remove the added resource from the resource set. See 
To copy a resource (copy temporary resource) on page 67.

To copy a resource (import file)

1 In the Source Project, extract the resource to file.

2 Transfer <ExtractedFile> from the Source computer to the Target 
computer.

3 In Design Center, open the Target Resource Set.

4 Right-click the root node or the appropriate resource folder and select 
Import. A file browser opens.

5 Browse to and open <ExtractedFile>. The Resource Type Settings dialog 
box opens.

6 Select the appropriate resource type and click OK. The resource is added to 
the Target Resource Set.

To copy a resource (add resource)

1 Transfer <Source Resource>.dcres from the Source computer to the 
appropriate Project folder (or sub-folder) on the Target computer.

2 In Design Center, open the Target Resource Set.

3 Right-click the root node or the appropriate resource folder and select Add 
Resource. A file browser opens.

4 Browse to and open <Source Resource>.dcres. The resource is added to 
the Target Resource Set.

To copy a resource (copy temporary resource)

1 Transfer <Source Resource>.dcres from the Source computer to the 
Target computer.

2 In Design Center, open the Target Resource Set.

3 Right-click the root node and select Add Resource. A file browser opens.

4 Browse to and open <Source Resource>.dcres. The resource (called 
TempResource hereafter) is added to the Target Resource Set.

5 Right-click TempResource and select Copy.

6 Right-click the root node or the appropriate folder in the Target Resource 
Set and select Paste. A new resource is added to the resource set.
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7 Remove TempResource from the resource set.

Sharing resources
This section describes how to share a resource between several resource sets in 
the same Project or in different Projects. 

Sharing a resource means the resource sets share the same resource file 
(*.dcres). Any modification made to the resource in one resource set is applied 
to all resource sets that share the resource.

To add a shared resource to a resource set

1 In Design Center, open the resource set.

2 Right-click the root node or the appropriate resource folder and select Add 
Resource. A file browser opens.

3 Browse to and open the resource (*.dcres). The resource is added to the 
resource set.
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Configuring the Input Analyzer
The Input Analyzer enables input connectors to receive any type of input. When 
the connector receives input, the Input Analyzer checks if the input matches any 
of the input types listed for the connector. It starts with the first input type in the 
list, and continues until it finds a match.

Where to configure Input Analyzer settings

You configure the Input Analyzer settings in the Project Export Settings dialog 
box (Edit > Project Export Settings). When you select an input connector in the 
Available connectors list, the input type list is displayed in the Input Analyzer 
configuration list.

Figure 33 Input type list.

Input types grouped into categories

The input types are grouped into the following categories:

• StreamIN (FieldIN, RecordIN, and Input Analyzer enabled Agents).

• XML (PreformatIN, MessageIN, StrsXML, and XMLIN).

• PageIN.

Figure 34 Input type categories.
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How the categories are ordered

By default, the StreamIN category is the first category in the list, followed by the 
XML category. You can use the option Handle XML-based input before 
StreamIN to change the order of these categories.

Figure 35 StreamIN handled before XML – option not selected.

Figure 36 XML handled before StreamIN – option selected.

The PageIN category is always last – you cannot change this.

How the input types are ordered within each category

You can order the input types as you like within each category. The only 
restriction is that if the input type list includes XMLIN, then XMLIN must be the last 
item in the XML category. You can change the order within a category by moving 
an input type up or down using the Move arrows.
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Managing notifications
The StreamServer can generate notifications for different types of objects. The 
notifications are used to monitor the jobs processed by the StreamServer. To 
retrieve the notifications from the StreamServer, you must use a Status Messenger 
input connector. See the Status Messenger documentation for details.

To enable notifications

The StreamServer application to which your Project is deployed does not generate 
notifications by default. First you must enable notifications in the Platform 
settings for the Project. This is a generic feature applied to all physical layers, 
which means you enable this in the generic Platform layer.

1 Activate the generic Platform layer.

2 Right-click the Platform view and select Configure Platform. The 
Configure Platform dialog box opens.

3 Select Use notifications and click OK.

To specify for which objects to generate notifications

If notifications are enabled, the StreamServer application will by default generate 
notifications for all Events, Processes, Runtime jobs, and connectors in the 
Project. If you do not need notifications from all these objects, you can select the 
objects manually.

1 Select Edit > Project Export Settings. The Project Export Settings dialog 
box opens.

2 On the Notifications tab, select Generate notifications for these objects.

3 Select the objects and click OK.

Figure 37 Notification settings.
StreamServe Persuasion SP5 Design Center User Guide Rev B



72 Using custom commands and keywords
Creating and structuring Projects
Using custom commands and keywords
You can add custom commands and keywords in order to use StreamServer 
functionality that cannot be configured via the standard Design Center GUI 
properties. You can add custom commands and keywords to the following 
Platform and Runtime configuration objects:

• Platform

• Connectors (Platform)

• Queues (Platform)

• Output connectors (Runtime configuration)

• Events and Processes (Runtime configuration)

Where to configure custom commands and keywords

You configure custom commands and keywords in the Edit Custom fields dialog 
box (Edit > Custom Settings). You specify which access point (Platform, 
connector, queue, etc.) to configure, and then you enter the custom commands and 
keywords on the Custom sheet.

Figure 38 The Edit Custom fields dialog box.

Access points browser

The Access points browser contains all configurable objects (connector, Message, 
etc.). Each object is divided into one node for the generic (Logical in the GUI) 
layer, and one node for each physical layer (Development, Test, etc.). This means 
you can create different commands and keywords for each layer.
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To add custom commands and keywords

1 Select Edit > Custom Settings. The Edit custom fields dialog box opens.

2 In the Access points browser, browse to and select the node you want to 
configure.

3 Enter your commands on the Custom sheet and click OK.
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Scheduling actions
You can define schedules for different types of actions, for example, how 
frequently to collect input, spool queues, etc. You can set a single time interval, 
or create more complex schedules. 

Figure 39 Example: Schedule that triggers an action once every second Monday 
to Wednesday, and once every hour Thursday to Sunday.

To add an interval

1 Click New (Intervals area). A new item is added to the list.

2 In Define Interval, select a unit and enter the value.

To set a time frame for a specific interval

1 Select the interval.

2 Click New (Apply selected interval area). A new item is added to the area.

3 Select a unit (Year, Month, etc.) for the item and enter a Start and, 
optionally, an End value for the time frame.

To set a time frame for all intervals

You can set a time frame for when to apply all intervals in the list. In the Apply 
all intervals area, use Date and Time for Start and Stop to set the frame for all 
intervals.
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Listing used fonts
You can list all fonts used in the Project. This applies to overlays, and to 
PageOUT and StoryTeller Processes. The fonts are listed in the Font 
Dependencies dialog box, and you can see in which Processes and overlays each 
font is used.

Figure 40 The Font Dependencies dialog box.

To open the Font Dependencies dialog box

Select View > Font Dependencies.

Grouping fonts by Process and overlays

By default, the fonts are grouped by font name, and in each font group you can 
see all Processes using the font. If you click the Dependencies column label, the 
fonts are grouped by Process and overlay. In this case you will see all fonts used 
in a specific Process or overlay.

Navigating to Processes and overlays

If you want to change a font in a Process, you can navigate to the Process from 
the Font Dependencies dialog box: 

1 Select the list item of the Process, and click Go to selected item. The 
Message view opens with the Process highlighted.

2 Open and edit the Process.

The same procedure applies to overlays, where the resource set view opens with 
the selected overlay resource highlighted.
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Packing and unpacking Projects
A Design Center Project consists of several Project files stored on disk (see Where 
the Design Center Project files are stored on page 54). If you want to move a 
Project to a new location, you can pack all Project files into a single package file 
(*.dcpackage). Then you move the package file to the new location, and unpack 
it there.

In this section

• Packing a Project on page 76

• Unpacking a Project on page 77

Packing a Project
You can pack any type of Project, and create a package file where all Project files 
and resource files used in the Project are included. 

Figure 41 Packing a Project.

The figure above shows an example where the Project Granvinge AB is packed 
into the package file Granvinge AB.dcpackage. In this example, all Project files 
are included in the same Project directory, i.e. there are no linked components in 
this example. You can also pack Projects that include linked components. In this 
case, the linked Project files will also be included in the package file.

To pack a Project

1 Select File > Pack Project. The Project Package information dialog box 
opens.

2 Click Save as Project Package. A file browser opens.

3 Browse to the folder where you want to save the package, enter a File name 
for the package, and click Save.
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Unpacking a Project
You can unpack a Project package, and create a copy of the packed Project.

Figure 42 Unpacking a Project.

When you unpack the Project, you can use two modes:

• Simple mode – use this mode if you want to create the same Project file/
folder structure as in the original Project. See Unpacking a Project using 
Simple mode on page 77.

• Advanced mode – use this mode if you want to modify the Project file/
folder structure used in the original Project. See Unpacking a Project using 
Advanced mode on page 78.

Unpacking Projects that contain custom drivers

If you unpack a Project that contains custom drivers, the corresponding driver 
files are unpacked as well. If there is a naming conflict, you are prompted to 
overwrite the driver file you already have, rename the unpacked driver file, etc. 
This means you must decide whether to overwrite existing driver files before you 
unpack the Project.

Unpacking a Project using Simple mode
If you use Simple mode when you unpack a Project, you must specify a root 
folder, i.e. where to create the Project folder for the unpacked Project. The Project 
files will be stored in the same file and subfolder structure as in the original 
Project.

Excluding subfolders

If you want to store all Project files directly under the Project folder, i.e. exclude 
all sub folders, you must uncheck the Keep folder structure check-box.

Linked Project files

If the Project contains linked Project files, these Project files will be stored in a 
separate folder in the root folder you specify.
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To unpack a Project

1 Select File > Unpack Project. A file browser opens.

2 Browse to and open the package file. The Unpack Project dialog box opens.

3 In Unpack to, specify the root folder and click OK.

Unpacking a Project using Advanced mode
If you use Advanced mode when you unpack a Project, you must also specify a 
root folder, i.e. where to create the Project folder for the unpacked Project. The 
default save paths for all files are the same as in Simple mode, but in Advanced 
mode you have the option to change the location (target folder) for each Project 
file.

Multiple file selection

You can specify the location for separate files, and you can also specify the 
location for several files at the same time using Ctrl + SELECT and SHIFT + 
SELECT.

Linked Project files

If the Project contains linked Project files, these Project files will by default be 
stored in a separate folder in the root folder you specify. In Advanced mode you 
have the option to change the location for these Project files.

To unpack a Project

1 Select File > Unpack Project. A file browser opens.

2 Browse to and open the package file. The Unpack Project dialog box opens.

3 In Unpack to, specify the root folder.

4 Specify new locations for the files you want to move, and click OK.

To specify new locations

1 Select the file(s) you want to move to a new location.

2 In Target location for selected component(s), browse to the folder where 
you want to store the files.

3 Repeat 1 and 2 for each new location.
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Project templates
You can use templates when you create new Projects. You can also save a Project 
as a template.

In this section

• Creating a Project using a template on page 79

• Creating a template on page 79

Creating a Project using a template
You can use templates when you create Projects. Design Center searches for 
available templates in the directory specified by Project Templates location in the 
Design Center Settings dialog box (Tools > Design Center Settings). 

To open a Project template

1 Select File > New > Create Project from Template. The Create Project 
From Template dialog box opens.

2 Select the appropriate category. All available templates in the selected 
category are displayed in the Available templates list.

3 Select the template you want to open, and click OK. The Unpack Project 
dialog box opens.

4 In Unpack to, specify the root folder and click OK.

Downloading templates from StreamServe

The Create Project From template dialog box has a web link that you can use to 
download templates from StreamServe.

Creating a template
You can save a Project as a template. When you create a template, you should 
enter a category and description of the template. This will make it easier to 
identify the template.

To create a new Project template

1 Select File > Pack Project. The Project Package Information dialog box 
opens.

2 Enter a Category and Description and click Save as Project Template. 
The Enter Project Template Name dialog box opens.

3 Enter a name for the template and click OK. 
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Exporting a Project to disk
If Design Center is not connected to a VCS, you must export the Project to disk. 
See Creating a release on page 184 for information on how to export a Project 
when Design Center is connected to a VCS.

The export generates a file (*.export) that contains all the Platform layers in the 
Project. When you deploy the Project in Control Center, you must specify which 
physical layer to deploy. 

To export a Project to disk

1 Select Tools > Export. The Export dialog box opens.

2 Specify the export settings. See Export dialog box on page 208.

3 Click OK.
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Platform configuration 
procedures

In this chapter

• Activating the Platform view on page 82

• Managing input connectors on page 83

• Managing output connectors on page 86

• Configuring queues on page 90

• Managing StreamServer startup arguments on page 98

• Log file settings on page 100

• Connecting resource sets to the Platform on page 104
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Activating the Platform view
All Platform settings are configured in the Platform view. The same Platform 
view is used for the generic layer and all physical layers. This means you must 
activate the appropriate Platform layer before you can configure the settings.

To activate the generic Platform layer

In the Project browser, double-click the Platform node.

To activate a physical Platform layer

1 In the Project browser, expand the Platform node. All physical layer nodes 
are displayed.

2 Double-click the node for the physical layer to activate.
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Managing input connectors
In this section

• Adding an input connector to the Platform on page 83

• Connecting a queue to an input connector on page 83

• Configuring connector type settings on page 84

• Deleting an input connector on page 84

• Sorting input connectors in the Platform view on page 84

Adding an input connector to the Platform
You can create a connector from scratch, or you can copy-paste an existing 
connector.

Generic Platform layer

The number of input connectors in a Platform must be the same for all physical 
layers. This means you must add input connectors to the generic Platform layer.

To add a new input connector

1 Activate the generic layer.

2 Right-click the Platform view and select New Input Connector. A new 
input connector is added to the Platform.

3 Rename the input connector.

To copy a connector

1 Activate the generic layer.

2 Select a connector and copy-paste according to standard Windows 
procedures.

3 Rename the input connector.

To rename a connector

1 Activate the generic layer.

2 Right-click the connector, select Rename, and enter the new name.

Connecting a queue to an input connector
You can connect an input queue to the input connector. The input queue stores 
input jobs before they are processed by the StreamServer.

Generic Platform layer

An input connector must use the same queue in all physical layers. This means 
you must connect the queue to the input connector in the generic Platform layer.
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To connect a queue to a connector

1 Activate the generic layer.

2 Right-click the connector and select Settings. The Connector Settings 
dialog box opens.

3 Click the Queue icon and select the appropriate Queue.

Configuring connector type settings
You must specify a connector type for each connector, and configure the settings 
for the selected connector type. For example, to receive input via email you must 
select the EmailIN connector type and configure the settings.

Physical Platform layer

You can use different connector types and settings in the physical layers. This 
means you must specify and configure the connector type for each physical layer.

To configure connector settings

1 Activate the appropriate physical layer.

2 Right-click the connector and select Settings. The Connector Settings 
dialog box opens.

3 On the Connector Settings tab, select the appropriate Connector type and 
configure the settings. See Input connectors.

Deleting an input connector

Generic Platform layer

The number of input connectors in a Platform must be the same for all physical 
layers. This means you must delete input connectors from the generic Platform 
layer.

To delete a connector

1 Activate the generic layer.

2 Right-click the connector and select Delete.

Sorting input connectors in the Platform view
You can sort the input connectors in the Platform view using drag and drop, or 
sort them in alphabetical order (ascending or descending).

Note: The connector presentation in the Runtime configuration views are not 
affected. See Sorting connectors in a Runtime configuration view on page 
131 for information on how to sort the connectors in a Runtime 
configuration view.
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Figure 43 Sorting input connectors in the Platform view.

To sort connectors in ascending/descending order

Right-click a connector and select Sort Connectors Ascending or Sort 
Connectors Descending.

To move a connector

Drag the connector to the desired position.
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Managing output connectors
In this section

• Adding an output connector to the Platform on page 86

• Connecting a device driver to an output connector on page 87

• Connecting a queue to an output connector on page 87

• Specifying the output mode for an output connector on page 88

• Configuring connector type settings on page 88

• Deleting an output connector on page 89

• Sorting output connectors in the Platform view on page 89

Adding an output connector to the Platform
You can create a connector from scratch, or you can copy-paste an existing 
connector.

Generic Platform layer

The number of output connectors in a Platform must be the same for all physical 
layers. This means you must add output connectors to the generic Platform layer.

Output connector categories

The output connector is added to the generic Platform layer. In each physical 
layer, you must select the appropriate connector type, and configure the 
corresponding settings. It should be possible to select different connector types in 
each layer, but the connector types must belong to the same category. For 
example, it should not be possible to use a File output connector in the 
Development layer and a Fax Connect output connector in the Production layer. 
The output connectors are therefore divided into the following categories:

• MailOUT-dependent – enables selection of the connector types Mapi for 
MailOUT, SMTP (MIME) for MailOUT, and Topcall in the physical layers.

• SMS – enables selection of the connector types SMS and SMS Provider in 
the physical layers.

• Fax Connect – enables selection of the connector type Fax Connect in the 
physical layers.

• Post-processor Repository – enables selection of the connector type Post-
processor repository in the physical layers.

• Generic – enables selection of all other types of connector types in the 
physical layers.

To add a connector

1 Activate the generic layer.
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2 Right-click the Platform view and select New Output Connector > 
category. A new output connector of the specified category is added to the 
Platform.

3 Rename the connector.

To copy a connector

1 Activate the generic layer .

2 Select a connector and copy-paste according to standard Windows 
procedures.

3 Rename the connector.

To rename a connector

1 Activate the generic layer.

2 Right-click the connector, select Rename, and enter the new name.

Connecting a device driver to an output connector
If the output connector delivers page formatted output to the target application, 
you must add the appropriate device driver to the output connector. For example, 
if the target application is a PCL printer, you must add the appropriate PCL device 
driver to the output connector.

Generic Platform layer

If you connect a device driver to an output connector, you must use the same 
device driver in all physical layers. This means you must connect the device 
driver to the output connector in the generic Platform layer.

To connect a device driver

1 Activate the generic layer.

2 Right-click the connector and select Settings. The Output Connector 
Settings dialog box opens.

3 Click the Driver icon, select a Device and edit the settings.

Connecting a queue to an output connector
You can connect an output queue to the output connector. The output queue stores 
the output jobs before they are delivered to the target application.

Generic Platform layer

An output connector must use the same queue in all physical layers. This means 
you must connect the queue to the output connector in the generic Platform layer.
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Available queues

By default, there are two queues available. These queues are called Input and 
Output. You can also create additional queues if you need to.

The input job must be queued

To be able to store output jobs in an output queue, the corresponding input job 
must be received via an input queue. This means the input connector that receives 
the input job must be connected to a queue if you want to connect a queue to the 
output connector.

To connect a queue to a connector

1 Activate the generic layer.

2 Right-click the connector and select Settings. The Connector Settings 
dialog box opens.

3 Click the Queue icon and select the appropriate Queue.

Specifying the output mode for an output connector
You must specify the appropriate output mode. See Output modes on page 20 for 
more information about output mode.

Generic Platform layer

An output connector must use the same output mode in all physical layers. This 
means you must specify the output mode in the generic Platform layer.

To specify the output mode

1 Activate the generic layer.

2 Right-click the connector and select Settings. The Connector Settings 
dialog box opens.

3 Click the Output mode icon and specify the output mode.

Configuring connector type settings
You must specify a connector type for each connector, and configure the settings 
for the selected connector type. For example, to send output to a printer you must 
select the Spool connector type and configure the settings.

Physical Platform layer

You can use different connector types and settings in the physical layers. This 
means you must specify and configure the connector type for each physical layer.

To configure connector settings

1 Activate the appropriate physical layer.
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2 Right-click the connector and select Settings. The Connector Settings 
dialog box opens.

3 On the Connector Settings tab, select the appropriate Connector type and 
configure the settings. See Output connectors.

Deleting an output connector

Generic Platform layer

The number of output connectors in a Platform must be the same for all physical 
layers. This means you must delete output connectors from the generic Platform 
layer.

To delete a connector

1 Activate the generic layer.

2 Right-click the connector and select Delete.

Sorting output connectors in the Platform view
You can sort the output connectors in the Platform view using drag and drop, or 
sort them in alphabetical order (ascending or descending).

Note: The connector presentation in the Runtime configuration views are not 
affected. See Sorting connectors in a Runtime configuration view on page 
131 for information on how to sort the connectors in a Runtime 
configuration view.

Figure 44 Sorting output connectors in the Platform view.

To sort connectors in ascending/descending order

Right-click a connector and select Sort Connectors Ascending or Sort 
Connectors Descending.

To move a connector

Drag the connector to the desired position.
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Configuring queues
In this section

• Queues overview on page 90

• Creating and renaming queues on page 91

• Specifying the default input and output queue on page 92

• Specifying how to store successful jobs on page 92

• Specifying how to store failed jobs on page 93

• Specifying when to resend a failed job from a queue on page 94

• Specifying the maximum number of threads for a queue on page 94

• Specifying when to process jobs on page 95

• Enabling sharing of queues on page 95

• Storing queued documents on disk on page 96

• Deleting queues on page 97

Queues overview
To be able to queue an input job, you must connect a queue to the input connector 
that retrieves the input job.

To be able to queue an output job, you must connect a queue to the input 
connector that retrieves the corresponding input job, and to the output connector 
that delivers the output job.

By default, the Platform includes two preconfigured input and output queues. You 
can connect any of these queues to your input and output connectors. You can use 
the preconfigured queue settings, and you can also edit the queue settings if you 
need to.

Generic Platform layer

The queue settings must be the same for all physical layers. This means you must 
configure queues in the generic Platform layer.

Where to configure queues

You configure the queues in the Manage Queues dialog box:

1 Activate the generic layer.

2 Right-click the Platform view and select Manage Queues. The Manage 
Queues dialog box opens.
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In this dialog box, you can configure the settings for all existing queues. You can 
also create new queues, rename queues, and delete queues using this dialog box.

Figure 45 The Manage Queues dialog box.

Related topics

• Creating and renaming queues on page 91

• Specifying the default input and output queue on page 92

• Specifying how to store successful jobs on page 92

• Specifying how to store failed jobs on page 93

• Specifying when to resend a failed job from a queue on page 94

• Specifying the maximum number of threads for a queue on page 94

• Specifying when to process jobs on page 95

• Enabling sharing of queues on page 95

• Storing queued documents on disk on page 96

• Deleting queues on page 97

Creating and renaming queues
The Platform includes the two default queues Input and Output. You can use these 
queues, but it is recommended to create queues with unique names in each Design 
Center Project if you do not want to share the queues with other Projects 
(StreamServer applications).

To add a queue

1 In the Manage Queues dialog box, click Add. A new queue is added to the 
list of available queues.
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2 Rename the queue.

To rename a queue

1 In the Manage Queues dialog box, right-click the queue you want to 
rename, and select Rename.

2 Enter a new name for the queue, and press ENTER.

Specifying the default input and output queue
You can specify which input queue to use as default input queue, and which 
output queue to use as default output queue. When you add a queue to an input/
output connector, and select the option (Use default), the default input/output 
queue you specify here will be selected.

To specify the default input queue

Right-click the queue and select Set as default input queue.

To specify the default output queue

Right-click the queue and select Set as default output queue.

Specifying how to store successful jobs
A job is stored in the queue until it is marked as successful or failed. What to do 
with a job after it is marked as successful depends on the option you specify for 
how to store successful jobs. These options are described in the table below.

When is a job marked as successful?

• A job sent from an output queue is marked as successful when the output 
job is successfully delivered from the output connector.

Option Description

No No job or job information is stored. If you select this 
option, jobs cannot be resent from the queue, and no 
information about the job can be retrieved.

Store information 
only

No job is stored, but information about the job is stored. 
If you select this option, jobs cannot be resent from the 
queue.

Store information 
and job

The job and information about the job is stored. This is 
the default option. If you select this option, jobs can be 
resent from the queue. Successful jobs remain in the 
queues as long as specified in the Platform configuration 
dialog box (see Configure Platform dialog box – Generic 
layer mode on page 215).
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• A job sent from an input queue is marked as successful when it is 
successfully processed, and when all output jobs created from this job are 
successfully delivered from the output connectors.

To specify how to store successful jobs

1 Activate the generic layer.

2 Right-click the Platform view and select Manage Queues. The Manage 
Queues dialog box opens.

3 Select the queue to configure.

4 Select the Queuing tab.

5 From the Store successful jobs drop-down list, select the appropriate 
option:

• No

• Store information only

• Store information and job

Specifying how to store failed jobs
A job is stored in the queue until it is marked as successful or failed. What to do 
with a job after it is marked as failed, and after the StreamServer fails to resend 
the job, depends on the option you specify for how to store failed jobs. These 
options are described in the table below.

When is a job marked as failed?

• A job sent from an output queue is marked as failed when the output 
connector fails to deliver the output job.

• A job sent from an input queue is marked as failed when it is not 
successfully processed, or when an output job created from this job fails.

Option Description

No No job or job information is stored. If you select this 
option, jobs cannot be resent from the queue, and no 
information about the job can be retrieved.

Store information 
only

No job is stored, but information about the job is stored. 
If you select this option, jobs cannot be resent from the 
queue.

Store information 
and job

The job and information about the job is stored. This is 
the default option. If you select this option, jobs can be 
resent from the queue. Failed jobs remain in the queues 
as long as specified in the Platform configuration dialog 
box (see Configure Platform dialog box – Generic layer 
mode on page 215).
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To specify how to store failed jobs

1 Activate the generic layer.

2 Right-click the Platform view and select Manage Queues. The Manage 
Queues dialog box opens.

3 Select the queue to configure.

4 Select the Queuing tab.

5 From the Store failed jobs drop-down list, select the appropriate option:

• No

• Store information only

• Store information and job

Specifying when to resend a failed job from a queue
You can specify when the StreamServer should try to resend a failed job from the 
queue.

To specify when to resend a failed job

1 Activate the generic layer.

2 Right-click the Platform view and select Manage Queues. The Manage 
Queues dialog box opens.

3 Select the queue to configure.

4 Select the Queuing tab.

5 In the Retries field, specify the maximum number of times the 
StreamServer should try to resend the job.

6 In the Retry delay (ms) field, specify the time (milliseconds) the 
StreamServer should wait before it tries to resend the job.

Specifying the maximum number of threads for a queue
For each queue, you can specify the maximum number of threads. Several treads 
enables the StreamServer to process several queued jobs in parallel. This is an 
advantage if a large job is followed by a small job. With one single thread, the 
small job must wait for the large job to be completed. Note that each thread 
consumes system resources.

To specify the maximum number of threads

1 Activate the generic layer.

2 Right-click the Platform view and select Manage Queues. The Manage 
Queues dialog box opens.

3 Select the queue to configure.

4 Select the Advanced tab.
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5 In the Threads field, specify the maximum number threads.

Specifying when to process jobs
You can specify when to process jobs. There are two options. These options are 
described in the table below.

To specify when to process queued jobs

1 Activate the generic layer.

2 Right-click the Platform view and select Manage Queues. The Manage 
Queues dialog box opens.

3 Select the queue to configure.

4 Select the Advanced tab.

5 From the Process jobs drop-down list, select the appropriate option (On 
arrival or When parent completed).

Enabling sharing of queues
If several StreamServer applications in the same application domain are used for 
load balancing and failover, they must be able to share queues.

Sharing is by default disabled for the queues. This to prevent from unintentional 
queue sharing, where one StreamServer application consumes another 
StreamServer application’s jobs.

If several StreamServer applications should be able to share a queue, the Platform 
and queue names must be exactly the same in the Design Center Projects for all 
StreamServer applications. This because the name of the queue used by the 
StreamServer applications in the runtime repository consists of both the Platform 
and queue name defined in Design Center. Sharing must also be enabled for the 
queue in all Projects.

Note: If you disable sharing for a queue in Project A, and enable sharing for the 
same queue in Project B, then StreamServer B can consume 
StreamServer A’s jobs. StreamServer A cannot consume StreamServer 
B’s jobs in this case.

Option Description

On arrival The job is processed as soon as possible after it arrives to 
the queue.

When parent 
completed

The job is added to the queue after the parent job is 
successfully processed. For example, output jobs are 
added to the output queue after the parent job (delivered 
from the input queue) is successfully processed.
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To enable sharing

1 Activate the generic layer.

2 Right-click the Platform view and select Manage Queues. The Manage 
Queues dialog box opens.

3 Select the queue to configure.

4 Select the Queueing tab.

5 Select Queue can be shared.

Storing queued documents on disk
Documents in queued input/output jobs are by default stored as blobs (Binary 
Large Objects) in the runtime repository. You can, for each queue, select to store 
the blobs as files on disk instead. The runtime repository will in this case include 
references to the blobs stored on disk.

There are several reasons to store blobs on disk, for example to:

• Improve performance.

• Decrease the amount of runtime repository data to backup.

• Minimize the risk to reach maximum database and tablespace limits.

Storing blobs on a network share

To store blobs on a network share, you must use UNC (Uniform Naming 
Convention) when you specify the path. You cannot use drive letters.

For example, you can use \\wtvs01\data\queues but not H:\data\queues 
when you specify the path.

When not to store blobs on disk

• If you intend to share the queue between several StreamServer applications 
(load balancing and fail over), you cannot store blobs on disk.

• StreamStudio Reporter can only view the status of the jobs in a queue if the 
blobs are stored on disk. This means StreamStudio Reporter will not be able 
to resend or delete jobs in this case.

• StreamStudio Collector cannot be used if you select to store blobs on disk. 
Note that archiving must be disabled for the output connector if you select 
to store blobs on disk.

To store blobs on disk

1 Activate the generic layer.

2 Right-click the Platform view and select Manage Queues. The Manage 
Queues dialog box opens.

3 Select the queue to configure.

4 Select the Advanced tab.
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5 Select Store blobs on disk.

6 In Blob path, specify the path to the folder where to store the files.

Deleting queues
If the Platform includes queues that you do not need in your Design Center Project 
you can delete them. Note that the queues are deleted from the Platform in your 
Project, but not from the runtime repository. To delete queues from the runtime 
repository, you must use the Database Administration Tool.

To delete a queue

1 In the Manage Queues dialog box, select the queue you want to delete and 
click Delete. A dialog box opens.

2 Click Yes to confirm. The queue is deleted, and all connectors that used the 
queue is no longer connected to a queue.
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Managing StreamServer startup arguments
Startup arguments are exported from Design Center to an argument file. The 
argument file is read by the StreamServer at server startup, and used when 
running the StreamServer application. In Design Center, you can specify 
arguments to add to the argument file.

Standard arguments and administrator arguments

There are two categories of arguments:

• Standard arguments exported to the argument file start.arg. To change 
these arguments, you must change the arguments in Design Center, export 
and redeploy the Project, and restart the StreamServer application.

• Administrator arguments exported to the argument file sysadmin.arg. To 
change these arguments, the administrator can edit sysadmin.arg and 
restart the StreamServer application. Note that if you export and redeploy 
the Project, sysadmin.arg is recreated with the arguments exported from 
Design Center.

Physical Platform layer

The StreamServer application to which the Project is deployed has one working 
directory per physical layer (you specify which layer to use when you deploy the 
Project). This means you specify startup arguments for each physical layer.

Where the startup arguments are configured

The startup arguments are configured in the Configure Platform Export dialog 
box. In this dialog box, there is one Arguments tab for standard arguments, and 
one Administrator Arguments tab for administrator arguments.

Figure 46 The Configure Platform Export dialog box.
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To open the Configure Platform Export dialog box

1 Activate the appropriate physical layer.

2 Right-click the Platform view and select Configure Export. The Configure 
Platform Export dialog box opens.

3 Select the Arguments tab or Administrator Arguments tab.

Argument lists

Each argument tab contains a list of available arguments, and each argument in 
the list has a check-box attached.

All arguments that you check will be included in the argument file. Some 
arguments, for example -langfile, have values that you must specify. To specify 
these values, you must select the argument and specify the values.

Figure 47 Specifying the value for the -langfile argument.

Custom arguments

The StreamServer can use special arguments that are not included in the argument 
lists. To add these arguments to the argument files, you must add them as custom 
arguments:

1 In the Configure Platform Export dialog box, click Edit Custom. The 
Custom Arguments dialog box opens.

2 Specify the arguments and click OK.

References

Startup argument reference
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Log file settings
In this section

• Log file settings overview on page 100

• Enable/disable logging on page 101

• Specifying which types of messages to log on page 102

• Creating a new log file at StreamServer start-up on page 102

• Log file truncation on page 103

Log file settings overview
The StreamServer application to which the Project is deployed can write log 
messages to a log file in the working directory. In Design Center, you can specify 
whether to generate a log file, which type of information to include in the log file, 
log file truncation settings, etc.

Physical Platform layer

There is one working directory per physical layer (you specify which layer to use 
when you deploy the Project). This means there is one log file per physical layer, 
and you must specify the log file settings for each physical layer.
StreamServe Persuasion SP5 Design Center User Guide Rev B



Log file settings 101
Platform configuration procedures
Where the log file settings are configured

The log file settings are configured on the Log File tab in the Configure Platform 
dialog box.

Figure 48 The Configure Platform dialog box (Log File tab).

To open the Configure Platform dialog box

1 Activate the appropriate physical layer.

2 Right-click the Platform view and select Configure Platform. The 
Configure Platform dialog box opens.

Enable/disable logging
Logging is enabled by default, and the default log file name is log.txt. In the 
Configure Platform dialog box, you can use Enable logging to specify whether 
to enable or disable logging. If yo need to, you can also specify a new name for 
the log file in Log file name.

Figure 49 Enabling logging and specifying a new log file name.
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Specifying which types of messages to log
In the Configure Platform dialog box, you can specify the log level, i.e. which 
types of error, warning, and information messages to include in the log. To do 
this, you must select the appropriate option in the Log messages of type(s) 
drop-down list.

Figure 50 Specifying the log level.

Creating a new log file at StreamServer start-up
The StreamServer application normally appends log messages to the same log file 
after it is restarted. If you select Remove log file when server starts in the 
Configure Platform dialog box, a new log file is created each time the 
StreamServer application is restarted. The old log file is deleted, and not stored 
anywhere.

Option Description

Severe error messages Only include severe error messages in the log. This is the 
recommended option for the production layer due to 
performance.

All error messages Include all error messages in the log. This can be used in 
the production layer to get more information.

All error and warning messages As the above, plus warning messages. This can also be 
used in the production layer to get even more 
information.

All error, warning and information 
messages

As the above, plus information messages. This is the 
recommended option for the development and test layers.

All error, warning and extended 
information messages

As the above, plus more information messages. This can 
be used in the development and test layers to get more 
information. Note that this option may complicate the 
search for relevant error messages, due to all information 
messages displayed in the log.
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Log file truncation
The StreamServer application normally appends log messages to the same log 
file. This means more and more messages will be appended to the log file. To 
prevent the log file from becoming to large, you can truncate the log file using 
time and file size as trigger. The old log file is then closed and saved, and the 
StreamServer application starts writing to a new log file.

Figure 51 Log file truncation settings in the Configure Platform dialog box.

Using time as trigger

Select Age restrictions and use Maximum age (days) to specify a time trigger. 
When the log file reaches the time limit specified, the old log file is closed and 
moved to the directory specified by Move old log files to.

Using file size as trigger

Select Size restrictions and use Maximum size (MB) to specify a file size 
trigger. When the log file reaches the size limit specified, the old log file is closed 
and moved to the directory specified by Move old log files to.
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Connecting resource sets to the Platform
When you create a Project, a default resource set is automatically added to the 
Project. This default resource set is automatically connected to the Platform. You 
can also connect other resource sets to the Platform.

To connect a resource set to the Platform

1 Activate the generic layer.

2 Right-click the Platform view and select Add Resource Set. The Select 
Resource Sets dialog box opens.

3 Select which resource set to connect and click OK.

To disconnect a resource set from the Platform

1 Activate the generic layer.

2 Right-click the Platform view and select Remove Resource Set. The 
Remove Resource Sets dialog box opens.

3 Select which resource set to disconnect and click OK.
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In this chapter

• Activating a Message view on page 106

• Managing Events on page 107

• Managing Processes on page 112

• Connecting resource sets to a Message configuration on page 114

• Adding scripts to a Message configuration on page 115
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Activating a Message view
Each Message is configured in a separate Message view displayed in the Design 
Center Main window. Before you configure a Message, you must activate the 
corresponding Message view.

To activate a Message view

In the Project browser, double-click the Message node you want to activate. The 
corresponding Message view is activated in the Design Center Main window.
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Managing Events
In this section

• Adding Events to a Message configuration on page 107

• Configuring Events on page 107

• Concatenating Events on page 108

• Deleting an Event on page 111

Adding Events to a Message configuration
A Message configuration normally contains one Event, but if you need to 
concatenate several Events in the same Message configuration you can do so (see 
Concatenating Events on page 108). In most cases you add an Event to a Message 
configuration by creating the Event from scratch, but you can also copy an 
existing Event and paste it to the Message configuration.

To add an Event

1 Right-click the Message view, select Add Event, and select the Event type. 
A new Event is added to the Message view.

2 Rename the Event.

3 Configure the Event (see Configuring Events on page 107).

To copy an Event

1 Right-click the Event you want to copy and select Copy.

2 Right-click the Message view and select Paste. The Event is pasted to the 
Message.

3 Rename the Event.

4 Configure the Event (see Configuring Events on page 107).

Configuring Events
After you add a new Event to a Message configuration, you must configure the 
Event. Event configuration includes the following:

• Configuring triggers, fields, and blocks

• Specifying agent and Event order settings

• Specifying Runtime Event settings

• Scripting (retrieved scripts)
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Configuring triggers, fields, and blocks
Each Event type has its own Event tool. See the corresponding tool 
documentation for information on how to configure triggers, fields, and blocks.

To open the Event tool

1 Double-click the Event. The Event tool opens.

2 Configure the Event and close the tool.

Specifying agent and Event order settings
XMLIN and StreamIN Events have agent settings that you must specify in the 
Event Settings dialog box (see Agent Settings tab on page 251). Event order 
settings are also specified in this dialog box (see Event Order tab on page 252).

To open the Event Settings dialog box

Right-click the Event and select Settings.

Specifying Runtime Event settings
Some Event settings must be specified in the Runtime configuration view to 
which the Message configuration is added. See Managing Events on page 125.

Scripting (retrieved scripts)
You can add retrieved scripts to the Event if you need to. See Scripting in 
StreamServe for information about scripts.

To add a script to an Event

1 Right-click the Event and select Script. The Script editor opens.

2 Enter the script and click OK.

Concatenating Events
If you have several Events of the same type that form a logical entity, you can 
concatenate the Events in the same Message configuration.
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PageIN example

If input data contains multi-page documents with different page layout, for 
example one layout on the first page and another layout on following pages, you 
can concatenate Events, i.e. create one PageIN Event for each page type in the 
same Message configuration.

Figure 52 Input with three different page layouts (page 1, 2, and 3).

Figure 53 Message configuration with three concatenated PageIN Events.

The fields defined in the concatenated Events will be appended to the same 
Message structure. When all fields are appended to the Message structure, it is 
passed on to the Process(es) in the Message.

Patterns

You must use different patterns, or multiple patterns, to specify when to trigger 
which Event.

Non-recurring fields

If non-recurring fields are defined in several Events, the StreamServer tries to add 
the same field to the Message structure several times.

If all documents in the input contains all page types defined by the concatenated 
Events, you should only define non-recurring fields once in all concatenated 
Events, and not once per Event.

If there are documents in the input that do not contain all page types, you need to 
define non-recurring fields in several Events. For example, if a non-recurring 
field normally is defined in the first of the concatenated Events, and the input 
document only contains the page type specified by the second Event, this field 
must also be defined, with the same name, in the second Event.
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Recurring fields and blocks

You can use recurring fields and blocks from all concatenated Events when you 
configure the Process(es) in the Message configuration. Note though that all fields 
and blocks must have unique names.

Block priority

If you use block priorities to group blocks, you must make sure blocks of the same 
type have the same priorities in all concatenated Events.

To concatenate Events

1 Add the Events to the Message view and configure the Events.

2 Configure the Process(es).

3 Right-click the first Event and select Settings. The Event Settings dialog 
box opens.

4 On the Event Order tab, select the appropriate option (First, Repeating, or 
Last). See Ordering the concatenated Events.

5 Repeat steps 3 and 4 for all other Events.

Overriding Event order settings using scripts

You can use the EndMessage scripting function in a Retrieved script to override 
the Event order settings.
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Ordering the concatenated Events
You must specify how to order the concatenated Events. The output from the 
Events are appended to the same Message structure in the order specified on the 
Event Order tab. The Message structure is then passed on to the Process(es).

Figure 54 Ordering three concatenated Events

First

Output from a First Event starts the Message structure.

If there are no more Events in the Message configuration, or if the following 
Event in the Message configuration is also a First Event, the Message structure 
only includes output from this Event.

Repeating

Output from a Repeating Event is appended to the Message structure.

• If there are no preceding Events in the Message configuration, this option is 
the same as the First option.

• If there are no following Events in the Message configuration, this option is 
the same as the Last option.

Last

Output from a Last Event is appended at the end of the Message structure.

If there are no preceding Events in the Message configuration, the Message 
structure only includes output from this Event.

Deleting an Event
Right-click the Event and select Delete.
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Managing Processes
In this section

• Adding Processes to a Message configuration on page 112

• Configuring Processes on page 112

• Deleting a Process on page 113

Adding Processes to a Message configuration
A Message configuration can contain one or more Processes. In most cases, you 
add a Process to a Message configuration by creating the Process from scratch, 
but you can also reuse existing Processes:

• Copy-paste – copy an existing Process and paste it to the Message 
configuration. In this case you create a separate instance of the Process, and 
there is no link between the original Process and the copy.

• Link in a Process – link an existing Process to the Message configuration. 
If you modify the Process, it will be modified in all Message configurations 
using it.

To add a new Process

1 Right-click the Message view, select Add Process, and select the Process 
type. A new Process is added to the Message view.

2 Rename the Process.

3 Configure the Process (see Configuring Processes on page 112).

To copy a Process

1 Right-click the Process you want to copy and select Copy.

2 Right-click the Message view and select Paste. The Process is pasted to the 
Message.

3 Rename the Process.

4 Configure the Process (see Configuring Processes on page 112).

To link in an existing Process

Right-click the Message view, select Add Process > Existing Process, and 
browse to and select the Process. The Process is added to the Message view.

Configuring Processes
After you add a new Process to a Message configuration, you must configure the 
Process. Process configuration includes the following:

• Configuring fields and blocks

• Specifying Runtime Process settings
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• Scripting (before and after Process scripts)

Configuring fields and blocks
Each Process type has its own Process tool. See the corresponding tool 
documentation for information on how to configure fields and blocks.

To open the Process tool

1 Double-click the Process. The Process tool opens.

2 Configure the Process and close the tool.

Specifying Runtime Process settings
Some Process settings must be specified in the Runtime configuration view to 
which the Message configuration is added. See Managing Processes on page 126.

Scripting (before and after Process scripts)
You can add before Process and after Process scripts to the Process if you need 
to. See Scripting in StreamServe for information about scripts.

To add a script to a Process

1 Right-click the Process and select Script. The Script editor opens.

2 Select a Trigger (Before or After).

3 Enter the script and click OK.

Deleting a Process
Right-click the Process and select Delete.
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Connecting resource sets to a Message 
configuration

When you create a Project, a default resource set is automatically added to the 
Project. This default resource set is automatically connected to all Message 
configurations. You can also connect other resource sets to a Message 
configuration.

To connect a resource set to a Message configuration

1 Right-click the Message view and select Add Resource Set. The Select 
Resource Sets dialog box opens.

2 Select which resource set to connect and click OK.

To disconnect a resource set from the Message configuration

1 Right-click the Message view and select Remove Resource Set. The 
Remove Resource Sets dialog box opens.

2 Select which resource set to disconnect and click OK.
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Adding scripts to a Message configuration
You can add scripts to a Message configuration at different stages:

• Retrieved scripts (Events)

• Before and After Message scripts

• Before and After Process scripts

See Scripting in StreamServe for information about scripts.

To add a script

1 Right-click the object (Event, Process, or Message ) and select Script. The 
Script editor opens.

2 Select a Trigger.

3 Enter the script and click OK.
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In this chapter

• Activating a Runtime configuration view on page 118

• Adding and connecting Message configurations on page 119

• Managing Runtime jobs and Post-processors on page 123

• Managing Events on page 125

• Managing Processes on page 126

• Managing output connectors on page 128

• Sorting connectors in a Runtime configuration view on page 131

• Defining Documents on page 132

• Connecting resource sets to a Runtime configuration on page 133
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Activating a Runtime configuration view
All Runtime configuration settings are configured in the Runtime configuration 
view. The same Runtime configuration view is used for the generic layer and all 
physical layers. This means you must activate the appropriate Runtime 
configuration layer before you can configure the settings.

To activate the generic Runtime configuration layer

In the Project browser, double-click the Runtime configuration node.

To activate a physical Runtime configuration layer

1 In the Project browser, expand the Runtime configuration node. All 
physical layer nodes are displayed.

2 Double-click the node for the physical layer to activate.
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Adding and connecting Message 
configurations

In this section

• Adding a Message configuration to a Runtime configuration on page 119

• Linking input connectors to Events on page 119

• Linking Processes to output connectors on page 121

• Unlinking connectors on page 121

• Enabling/disabling Message configurations on page 122

• Removing a Message configuration from a Runtime configuration on page 
122

Adding a Message configuration to a Runtime 
configuration

When you add a Message configuration to a Runtime configuration, you must add 
it to the appropriate Runtime job.

To add a Message configuration

1 Activate the generic layer.

2 Right-click the Runtime job and select Add Message. The Add Messages 
dialog box opens.

3 Select the Message configuration and click OK.

Linking input connectors to Events
When the Message configuration is added to the Runtime configuration, you must 
link the Event to the appropriate input connectors. For example, if you have a 
Message configuration that handles invoices, you must link the Event to the input 
connector that retrieves the invoices from the source application.
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One input connector, several Events

An input connector can be linked to several Events. For example, an input 
connector can deliver page formatted input to a PageIN Event, and XML 
structured input to an XMLIN Event.

Figure 55 One input connector linked to two Events.

One Event, several input connectors

An Event can be linked to several input connectors. For example, a StreamIN 
Event can retrieve input from two separate directories via two separate Directory 
input connectors.

Figure 56 Two input connectors linked to the same Event.

To link an input connector to an Event

1 Activate the generic layer.

2 Draw a line between the connector and the Event (click-draw-release).

To unlink an input connector from an Event

1 Activate the generic layer.

2 Right-click the link and select Delete Link.

If you cannot connect

Some input types, for example Agent on a StreamIN Event, cannot share the 
connector with other Events.
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Linking Processes to output connectors
When the Message configuration is added to the Runtime configuration, you must 
link the Processes to the appropriate output connectors. For example, if you have 
a Message configuration that handles invoices, you must link the Processes to the 
output connectors that deliver the invoices to the target devices (printers, faxes, 
etc.). 

Figure 57 Processes linked to output connectors.

Static and dynamic connections

When you link a Process to an output connector, you can either create a static 
connection or a dynamic connection. 

If you create a static connection, the output is always delivered via the same 
output connector. Note that you cannot create static links from a Process to 
several connectors.

If you create a dynamic connection, variables in the processed data determine 
which output connector to use.

Figure 58 Dynamic connection to three output connectors.

To create a static link

1 Activate the generic layer.

2 Draw a line between the connector and the Process (click-draw-release).

To create a dynamic link

1 Activate the generic layer.

2 Right-click the Process and select Connector Selection. The Connector 
Selection Method dialog box opens.

3 Select the appropriate method, specify the settings, and click OK.

Unlinking connectors
If you want to unlink connectors from Events and Processes, you can do so. How 
to do it depends on whether the connection is static (input and output connector) 
or dynamic (output connector).
StreamServe Persuasion SP5 Design Center User Guide Rev B



122 Adding and connecting Message configurations
Runtime configuration procedures
To unlink a static link

1 Activate the generic layer.

2 Right-click the link and select Delete Link.

To unlink a dynamic link

1 Activate the generic layer.

2 Right-click the Process and select Connector Selection. The Connector 
Selection Method dialog box opens.

3 Select None and click OK.

Enabling/disabling Message configurations
If you want to disable a Message configuration in a Runtime configuration, you 
can do so. The StreamServer application ignores all disabled Message 
configuration when running the Project. 

Physical Runtime configuration layer

You enable/disable Message configurations per physical layer.

To disable a Message configuration

1 Activate the appropriate physical layer.

2 Right-click the Message configuration and select Enabled to cancel the 
selection.

To enable a Message configuration

1 Activate the appropriate physical layer.

2 Right-click the (dimmed) Message configuration and select Enabled.

Removing a Message configuration from a Runtime 
configuration

If you want to remove a Message configuration from a Runtime configuration, 
you can do so. The Message configuration will be removed from the Runtime 
configuration, but it will not be removed from the Project.

To remove a Message configuration

1 Activate the generic layer.

2 Right-click the Message configuration and select Remove Message.
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Managing Runtime jobs and Post-
processors

In this section

• Adding, renaming, and deleting Runtime jobs on page 123

• Adding, renaming, and deleting Post-processors on page 123

• Collapsing/expanding Runtime jobs and Post-processors on page 124

• Scripting on page 124

Adding, renaming, and deleting Runtime jobs
By default, a Runtime configuration contains one Runtime job. If you need to, you 
can add new Runtime jobs.

To add a Runtime job

1 Activate the generic layer.

2 Right-click the Runtime configuration view and select New Job. A new 
Runtime job is added to the Runtime configuration view.

To rename a Runtime job

1 Activate the generic layer.

2 Right-click the job, select Rename, and enter the new name.

To delete a Runtime job

1 Activate the generic layer.

2 Right-click the job, and select Delete Job.

Adding, renaming, and deleting Post-processors

To add a Post-processor

1 Activate the generic layer.

2 Right-click the Runtime configuration view and select New Post-
processor. A new Post-processor is added to the Runtime configuration 
view.

To rename a Post-processor

1 Activate the generic layer.

2 Right-click the Post-processor, select Rename, and enter the new name.

To delete a Post-processor

1 Activate the generic layer.
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2 Right-click the Post-processor, and select Delete Post-processor.

Collapsing/expanding Runtime jobs and Post-
processors

You can collapse or expand the Runtime jobs and Post-processors displayed in the 
Runtime configuration view. When expanded, all Events, Processes, and 
connector links are displayed. When collapsed, all Events, Processes, and 
connector links are hidden.

To collapse or expand a single job

1 Activate the generic layer.

2 In the top-left corner of the job, click - to collapse or + to expand the job.

To collapse all jobs

1 Activate the generic layer.

2 Select Runtime > Collapse all jobs & Post-processors.

To expand all jobs

1 Activate the generic layer.

2 Select Runtime > Expand all jobs & Post-processors.

Scripting
You can add Before and After scripts to Runtime jobs and Post-processors if you 
need to. See Scripting in StreamServe for information about scripts.

To add a script to a Runtime job or Post-processor

1 Right-click the job and select Script. The Script editor opens.

2 Select a Trigger (Before or After).

3 Enter the script and click OK.
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Managing Events
In this section

Ordering Events on page 125

Ordering Events
If several Events are triggered by the same pattern, they are run in the order (top 
down) they are displayed in the Runtime configuration view. You can drag and 
drop the Message configurations to change the order, and you can also specify 
priorities for the Events to change the order.

To specify a priority for an Event

1 Activate the generic layer.

2 Right-click the Event and select Settings. The Runtime Event Settings 
dialog box opens.

3 On the General tab, select a Priority (the higher the number, the lower the 
priority).
StreamServe Persuasion SP5 Design Center User Guide Rev B



126 Managing Processes
Runtime configuration procedures
Managing Processes
In this section

• Ordering Processes on page 126

• Defining rules for triggering Processes on page 126

• Enabling/disabling Processes on page 127

Ordering Processes
Processes are run in the order (top down) they are displayed in the Runtime 
configuration view. You can drag and drop the Processes within a Message 
configuration to change the order.

Defining rules for triggering Processes
You can define rules (operators AND, OR, and NOT) for when to run a Process.

To define rules

1 Right-click the Process and select Settings. The Runtime Process settings 
dialog box opens.

2 On the Rule tab, enter the rule.

Examples

Example 1 Use patterns in the Event to trigger the Process

Rule: idInvoice1 AND idInvoice2 

Result: The Process is run only if the Event contains both patterns idInvoice1 
and idInvoice2. 

Example 2 Use variables in the Process to trigger the Process

Rule: $page=3 OR $page=4 

Result: The Process is run only if the variable $page equals 3 or 4. 

Example 3 Use a connector name to trigger the Process

The before script $InConnector=InConnectorName(); is added to the Event. 

Rule: $InConnector=Input1 

Result: The Process is run only if input comes from the connector Input1. 
StreamServe Persuasion SP5 Design Center User Guide Rev B



Managing Processes 127
Runtime configuration procedures
Enabling/disabling Processes
If you want to disable a Process in a Runtime configuration, you can do so. The 
StreamServer application ignores all disabled Processes when running the 
Project. 

Physical Runtime configuration layer

You enable/disable Processes per physical layer.

To disable a Process

1 Activate the appropriate physical layer.

2 Right-click the Process and select Enabled to cancel the selection.

To enable a Process

1 Activate the appropriate physical layer.

2 Right-click the (dimmed) Process and select Enabled.
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Managing output connectors
In this section

• Configuring physical output connector settings on page 128

• Configuring device driver settings on page 128

• Sheet layout on page 129

• Enveloping, OMR codes, and labels on page 129

• Copying/pasting generic output connector settings on page 129

• Enabling/disabling output connectors on page 129

Configuring physical output connector settings
In the Platform, you specify which connector type to use, and the default settings 
for the selected connector type. In the Runtime configuration, you can override 
the default connector settings in each physical layer.

Physical Runtime configuration layer

You configure connector type settings per physical layer.

Output mode

You configure the connector settings at either Process Begin, Document End, or 
Job End. The option to use depends on the output mode specified for the 
connector.

To configure the output connector settings

1 Activate the appropriate physical layer.

2 Double-click the output connector. The Edit Output Connector Settings 
dialog box opens.

3 Select context and click OK. The Runtime Output Connector Settings dialog 
box opens.

4 On the connector type tab, edit the connector settings.

Configuring device driver settings
In the Platform, you specify which driver type to add to the output connector, and 
the default settings for the selected driver type. In the Runtime configuration, you 
can override the default driver settings and specify Job Begin and Document 
Begin specific driver settings. Where to configure driver settings (Process Begin, 
Document Begin, or Job Begin) depends on the driver type.

Generic Runtime configuration layer

You configure device driver settings in the generic layer.
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To configure device driver settings

1 Activate the generic layer.

2 Double-click the output connector. The Edit Output Connector Settings 
dialog box opens.

3 Select context and click OK. The Runtime Output Connector Settings dialog 
box opens.

4 Click the Process Begin or Document Begin or Job Begin icon.

5 On the Device Driver Settings tab, edit the device driver options.

Sheet layout
See About sheet layout.

Enveloping, OMR codes, and labels
See About document sorting and bundling.

Copying/pasting generic output connector settings
You can copy the generic output connector settings from one output connector 
(source connector), and paste them to another output connector (target 
connector). For example, if you create a new output connector with complex 
runtime settings (AFP driver, OMR codes, enveloping, etc.), and already have 
another output connector with similar settings, you can copy the settings from the 
existing connector, and paste them to the new connector.

Generic Runtime configuration layer

You can only copy/paste connector settings in the generic layer. All generic 
settings (except for notes) will be copied and pasted.

To copy/paste output connector settings

1 Activate the generic layer.

2 Right-click the source connector, and select Copy Connector Settings.

3 Right-click the target connector, and select Paste Connector Settings.

Enabling/disabling output connectors
If you want to disable an output connector in a Runtime configuration, you can do 
so. The StreamServer application ignores all disabled connectors when running 
the Project. 
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Physical Runtime configuration layer

You enable/disable output connectors per physical layer.

To disable an output connector

1 Activate the appropriate physical layer.

2 Right-click the output connector and select Enabled to cancel the selection.

To enable an output connector

1 Activate the appropriate physical layer.

2 Right-click the (dimmed) output connector and select Enabled.
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Sorting connectors in a Runtime 
configuration view

The connectors in a Runtime configuration view are by default displayed in the 
same order as they are added to the Platform view. If you want to, you can 
organize the connectors as you like in each Runtime configuration view.

You can sort the connectors using drag and drop, sort them in alphabetical order 
(ascending or descending), or sort them in the same order as they are organized in 
the Platform view.

Figure 59 Sorting connectors in a Runtime configuration view.

To sort connectors in ascending/descending order

Right-click a connector and select Sort Connectors Ascending or Sort 
Connectors Descending.

To sort connectors as they are displayed in the Platform view

Right-click a connector and select Sort Connectors As In Platform.

To move a connector

Drag the connector to the desired position.
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Defining Documents
In output mode Document, the output connector waits until the output documents 
are grouped per customer number, delivery address, etc. See Output mode 
Document on page 21 for more information about output mode Document. To 
enable output mode Document, you must:

• Select output mode Document in the generic Platform layer for the 
connector.

• Define the document, i.e. the document trigger, for the Runtime job and 
output connector.

Generic Runtime configuration layer

You create the Document trigger in the generic layer.

To create a Document trigger

1 Activate the generic layer.

2 Double-click the connector. The Edit Output Connector Settings dialog box 
opens.

3 Double-click the job for which you want to define the Document. The 
Runtime Output Connector Settings dialog box opens.

4 Click the Document Trigger icon and enter the Document trigger 
variable.
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Connecting resource sets to a Runtime 
configuration

When you create a Project, a default resource set is automatically added to the 
Project. This default resource set is automatically connected to all Runtime 
configurations. You can also connect other resource sets to a Runtime 
configuration.

To connect a resource set to a Runtime configuration

1 Activate the generic layer.

2 Right-click the Runtime configuration view and select Add Resource Set. 
The Select Resource Sets dialog box opens.

3 Select which resource set to connect and click OK.

To disconnect a resource set from the Platform

1 Activate the generic layer.

2 Right-click the Runtime configuration view and select Remove Resource 
Set. The Remove Resource Sets dialog box opens.

3 Select which resource set to disconnect and click OK.
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procedures

In this chapter

• Resource set management on page 136

• Resource management on page 139
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Resource set management
In this section

• Connecting a resource set to a Project component on page 136

• Adding folders to a resource set on page 136

• Adding resources to a resource set on page 136

Connecting a resource set to a Project component
The Project’s default resource set is automatically connected to all Project 
components (Platform, Runtime configuration, and Message configuration). If 
you need to, you can connect other resource sets to a Project component.

To connect a resource set to a Project component

1 Activate the Project component view in the Main window (for example, 
double-click the corresponding node in the Project browser).

2 Right-click the component view, and select Add Resource Set. The Select 
Resource Sets dialog box opens.

3 Select the resource set to connect, and click OK.

To disconnect a resource set from a Project component

1 Activate the Project component view in the Main window.

2 Right-click the component view, and select Remove Resource Set. The 
Remove Resource Sets dialog box opens.

3 Select the resource set to disconnect, and click OK.

Adding folders to a resource set
You can structure the resources in a resource set by inserting folders and sub 
folders. You can then add the resources to the appropriate folders. You can also 
drag and drop resources within the resource set tree.

To create a resource set folder

1 Right-click the node (root node or folder) where you want to add the folder, 
and select New > Folder. A new folder is added.

2 Rename the folder.

Adding resources to a resource set
When you add a resource to a resource set, you create a link from the resource set 
to a physical resource file. This means the same resource file can be linked to 
several resource sets. You can add resources to a resource set in different ways:
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• Create a new resource file using a resource editor, and link the resource file 
to the resource set. See Creating resources using resource editors on page 
137.

• Create a new resource file by importing a source file, and link the resource 
file to the resource set. Creating resources by importing source files on page 
137.

• Link an existing resource file to the resource set. Linking existing resources 
on page 138.

• Create a new font resource file by importing a font, and link the resource 
file to the resource set. Importing fonts on page 138.

Creating resources using resource editors
Using this method, you create a resource file in your Project directory, and link 
the resource file to the resource set.

To edit the resource, you must use the resource editor. See Editing resources using 
resource editors on page 139.

To create a resource using a resource editor

1 Right-click the resource set, select New and the resource type. A new 
resource is added to the resource set.

2 Rename the resource.

3 Double-click the resource. The resource editor opens.

4 Configure the resource, save the resource, and close the editor.

Creating resources by importing source files
Using this method, you create a resource file in your Project directory, and link 
the resource file to the resource set.

To edit the resource, you can edit the source file, and then update the resource. 
See Editing imported resources on page 140. If you have specified a resource 
editor for the resource, you can also use the resource editor to edit the resource. 
See Editing resources using resource editors on page 139.

To create a resource by importing a source file

1 Right-click the resource set, select Import and browse to and select the 
source file. The Resource Type Settings dialog box opens.

2 Specify the resource type and click OK. A new resource is added to the 
resource set.

3 Rename the resource.
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Linking existing resources
Using this method, you can link an existing resource file, located in another 
Project’s Project directory, to the resource set. For example, you can link a 
logotype shared by several Projects to the resource set.

If you edit a linked resource, it will be changed in all resource sets using it.

To link in an existing resource

Right-click the resource set, select Add Resource and browse to and select the 
resource file. A new resource is added to the resource set.

Importing fonts
This is a special case of importing source files. Using this method, you can 
manually import fonts from the Fonts directory to the resource set. 

To import fonts

1 Right-click the resource set, and select Import Font. The Select Fonts 
dialog box opens.

2 Specify the fonts to import, and click OK. The new resources are added to 
the resource set.

Importing all used fonts

There is also an alternative to import fonts manually. You can select to add all 
used fonts to a resource set when you export the Project. This ensures that all fonts 
are available if you move the Project to a new machine.

You do this in the Export dialog box by selecting the option Add exported fonts 
to Platform’s default resource set.
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Resource management
In this section

• Editing resources using resource editors on page 139

• Editing imported resources on page 140

• Changing the resource type on page 140

• Specifying resource editors on page 140

• Extracting a resource to file on page 141

• Showing resource dependencies on page 141

Editing resources using resource editors
The resource types shown in the table below have resource editors that you can 
use when editing the resource.

Resource type Default resource editor

Description file UTF8 Edit

Document Type Document Type Editor

Filter Chain Filter Chain Editor

Function file Script Editor

Layout Template UTF8 Edit

Metadata Group MetaData Group Editor

OutputPlus 
configuration

UTF8 Edit

Overlay Overlay Editor

Post-processor 
Query

Post-processor Repository Tool

RDI Setting UTF8 Edit

Rule Rule Editor

Sample UTF8 Edit

Security 
configuration

Security Editor

Sheet Layout Sheet Layout Editor

StoryTeller 
Document

StoryTeller tool

SXD file UTF8 Edit
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If you want to edit other resource types using a resource editor, you must specify 
which editor to use. See Specifying resource editors on page 140.

To edit a resource using a resource editor

1 Double-click the resource. The resource editor opens.

2 Edit the resource file, save it, and close the editor.

Editing imported resources
If you have created a new resource using the Import command, you can edit the 
source file, and then apply the changes to the resource.

To edit an imported resource

1 Edit the source file.

2 Right-click the resource and select Update From Origin.

Changing the resource type
When you create a resource using the New command, you select which resource 
type to create. When you create a resource using the Import command, you 
specify the resource type for the imported resource. In both cases, you can change 
the resource type afterwards.

To change the resource type

1 Right-click the resource and select Resource Type. The Resource Type 
Settings dialog box opens.

2 Select the resource type, and click OK.

Specifying resource editors
When you create a resource using the Import command, you must specify a 
resource type for the imported resource. Some resource types, for example 
Image, do not have default resource editors. In this case, you can specify a editor 
for the imported resource.

When you create a resource using the New command, you select which resource 
type to create. All these resource types have default resource editors. You can 
change the resource editor for all resource types but the following:

Table file UTF8 Edit

XDP Template UTF8 Edit

XML Stylesheet UTF8 Edit

Resource type Default resource editor
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• Document Type

• Filter Chain

• Metadata Group

• Post-processor Query

• RDI Setting

• Security configuration

• StoryTeller document

To select a resource editor

1 Right-click the resource and select Resource Editor. The Set Resource 
Editor dialog box opens.

2 Select Pick resource editor, browse to and select the resource editor, and 
click OK.

Extracting a resource to file
You can extract the data embedded in a resource file. For example, if you have an 
image resource, you can extract the image data to an image file. Note that you 
cannot extract data from all resource types. For example, you cannot extract data 
from filter chains or security configurations. 

To extract the resource contents

1 Right-click the resource and select Extract To File. A file browser opens.

2 Specify the file path, including file name and extension, and click OK.

Showing resource dependencies
You can retrieve information about which objects (Processes, overlays, etc.) are 
affected when you modify a resource. This applies to the following resource 
types:

• Image

• Overlay

• Sheet Layout

• Metadata Group

• Rule
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The objects are listed in the Show Dependencies dialog box.

Figure 60 The Show Dependencies dialog box.

To open the Show Dependencies dialog box

Right-click the resource, and select Show Dependencies.

Navigating to the objects

You can navigate to the objects from the Show Dependencies dialog box: 

1 Select the object, and click Go to selected item. The corresponding view 
opens with the object highlighted.

2 Open the object.
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In this chapter

• Alias overview on page 144

• Script alias on page 146

• Lookup alias on page 148
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Alias overview
You can use aliases to configure settings dynamically. You can do this for various 
features, such as selection of overlays, output connectors, driver settings, etc.

Several alternatives

An alias includes several alternatives. The alias also includes the conditions for 
when to select a specific alternative. For example, an alias for output connector 
selection contains several connector alternatives, and the conditions for when to 
select a specific connector.

Two types of aliases

There are two types of aliases:

• Script alias, where you use scripting to determine which alternative to 
select.

• Lookup alias, where you use lookup tables to determine which alternative to 
select.

Script alias

The script contains a number of statements to determine which alternative to 
select. The example below shows a script for output connector selection, where 
the alternatives (connector names) are spoolSWE and spoolFIN.

if(&countryCode = "SWE")

{

   $connector = "spoolSWE";

}

if(&countryCode = "FIN")

{

   $connector = "spoolFIN";

}

See Script alias on page 146 for more information.

Lookup alias

The lookup table is a text file that includes all the alternatives. The example below 
shows a lookup table for output connector selection, where the alternatives 
(connector names) are spoolSWE and spoolFIN.

SWE    spoolSWE

FIN    spoolFIN

See Lookup alias on page 148 for more information.

Default alternative

You must specify a default alternative. This alternative is used if there is no 
matching condition specified in the alias. For example, the script alias above 
includes conditions for &countryCode="SWE" and &countryCode="FIN". If 
&countryCode is neither SWE nor FIN, the default alternative is used.
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When to use script alias, and when to use lookup alias

There are no general rules for when to use script alias, or when to use lookup alias. 
There are however some features, for example font size and font color, that do not 
support lookup alias.

Where to set the alias

You set aliases in the Design Center user interface at the same place as you set 
fixed values. Instead of setting a fixed value, you select a default alternative, 
specify the type of alias (script or lookup), and specify the alias parameters.
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Script alias
A script alias consists of a key, a script, and an alias variable.

Key

The key is used in the script conditions. You can use a field reference 
(&fieldname) or a variable ($variable) as key. 

Script

In the script, you use the key to specify conditions for when to select a specific 
alternative. A connector selection example is shown below:

//Select the appropriate output connector

if(&countryCode = "SWE")

{

   $connector = "spoolSWE";

}

if(&countryCode = "FIN")

{

   $connector = "spoolFIN";

}

Alias variable

The alias variable is the variable you use when you set the alias in the Design 
Center user interface. The value of this variable is set by the script. In the script 
above, $connector is the alias variable. 

Note that the alias variable must be a variable ($variable). It must not be a field 
reference (&fieldname).

Setting a script alias

To set a script alias for a feature, you select the alias type Variable and specify an 
alias variable. The figure below shows the Connector Selection Method dialog 
box where you use the alias variable $connector to select the appropriate output 
connector.

Figure 61 Script alias for connector selection.
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Script alias example
In this example, a script alias is used to select the appropriate output connector:

• spoolSWE – output connector used for invoices with country code SWE. 
This is also the default connector alternative.

• spoolFIN – output connector used for invoices with country code FIN.

Key

The country code is used to determine which connector to select. In this example, 
the field reference &countryCode is used as key. This is a reference to the Event 
field countryCode.

Script

The script is a Before Message script that uses &countryCode to determine which 
connector to select, and sets the value of the alias variable $connector to the 
name of the selected connector.

//Select the appropriate output connector

if(&countryCode = "SWE")

{

   $connector = "spoolSWE";

}

if(&countryCode = "FIN")

{

   $connector = "spoolFIN";

}

Setting the alias

The alias is set in the Connector Selection Method dialog box.

How it works

1 The StreamServer application processes an invoice.

2 The field reference &countryCode in the current invoice equals SWE.

3 The Before Message script is run, and $connector is set to spoolSWE.

4 The connector alias is set to spoolSWE, and the invoice is sent to the 
connector spoolSWE.
StreamServe Persuasion SP5 Design Center User Guide Rev B



148 Lookup alias
Dynamic selection using aliases
Lookup alias
A lookup alias consists of a key and a lookup table.

Key

The key is used to find the appropriate alternative in the lookup table. You must 
use a variable ($variable) as key, for example $countryCode.

Lookup table

The lookup table is a resource that you add to the appropriate resource set. The 
lookup table contains two columns:

• The first column contains the key value.

• The second column contains the alternative associated with the key value.

A connector selection lookup table is shown below:

SWE    spoolSWE

FIN    spoolFIN

Setting a lookup alias

To set a lookup alias for a feature, you select the alias type Lookup and specify a 
key variable and lookup table. The figure below shows the Connector Selection 
Method dialog box where you use the key variable $countryCode and lookup 
table connectors.tbl to select the appropriate output connector.

Figure 62 Lookup alias for connector selection.

Lookup alias example
In this example, a lookup alias is used to select the appropriate output connector:

• spoolSWE – output connector used for invoices with country code SWE. 
This is also the default connector alternative.

• spoolFIN – output connector used for invoices with country code FIN.
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Key

The country code is used to determine which connector to select. In this example, 
the variable $countryCode is used as key. This is a variable created for the Event 
field countryCode.

Lookup table

The lookup table is called connectors.tbl. It contains two rows, where each row 
consists of a key value (the value of $countryCode) and an alternative associated 
with the key value:

SWE    spoolSWE

FIN    spoolFIN

Setting the alias

The alias is set in the Connector Selection Method dialog box.

How it works

1 The StreamServer application processes an invoice.

2 The field variable $countryCode in the current invoice equals SWE.

3 The StreamServer application finds the key value SWE and the 
corresponding connector alternative spoolSWE in the lookup table.

4 The connector selection alias is set to spoolSWE, and the invoice is sent to 
the connector spoolSWE.
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Filters and filter chains

In this chapter

• About filters and filter chains on page 152

• Creating filter chains on page 153

• Adding filter chains to connectors on page 154

• Filter reference on page 155
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About filters and filter chains
You can apply filters to input and output data. For example, if the input data is 
compressed you must apply a decompression filter to the input data. See Filter 
reference on page 155 for information about available filters.

Filter chains

When you create a filter, you must first create a filter chain resource. Then you 
add the filter to the filter chain, and configure the filter settings. See Creating filter 
chains on page 153 for information on how to create a filter chain.

Adding filters to a connector

To add a filter to a connector, you must add a filter chain that contains the filter 
to the connector. See Adding filter chains to connectors on page 154 for 
information on how to add a filter chain to a connector.
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Creating filter chains
You must create the filter chain in a resource set connected to the Platform.

To create a filter chain

1 Open the resource set.

2 Right-click in the resource set and select New Resource > Filter Chain. A 
new filter chain is added to the resource set.

3 Rename the filter chain.

To add a filter to a filter chain

1 Double-click the filter chain. The filter chain editor opens.

2 Right-click the flow bar, select Add Filter, and select the filter type. The 
filter is added to the flow bar.

3 Select the filter and edit the properties.

Several filters in one filter chain

A filter chain can contain several filters. The filters are applied in order they are 
displayed in the filter chain editor.

To order filters in a filter chain

Drag the filters to the appropriate positions in the flow bar.
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Adding filter chains to connectors
Adding filter chains to connectors in the Platform

In the Platform, you can add filter chains to both input and output connectors. In 
this case the filter chain is applied to all data sent through the connector. See 
Adding a filter chain to a connector on page 154 for information on how to add a 
filter chain to a connector.

Applying filter chains per input type

Filter chains can also be applied per input type. For example, if you have an input 
connector that receives both page formatted and record based input, you can apply 
one filter chain to the page formatted input, and another filter chain to the record 
based input. If you also have added a filter chain to the input connector in the 
Platform, this filter chain is applied to both the page formatted and record based 
input. See Applying filter chains per input type on page 154 for information on 
how to apply filter chains per input type.

Adding a filter chain to a connector
1 Activate the generic Platform layer.

2 Right-click the connector and select Settings. The Connector Settings 
dialog box opens.

3 Click the Filter Chain icon.

4 From the Look in drop-down list, select the resource set that contains the 
filter chain you want to add. All filter chains in the selected resource set are 
displayed in the list of items. If the filter chains is located in a folder, you 
must double-click the folder to display the filter chains.

5 Double-click the filter chain you want to add and click OK.

Applying filter chains per input type
1 In the Project browser, right-click the Project node and select Project 

Export Settings. The Project Export Settings dialog box opens.

2 Select the InputAnalyzer tab.

3 In the Available connectors list, select the connector.

4 In the Input Analyzer settings list, select the input type and click the 
Select a Filter Chain icon. The Browse for Resources dialog box opens.

5 From the Look in drop-down list, select the resource set that contains the 
filter chain you want to add. All filter chains in the selected resource set are 
displayed in the list of items. If the filter chains is located in a folder, 
double-click the folder to display the filter chains.

6 Double-click the filter chain you want to add and click OK.
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Filter reference
Bypass filter

Bypasses the StreamServer, and sends the input data directly to a designated 
output connector. See Bypass filter settings on page 156.

Note: Even if you use the bypass filter to bypass all the input data, you must 
connect the input connector to a dummy Event. If you do not connect the 
input connector to an Event, the filter chain will not be activated.

Code page filter

This filter is used to apply a code page for the input data. See About code pages 
and Unicode support for more information.

CollectorArchive filter

This filter archives output data in the storage for Collector. Any metadata 
intended for archiving is archived together with the data.

Note: If you use the CollectorArchive Filter, you must create and configure the 
storage for Collector in Control Center. You must also configure an 
Archiver application, which will transfer the documents to the storage. For 
more information, see Control Center documentation > StreamStudio 
Collector configurations. The storage is referred to as the StreamServe 
archive in the Control Center documentation.

Archiving via the CollectorArchive filter is an alternative to archiving via the 
output connector. When using the filter, you must assign a document type to the 
data to be archived. You assign the document type in the Runtime Output 
Connector dialog box, on the Archiving tab. 

To avoid double archiving, make sure that No is selected in the Collector Archive 
area. The options Device independent copy and Compress documents in 
archive are not available for the CollectorArchive filter.

Compression filter

This filter compresses the output data.

Decompression filter

This filter decompresses the input data.

External filter

This filter reads data from standard input, sends it to the specified filter, and 
delivers the filtered data back on standard output. The specified filter can be any 
executable.

File filter

This filter converts characters in the input data using a conversion table. See File 
filter settings on page 158.
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GenericArchive filter

This filter archives output data in an external archive. Any metadata is archived 
in an index file together with the data. See GenericArchive filter settings on page 
159.

Archiving via the GenericArchive filter is an alternative to archiving via the 
Generic Archive output connector. When using the GenericArchive filter, you can 
use any type of output connector for the final delivery of the output data.

You must assign a document type to the data to be archived. You assign the 
document type in the Runtime Output Connector dialog box, on the Archiving 
tab.

Internal filter

This filter handles escape codes (HpPcl, Esc0, and URL) in the input data. See 
Internal filter settings on page 160.

Job filter

This filter enables the StreamServer to divide large input jobs into several small 
jobs. Sequences in the input data determine the size of each job. See Job filter 
settings on page 161.

AFPIN filter

This filter enables the StreamServer to identify and extract AFPDS (Advanced 
Function Presentation Data Stream) formatted input. See The AFPIN filter for 
more information.

PDFIN filter

This filter enables the StreamServer to identify and extract PDF formatted input. 
See The PDFIN filter for more information.

LiveCycle filter

This output filter is used to integrate Adobe LiveCycle ES processes into the 
StreamServer pipeline when processing documents. See LiveCycle filter on page 
162.

Bypass filter settings
This filter bypasses the StreamServer, and sends the input data directly to a 
designated output connector. The filter settings are described in the table below.

Start in bypass If selected, all input received between StreamServer 
start-up and the first Bypass off trigger is sent to the 
Bypass connector.

Bypass connector The name of the output connector to send the input data 
to. 
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Examples

Example 4 Bypass sequences

Settings:
Bypass on = #ON and Bypass off = #OFF

Input data:
xyz;#ONabc;def;ghi#OFF;jkl

Bypassed data: 
abc;def;ghi

Initial time-out N/A

Bypass time-out Time-out (seconds). Overrides the ordinary connector 
time-out 

Bypass on Sequence in input data that activates the bypass filter. For 
example: 

#bypassON

Remove (bypass 
on)

Select whether to remove the Bypass on sequence from 
output data. 

Bypass off Sequence in input data that deactivates bypass mode. For 
example: 

#bypassOFF

Remove (bypass 
off)

Select whether to remove the Bypass off sequence from 
output data. 

Append output to 
job

Allows the output sent to the bypass connector to be 
treated as a unit. For example, if the bypass connector is 
a File connector, the output will end up in the same file.

Overlay resource Optional overlay to include in the output.

Overlay select Sequence in input data that indicates “here comes an 
overlay”. For example:

#ovl

Remove (overlay 
select)

Select whether to remove the Overlay select sequence 
from output data. 

Overlay trigger Sequence in input data that indicates the end of the 
overlay file name. For example: 

##

Remove (overlay 
trigger)

Select whether to remove the Overlay trigger sequence 
from output data. 
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Example 5 Overlay sequences

Settings:
Overlay select = #OVL and Overlay trigger = ##

Input data:
abc;def;#OVLlogo.prn##ghi;jkl

Result: 
The file logo.prn is sent between “#OVL” and “##”.

File filter settings
This filter coverts characters in the input data using a conversion table. The 
settings are described in the table below.

Examples

Example 6 Conversion table

// Substitute ALPHA with BETA

ALPHA

BETA

// Substitute line feed with carriage return and line feed

<0A>

File The conversion table that describes how to convert the 
characters. The conversion table must be available in the 
same resource set as the filter chain. Use the following 
syntax in the conversion table:

input_string_1

output_string_1

input_string_2

output_string_2

...

input_string_N

output_string_N

The strings are case sensitive, and you must comment 
empty rows with // or *.

You can use hexadecimal notation within angle brackets 
(<hex>). Some characters (tab, line feed, angle brackets, 
quotation marks, etc.) must have hexadecimal notation. 
You can separate multiple hex values with comma. For 
example:

<0D,0A>
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<0D,0A>

// Substitute " with ()

<22>

<28,29>

// Substitute \ with /

<5C>

<2F>

GenericArchive filter settings
This filter archives output data in an external archive. Any metadata is archived 
in an index file together with the data.

What settings to specify depends on the requirements from the archiving system. 
For example, if a third-party archiving client scans the directory for index files 
with a certain extension, you must specify this extension. As the extension is 
added at job end, you prevent the archiving client from accessing an index file 
before it is completed.

The settings are described in the table below.

Setting Description

Output directory The root directory for the output. The output is 
temporarily stored in the root directory before it is sent to 
the archiving system. You can use variables.

Output document 
name prefix

A prefix that is added to the output data at job end. You 
can use variables.

Output document 
name extension

An extension that is added to the output data at job end. 
You can use variables.

Output document 
name

The name for the output data. You can use variables. If no 
name is specified, a name is automatically generated.

Output document name overrides the Output 
document name prefix and Output document name 
extension settings.

Index file name 
prefix

A prefix that is added to the index file at job end. You can 
use variables.

Index file name 
extension

An extension that is added to the index file at job end. 
You can use variables.
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Internal filter settings
This filter handles escape codes (HpPcl, Esc0, and URL) in the input data. The 
settings are described in the table below.

Index file name The name for the index file. You can use variables. If no 
name is specified, an index file name is automatically 
generated.

Index file name overrides the Index file name prefix 
and Index file name extension settings.

External archive 
command

A command to execute when all files are added to the 
Output directory. You can use variables.

Use %doc for document name and %idx for index name. 
If the command includes a path with spaces, the path 
must be specified within apostrophes.

Note: Do not us any command that moves or removes 
the files. Use the Remove files after external 
archive command instead.

Remove files after 
external command 
execution

Removes the files (in the Output directory) after 
successful completion of the External archive 
command. At a successful completion, the External 
archive command returns the value 0.

Setting Description

Internal > HpPcl Removes HpPcl escape codes from the input data.

StreamServer detects an escape code as an ESC character 
(0x1b) followed by any number of characters. The “end 
of escape code” character is an upper case letter 
(character in the range [0x41..0x5a]).

When StreamServer detects an ESC character, it removes 
all characters until it finds an upper case letter (including 
the upper case letter).

Note: If no “end of escape code” is found, input is 
truncated at the ESC character.
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Job filter settings
This filter enables the StreamServer to divide large input jobs into several small 
jobs. Sequences in the input data determine the size of each job. The settings are 
described in the table below.

Examples

Example 7 Job filter

This example displays two scenarios where one large input job is divided into 
smaller jobs.

Internal > Esc0 Removes Esc0 escape codes from the input data.

StreamServer detects an escape code as an ESC character 
(0x1b) followed by any number of characters. The “end 
of escape code” character is a NULL character (0x00).

When StreamServer detects an ESC character, it removes 
all characters until it finds a NULL character (including the 
NULL character).

Note: If no “end of escape code” is found, input is 
truncated at the ESC character.

Internal > URL • Converts URL escape codes (%20 to space etc.).

• Converts ‘&’ (ampersand) to <0D, 0A> (carriage 
return - line feed).

• Converts ‘+’ (plus sign) to ‘ ‘ (space).

Job begin Sequence specifying the beginning of a job. For example: 

[JOB BEGIN]

Job end Sequence specifying the end of a job. For example: 

[JOB END]
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LiveCycle filter
StreamServer can use a LiveCycle output filter to invoke LiveCycle processes 
that are deployed within Adobe LiveCycle ES and exposed through web services. 
These web services can be used to integrate LiveCycle processes into the 
StreamServer pipeline when processing documents.

The filter settings are described in the table below.

Setting Description

Host name The host name or IP address of the server 
hosting LiveCycle ES. For example:

localhost

Port The port used by the LiveCycle ES server. For 
example:

8080

Web service name The name (case sensitive) of the service to 
invoke. This name must be the same as the 
corresponding process created in LiveCycle 
Workbench ES. 

User name User name to connect to the server hosting 
LiveCycle ES. Used in case of basic HTTP 
authentication.

Password Password to connect to the server hosting 
LiveCycle ES. Used in case of basic HTTP 
authentication.

Enable asynchronous 
communication

Yes
Make asynchronous calls to the service. This 
option is used when invoking long-lived 
LiveCycle services.

No
Make synchronous calls to the service. This 
option is used when invoking short-lived 
LiveCycle services.

Asynchronous poll interval Only used together with asynchronous calls. 
This is the interval (milliseconds) used to 
check for a response to the invocation request.

Root certificate for SSL 
communication

The root certificate used when HTTPS is used 
as web service protocol (secure 
communication). The certificate must be 
available from a resource set connected to the 
Platform.
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Custom options A list of custom keys (key-value pairs) to 
include in the invocation request.

To be able to handle custom keys, the service 
must have a variable named optionsMap of the 
type map. All custom keys defined here will be 
added to the optionsMap variable in the 
invoked service.

The values provided can be extracted in the 
receiving LiveCycle process by using an 
XPath expression in the LiveCycle process.

Examples of custom keys are passwords for 
creating password encrypted PDF files. For 
example:

Key: pdfpassword

Value: encrypted

Setting Description
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Sorting documents

In this chapter

• Sorting documents – overview on page 166

• Sort keys on page 168

• Sorting before Process on page 169

• Sorting after Process on page 172

• Sorting Documents on page 173
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Sorting documents – overview
An input job contains several documents (invoices, delivery notes, etc.). If no 
sorting is applied, the documents are processed in the order they are received. In 
some situations you need to sort the documents. For example, to be able to use a 
Document trigger, you may have to sort the input documents before they are 
processed.

Sort keys

You use sort keys to specify how to sort documents. See Sort keys on page 168.

Sorting before or after Process

You can sort documents either before or after they are handled by the Processes.

When to sort before Process

You should always try to sort documents before Process, due to performance 
reasons. See Sorting before Process on page 169.

When to sort after Process

You must sort after Process if the sort key variables are defined in a Process. See 
Sorting after Process on page 172.

Sorting Documents

You can sort the output after it is grouped as Documents (using a Document 
trigger). This also applies to documents retrieved from a Post-processor 
repository. See Sorting Documents on page 173.

Scenario – No sorting
The figure below illustrates a simple scenario where the input job contains four 
documents:

• One hardware invoice (hw) and one software invoice (sw) to customer 01.

• One hardware invoice and one software invoice to customer 02

.

Figure 63 Processing a job – no sorting applied.
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Output mode Document

In this scenario, it is not possible to group hardware and software invoices by 
customer, since the Document trigger changes after each processed document. 
This would result in four Documents (one invoice per Document) instead of two 
Documents (one hardware and software invoice per Document).

Figure 64 Using $customerNumber as Document trigger – no sorting applied.

To be able to create Documents by customer, the invoices must first be sorted by 
customer.

1 The StreamServer application receives the input job.

2 No sorting is done, and the Processes handle documents in the same 
order as they are received.

3 The documents are delivered in the same order as they are received.
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Sort keys
You use sort keys to specify how to sort documents. A sort key is a variable 
defined in the Message configuration, or a metadata key if you are sorting 
documents retrieved from a Post-processor repository. For example, if you assign 
a variable called $customerNumber to the Event field customerNumber, you can 
use $customerNumber as sort key.

Multiple sort keys

You can use multiple sort keys. For example, if you use $customerNumber as the 
first sort key, and $documentType as the second sort key, the documents are first 
sorted by $customerNumber, and then by $documentType.

Numeric or string variables

When you specify a sort key, you must select the appropriate type. If the sort key 
is a string variable you must select Type > String, and if the sort key is a numeric 
variable, you must select Type > Numeric.

Sorting ascending or descending

The default sort order is descending. But if you need to, you can change the sort 
order to ascending.

Changing the order of the sort keys

The sort keys are applied in the order they are displayed in the Edit Sort Definition 
dialog box. You can select any sort key, and use the Move arrows to move the sort 
key to the appropriate position.

Figure 65 Moving sort key $documentType.
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Sorting before Process
You should always try to sort documents before Process. To sort documents 
before Process, you must add one or more sort keys to the Runtime job.

To add a sort key

1 Activate the generic layer.

2 Right-click the Runtime job and select Edit Sort Definition. The Edit Event 
Sort Definition dialog box opens.

3 Click Add New. The Add Sort Key dialog box opens.

4 Add the sort key and click OK.

Scenario – Sorting before Process using one sort key
The figure below illustrates a simple scenario, where $customerNumber is used 
as sort key.

Figure 66 Sort before Process using $customerNumber as sort key.

In this scenario, the documents are not delivered in the same order.

1 The StreamServer application receives the input job.

2 The documents are sorted using $customerNumber as sort key:

3 All customer 01 documents are delivered before the customer 02 
documents.

Customer Document order

01 1 Software invoice

2 Hardware invoice

02 1 Hardware invoice

2 Software invoice
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Output mode Document 

In this scenario, you can use $customerNumber as Document trigger to group 
hardware and software invoices per customer. The documents are not in the same 
order in all Documents. This is corrected in Scenario – Sorting before Process 
using multiple sort keys on page 170.

Figure 67 Creating Documents using $customerNumber as sort key and 
Document trigger.

Scenario – Sorting before Process using multiple sort 
keys

The figure below illustrates a simple scenario, where two sort keys are used:

• $customerNumber

• $documentType

Figure 68 Sort before Process using $customerNumber and $documentType as 
sort keys.

1 The StreamServer application receives the input job.

2 The documents are sorted using $customerNumber the first sort key.

3 The documents are sorted using $documentType as the second sort key.

4 All customer 01 documents are delivered before the customer 02 
documents.
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In this scenario, the hardware invoices are delivered before the software invoices.

Output mode Document 

In this scenario, you can use $customerNumber as Document trigger to group 
hardware and software invoices per customer.

Figure 69 Creating Documents using $customerNumber and $documentType as 
sort keys, and $customerNumber as Document trigger.

Customer Document order

01 1 Hardware invoice

2 Software invoice

02 1 Hardware invoice

2 Software invoice
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Sorting after Process
You must sort after Process if the sort key variables are defined in the Process. To 
sort documents after Process, you must add one or more sort keys to the output 
connector in the generic Runtime configuration layer.

To add a sort key

1 Activate the generic layer.

2 Double-click the connector. The Edit Output Connector Settings dialog box 
opens.

3 Double-click the Runtime job that contains the Document. The Runtime 
Output Connector Settings dialog box opens.

4 Click the Document End icon.

5 On the Process Sort Definition tab, click Edit Process Sort Definition. The 
Edit Process Sort Definition dialog box opens.

6 Click Add New. The Add Sort Key dialog box opens.

7 Add the sort key and click OK.

Scenario – Sorting after Process using one sort key
The figure below illustrates a simple scenario where documents are sorted before 
Process using $customerNumber as sort key, and after Process using 
$documentType as sort key. In this scenario, $documentType is defined in the 
Processes (Process1 and Process2).

Figure 70 Sort before Process using $customerNumber as sort key, and after 
Process using $documentType as sort key.

1 The StreamServer application receives the input job.

2 Sorting is done before Process using $customerNumber as sort key:

3 Sorting is done after Process using $documentType as sort key.
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Sorting Documents
You can sort the output after it is grouped as Documents (using a Document 
trigger). This also applies to documents retrieved from a Post-processor 
repository, and can be used to sort documents within envelopes if enveloping is 
enabled.

To sort Documents, you must add one or more sort keys to the output connector 
in the generic Runtime configuration layer.

To add a sort key

1 Activate the generic layer.

2 Double-click the connector. The Edit Output Connector Settings dialog box 
opens.

3 Double-click the Runtime job or Post-processor job that contains the 
documents. The Runtime Output Connector Settings dialog box opens.

4 Click the Job End icon.

5 On the Document Sort tab, click Add New. The Add Sort Key dialog box 
opens.

6 Add the sort key and click OK.
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Version Control in Design Center

In this chapter

• Version Control overview

• Creating VCS connections

• Connecting to the VCS

• Adding new files to the VCS

• Checking in files

• Checking out files

• Creating a release
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Version Control overview
You can connect Design Center to a Version Control System (VCS). This enables 
you to check in/out Design Center files directly from the Design Center GUI. 
Currently Design Center only supports connection to CVS. If you are using 
another VCS (StarTeam, ClearCase, etc.), you must use external tools to check in/
out the Design Center files.

To be able to use version control for Design Center files, you must know how to 
set up your VCS environment. This is not described in this section, this section 
only describes the following tasks:

• Creating VCS connections

• Connecting to the VCS

• Adding new files to the VCS

• Checking in files

• Checking out files

VCS status indicators
Each Project node has a number of indicators. The indicators show the status of 
the Design Center file in the VCS compared to the status of the file in your Project 
directory. A tick attached to a node indicates that the file is under version control, 
i.e. the file is added to the VCS. If there is no tick, you must add the file to the 
VCS in order to have it under version control. 

Figure 71 VCS status indicators

The VCS status of a file can be as follows:

• Current – The status of the file in the VCS is the same as the status of the 
file in your Project directory. This means the file has not been modified 
since the last time it was checked in.

• Modified – You have modified and saved the file in your Project directory, 
but you have not checked in the new version. This means you must check in 
the file.

• Out Of Date – Another user has modified and checked in the file. This 
means you must check out the file in order to get the latest version.
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• Merge – Both you and another user have modified the file, and the other 
user has checked in the file before you. This means you have two options:

– Use Force check-in to check in your version of the modified file.

– Use Force check-out to check out the other user’s version of the 
modified file. In this case, your modifications to the file are 
overwritten.

• Missing – The file is saved in the VCS, but there is no copy of the file in 
your Project directory. You can check out the file in order to get the latest 
version.

• Not in view – The file exists in your Project directory but is not in the VCS. 
You must add the file to the VCS if you want to have it under version 
control.

• Unknown – The status of the file is unknown. In this case, you should 
contact your VCS administrator. If you know which version of the file you 
want, you can:

– Use Force check-in to check in your version of the modified file. This 
overwrites the version of the file in the VCS.

– Use Force check-out to check out the version of the file from the VCS. 
In this case, your modifications to the file are overwritten.
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Creating VCS connections
You can create several VCS connections in Design Center. For example, you can 
create one VCS connection for each Project. If you have large Projects, you can 
divide the Project into logical units, and create one VCS connection per logical 
unit.

For each VCS connection, you must specify the local path to the Design Center 
files you are working with. For example, the path to the Project directory, or the 
path to a logical unit of the Project directory. You must also specify into which 
CVS repository module to check in the Design Center files.

To create a VCS connection

1 Select File > Version Control > Manage Connections. The Manage 
Connections dialog box opens.

2 Click Add. The Select connection type dialog box opens.

3 Select the type of VCS system you want to create the connection to and 
click OK. The Connection name dialog box opens.

4 Enter a name for the connection and click OK. The Add connection dialog 
box opens.

5 Specify the settings for the connection and click OK.
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Connecting to the VCS
Design Center can have several VCS connections, for example one VCS 
connection per Project (see Creating VCS connections on page 178). When you 
open your Project, you must specify which VCS connection to use.

To connect to the VCS

Select File > Version Control > Connect to and the appropriate VCS 
connection.

To disconnect from the VCS

Select File > Version Control > Disconnect.
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Adding new files to the VCS
New Design Center Project nodes are not automatically added to the VCS. You 
must first save the corresponding files locally, and then manually add the files to 
the VCS. You can add files in two ways:

• Add a selected Project node to the VCS. Using this option, you can add the 
selected Project node and related Project nodes that are not already added. 
See Adding the selected Project node to the VCS on page 180.

• Add multiple Project nodes to the VCS. Using this option, you can add all 
new Project nodes to the VCS. See Adding multiple Project nodes to the 
VCS on page 180.

When you have added the Project nodes to the VCS, the corresponding files are 
under version control. You can then check in/out the files to/from the VCS. See 
Checking in files on page 181 and Checking out files on page 182.

Adding the selected Project node to the VCS
1 Right-click the Project node and select Version Control > Add Selected. 

The Add to version control dialog box opens.

2 Select the components to add and click OK.

Reference

Add to version control dialog box on page 296

Adding multiple Project nodes to the VCS
1 Select File > Version Control > Add Multiple. The Add to version control 

dialog box opens.

2 Select the components to add and click OK.

Reference

Add to version control dialog box on page 296
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Checking in files
After you have modified your Design Center files, you can check in the modified 
files to the VCS. You can check in files in two ways:

• Check in a selected Project node to the VCS. Using this option, you can 
check in the selected Project node and related Project nodes. See Checking 
in the selected Project node to the VCS on page 181.

• Check in multiple Project nodes to the VCS. Using this option, you can 
check in multiple Project nodes. See Checking in multiple Project nodes to 
the VCS on page 181.

Checking in the selected Project node to the VCS
1 Right-click the Project node and select Version Control > Check In 

Selected. The Check in dialog box opens.

2 Select the components to check in and click OK.

Reference

Check in dialog box on page 297

Checking in multiple Project nodes to the VCS
1 Select File > Version Control > Check In Multiple. The Check in dialog 

box opens.

2 Select the components to check in and click OK.

Reference

Check in dialog box on page 297
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Checking out files
You can check out files in two ways:

• Check out a selected Project node. See Checking out a selected Project node 
on page 182.

• Check out multiple Project nodes. Using this option, you can select all files 
below a selected folder, or specific files below a selected folder. See:

– Checking out multiple Project nodes from a folder on page 182

– Checking out multiple Project nodes from a folder and sub folders on 
page 183

– Checking out all Project nodes from a selected folder on page 183

– Checking out all the files from a selected folder and sub folders on 
page 183

If you check out the Project root node (*.dcproject), all other Project nodes in 
the Project are checked out as well.

Checking out a selected Project node
1 Right-click the Project node and select Version Control > Check Out 

Selected. The Check out dialog box opens.

2 Specify the settings and click OK.

Reference

Check out dialog box on page 298

Checking out multiple Project nodes from a folder
1 Select File > Version Control > Check Out Multiple. The Check out 

multiple files or folders dialog box opens.

2 Select the folder that contains the Project nodes you want to check out.

3 Select the Project nodes you want to check out (use SHIFT SELECT or 
CONTROL SELECT to select multiple nodes).

4 Specify the Check-out method and click OK.

Reference

Check out multiple files or folders dialog box on page 299
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Checking out multiple Project nodes from a folder and 
sub folders

1 Select File > Version Control > Check Out Multiple. The Check out 
multiple files or folders dialog box opens.

2 Select the folder that contains the Project nodes you want to check out.

3 Select Show all descendants.

4 Select the Project nodes you want to check out (use SHIFT SELECT or 
CONTROL SELECT to select multiple nodes).

5 Specify the Check-out method and click OK.

Reference

Check out multiple files or folders dialog box on page 299

Checking out all Project nodes from a selected folder
1 Select File > Version Control > Check Out Multiple. The Check out 

multiple files or folders dialog box opens.

2 Select the folder that contains the Project nodes you want to check out.

3 Specify the Check-out method and click OK.

Reference

Check out multiple files or folders dialog box on page 299

Checking out all the files from a selected folder and sub 
folders

1 Select File > Version Control > Check Out Multiple. The Check out 
multiple files or folders dialog box opens.

2 Select the folder that contains the Project nodes you want to check out.

3 Specify the Check-out method. 

4 Select Recursive check-out and click OK.

Reference

Check out multiple files or folders dialog box on page 299
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Creating a release
When you create a release, the Project is exported, all Project files are checked in, 
and the export file is added to CVS in the same folder as the Project.

The export generates a file (*.export) that contains all the Platform layers in the 
Project. When you deploy the Project in Control Center, you must connect to the 
VCS, and specify which physical layer to deploy.

To create a release

1 Select File > Version Control > Create Release. The Create Release 
dialog box opens.

2 Enter the appropriate comment and label and click OK.
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Menus, menu commands, and 
dialog boxes in Design Center

In this chapter

• Main window reference on page 186

• Project menu commands and dialog boxes on page 196

• Platform menu commands and dialog boxes on page 212

• Message menu commands and dialog boxes on page 249

• Runtime configuration menu commands and dialog boxes on page 254

• Resource set menu commands and dialog boxes on page 284

• Version Control menu commands and dialog boxes on page 292
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Main window reference
In this section

• File menu commands on page 186

• Edit menu commands on page 188

• View menu commands on page 190

• Tools menu commands on page 190

• Customize dialog box on page 191

• Design Center Settings dialog box on page 193

File menu commands
The File menu includes the commands described in the table below.

Command Description

New > Project Create a new Project. A Project node (root node) is 
added to the Project browser.

New > Platform Create a new Platform. A new Platform node and 
physical layer node is added to the Project browser. 
The Platform node is added below the Project node, or 
in a folder if a folder is selected in the Project browser. 
The physical layer node is added as a sub node to the 
Platform node.

New > Message Create a new Message configuration. A new Message 
node is added to the Project browser. The Message 
node is added below the Project node, or in a folder if 
a folder is selected in the Project browser.

New > Runtime Create a new Runtime configuration. A new Runtime 
configuration node and one or more physical layer 
nodes are added to the Project browser. The Runtime 
configuration node is added below the Project node, or 
in a folder if a folder is selected in the Project browser. 
The physical layer nodes are added as sub nodes to the 
Runtime configuration node.

New > Resource Set Create a new resource set. A new resource set node is 
added to the Project browser. The resource set node is 
added below the Project node, or in a folder if a folder 
is selected in the Project browser.

New > Create Project 
from Template

Create a new Project using a template. This command 
opens the Create Project from Template dialog box 
where you select which template to use.
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Open Open and activate a Design Center file (Platform, 
Message configuration, Runtime configuration, or 
resource set) in the Main window. Used to open a file 
that is not included in the Project. This command 
launches a file browser where you browse to and select 
the file. 

Close Close the active view.

Save Save the changes made in the active view.

Save All Save the Project. This command also saves changes 
made in open views that are not part of the Project.

Save As Save the changes made in the active view, and specify 
a new filename/path for the corresponding Design 
Center file.

Open Project Open an existing Project. This command launches a 
file browser where you browse to and select the Project 
file.

Save Project Save the Project. This command does not save changes 
made in open views that are not part of the Project.

Close Project Close the Project. If there are modified and unsaved 
Project components, a dialog box opens where you can 
specify what to save.

Version Control See Version Control menu commands and dialog boxes 
on page 292.

Obtain Write Lock Lock the selected component. If you lock a component, 
only you can edit the component. Applicable only if 
Design Center is connected to a Version Control 
System (CVS in this release).

Release Write Lock Unlock the selected component. If you unlock a 
component, you can view the settings in the 
corresponding view, but you cannot edit the 
component. Applicable only if Design Center is 
connected to a Version Control System (CVS in this 
release).

Reload Component Revert to the latest saved version of the selected 
component.

Command Description
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Edit menu commands
The Edit menu includes the commands described in the table below.

Add to Project Link an existing Project component (Platform, 
Message configuration, Runtime configuration, or 
resource set) to the Project. This command launches a 
file browser where you browse to and select the Project 
file you want to link to the Project. The Project 
component node is added below the Project node, or in 
a folder if a folder is selected in the Project browser.

Remove from Project Remove the selected node and all its children from the 
Project. The corresponding Design Center files are not 
deleted.

Pack Project Pack the Project. This command opens the Project 
Package information dialog box where you also can 
select to save the Project as a template.

Unpack Project Unpack a Project package. This command opens the 
Unpack Project dialog box where you specify how to 
unpack the Design Center files.

Exit Exit Design Center. If there are modified and unsaved 
components, a dialog box opens where you can specify 
what to save.

Command Description

Command Description

Cut Applicable to the Note pad in the Property window. 
Cuts the selected text segment, and adds it to the 
clipboard.

Copy Copy the selected item (connector, text segment, 
Event, etc.).

Paste Paste the copied item to the active area.

Delete Delete the selected item.

Copy Connector 
Settings

Copy the connector settings in the selected output 
connector. All generic settings (except for notes) will 
be copied.

Paste Connector 
Settings

Paste the connector settings (see Copy Connector 
Settings above) to the selected output connector.

Rename Rename the selected item.
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Enabled Applicable to the following items in the Runtime 
configuration view:

• Message configurations

• Processes

• Output connectors

Used to enable/disable the selected item.

Find Open the Find dialog box, where you specify 
components to search for. The search result is 
displayed in the Search results window.

Script Edit scripts for the selected item. This command opens 
the script editor where you can add, edit, and remove 
scripts. Applicable to the following items in the 
Message and Runtime configuration views:

• Event

• Message

• Process

• Runtime job

Go To Source Activate the source of the connector, Event, Process, or 
Process Link selected in the Runtime configuration 
view:

• Opens the Platform view with the selected 
connector highlighted.

• Opens the Message view with the selected Event 
or Process highlighted.

Add Resource Set Connect resource sets to the active view. Opens the 
Select Resource Sets dialog box, where you select 
resource sets to connect.

Remove Resource 
set

Disconnect resource sets from the active view. Opens 
the Remove Resource Sets dialog box, where you 
select which resource sets to disconnect.

Project Export 
Settings

Open the Project Export Settings dialog box, where 
you can configure input analyzer and notifications 
settings.

Settings Open the Settings dialog box for the component 
selected in the active view. For example, if you select 
an input connector in the Platform view, and select this 
command, the Input Connector Settings dialog box 
opens.

Command Description
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View menu commands
The View menu includes the commands described in the table below.

Tools menu commands
The Tools menu includes the commands described in the table below.

Custom Settings Open the Edit Custom Fields dialog box, where you 
can add custom commands and keywords to Platform 
and Runtime configuration component.

File Properties Open the Properties dialog box. The Properties dialog 
box shows the path to the Design Center file of the 
selected Project browser node. It also displays VCS 
information about the same file.

Command Description

Command Description

Project Browser Open/hide the Project browser.

Property Window Open/hide the Property window.

Search Results Open/hide the Search results window.

Font Dependencies Open the Font Dependencies dialog box. This dialog 
box shows all fonts used in the PageOUT and 
StoryTeller Processes.

Status Bar Show/hide the status bar.

Window Tabs Show/hide the window tabs below the Main window.

Refresh view Refresh the active view.

Refresh all views Refresh all views.

Command Description

Customize Open the Customize dialog box, where you can view 
and customize the Design Center toolbars.

Design Center 
Settings

Open the Design Center Settings dialog box, where 
you can specify default Design Center tool settings.

Select Note Font Specify which font to use for the notes.

Select Note 
Alignment

Specify text alignment of the notes (Left, Center, or 
Right).
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Customize dialog box
In the Customize dialog box, you can customize the Design Center toolbars.

Figure 72 The Customize dialog box.

Select Adobe 
LiveCycle Repository 
connection

Opens the Select active Adobe LiveCycle Repository 
Connection dialog box, where you can manage 
connections to the LiveCycle ES2 Repository.

Export Export the Project to disk. This command opens the 
Export dialog box where you specify the export 
settings.

If Design Center is connected to a VCS, you must use 
the Version Control > Create Release command 
instead.

Autocreate Message Autocreate a Message configuration based on an SXD 
file (Event) and a PLT file (Process). This command 
opens the Autocreate Message dialog box, where you 
specify the SXD file and PLT file.

Edit Project Template 
Information

Edit the category and description of a template. This 
command opens the Project Package information 
dialog box, where you edit the category and 
description.

Update Composition 
Center template 
versions

Opens the Set Composition Center template version 
dialog box, where you can update Composition Center 
template version numbers.

Command Description
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Toolbars tab

On this tab you enable/disable toolbars and tooltips, and modify the appearance 
of the toolbars. The settings are described in the table below.

Command tab

On this tab you can see descriptions of all Design Center toolbar buttons. You can 
also drag buttons and menus to any toolbar displayed in Design Center. The 
settings are described in the table below.

Setting Description

Toolbars Displays all available toolbars. Use the check boxes to 
specify which toolbars to display in Design Center.

Show Tooltips Select to enable tooltips for the toolbar buttons.

Flat look Select to flatten the toolbars.

Large buttons Select to display large size toolbar buttons.

New Add a new custom toolbar.

Reset Reset selected (native) toolbar to include its default 
toolbar buttons. Can be used if you have added new 
buttons to the toolbar.

Delete Delete selected (custom) toolbar.

Setting Description

Categories Displays all available toolbar and menu categories.

Buttons Displays the buttons in the selected category. You can 
drag buttons from this panel to any native or custom 
toolbar.

Description Shows the description of the selected button.
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Design Center Settings dialog box
In the Design Center Settings dialog box you can specify the default Design 
Center application settings.

Figure 73 The Design Center Settings dialog box.

The settings are described in the table below.

Setting Description

Remember these settings 
when closing Design Center

Select to open the Design Center views and windows as they 
were the last time Design Center was closed.

Default code page The default code page specified here is the default code page 
in all code page drop-down lists in Design Center.

Enable wizard window at 
startup

Select to display the wizard window when you launch Design 
Center. The wizard window contains the options Recent 
Projects, Open Project, Create new Project, etc.

Highlight Runtime links for 
selected items

Select to highlight all links to components selected in a 
Runtime configuration view.

Reconnect version control 
session on startup

Select to reconnect to the Version Control System when you 
launch Design Center. If a VCS connection was active the last 
time you exited Design Center, the same VCS connection is 
activated when you launch Design Center.
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Track active item in project 
tree

Select to highlight the active node in the Project browser. For 
example, if a Message view is active in the Main window, the 
corresponding Message node in the Project browser is 
highlighted.

Enable autosave Select to enable autosave of the Design Center Project files.

Autosave interval Specify how frequently to autosave the Design Center Project 
files.

Inherit resource sets Specify whether to inherit resource sets. For example, you 
have the resource set “B” connected to the Message 
configuration “Invoice”. When you add the Message 
configuration “Invoice” to a Runtime configuration, you 
must decide whether the Runtime configuration should 
inherit the resource set “B”.

• Ask Before – You are prompted each time.

• Always – Resource sets are inherited automatically.

• Never – Resource sets are not inherited.

Try to obtain write lock when 
opening views

Specify whether Design Center should try to lock a Project 
file when opening the corresponding view.

• Ask Before – You are prompted each time.

• Always – Design Center tries to lock the file 
automatically. Recommended if Design Center is not 
connected to a Version Control System (CVS in this 
release).

• Never – Design Center does not try to lock the file. 
Recommended if Design Center is connected to a 
Version Control System.

Always obtain write lock for all 
components when opening 
them

Specify whether Design Center should lock all components in 
a view when opening the view.

• Ask Before – You are prompted each time.

• Always – Design Center locks the components 
automatically. Recommended if Design Center is not 
connected to a Version Control System (CVS in this 
release).

• Never – Design Center does not lock the components. 
Recommended if Design Center is connected to a 
Version Control System.

Project Templates location The path to the Design Center Project templates.

Setting Description
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Choose help type Select whether to Use web help or Use local help. The 
default option is to use web help, but if you are unable to 
connect to the web, you can select to use local help instead.

To use local help, you must download the help package from 
StreamShare (http://streamshare.streamserve.com) and 
unzip it to:

<StreamServe>\Applications\StreamSever\<version>\
Common\OnlineHelp

Setting Description
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Project menu commands and dialog boxes
In this section

• Project browser shortcut menu commands on page 196

• Project Settings dialog box on page 199

• Project Package information dialog box on page 199

• Unpack Project dialog box on page 200

• Create Project from Template dialog box on page 202

• Project Export Settings dialog box on page 203

• Font Dependencies dialog box on page 206

• Edit Custom Fields dialog box on page 207

• Export dialog box on page 208

• Set Composition Center template version dialog box on page 211

Project browser shortcut menu commands
The Project browser shortcut menu (right-click the Project browser) includes the 
commands described in the table below.

Command Description

New > Folder Create a new folder. The new folder is added to the 
Project browser below the Project node, or in a folder 
if a folder is selected in the Project browser.

New > Platform Create a new Platform. A new Platform node and 
physical layer node is added to the Project browser. 
The Platform node is added below the Project node, or 
in a folder if a folder is selected in the Project browser. 
The physical layer node is added as a sub node to the 
Platform node.

New > Message Create a new Message configuration. A new Message 
node is added to the Project browser. The Message 
node is added below the Project node, or in a folder if 
a folder is selected in the Project browser.

New > Runtime Create a new Runtime configuration. A new Runtime 
configuration node and one or more physical layer 
nodes are added to the Project browser. The Runtime 
configuration node is added below the Project node, or 
in a folder if a folder is selected in the Project browser. 
The physical layer nodes are added as sub nodes to the 
Runtime configuration node.
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New > Resource Set Create a new resource set. A new resource set node is 
added to the Project browser. The resource set node is 
added below the Project node, or in a folder if a folder 
is selected in the Project browser.

Open Project Open an existing Project. This command launches a 
file browser where you browse to and select the Project 
file.

Save Project Save the Project. This command does not save changes 
made in open views that are not part of the Project.

Save As Save the Project, and specify a new filename/path for 
the corresponding Project file.

Close Project Close the Project. If there are modified and unsaved 
Project components, a dialog box opens where you can 
specify what to save.

Version Control See Version Control menu commands and dialog boxes 
on page 292.

Pack Project Pack the Project. This command opens the Project 
Package information dialog box where you also can 
select to save the Project as a template.

Unpack Project Unpack a Project package. This command opens the 
Unpack Project dialog box where you specify how to 
unpack the Design Center files.

Obtain Write Lock Lock the selected component. If you lock a component, 
only you can edit the component. Applicable only if 
Design Center is connected to a Version Control 
System (CVS in this release).

Release Write Lock Unlock the selected component. If you unlock a 
component, you can view the settings in the 
corresponding view, but you cannot edit the 
component. Applicable only if Design Center is 
connected to a Version Control System (CVS in this 
release).

Reload Component Revert to the latest saved version of the selected 
component.

Command Description
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Add to Project Link an existing Project component (Platform, 
Message configuration, Runtime configuration, or 
resource set) to the Project. This command launches a 
file browser where you browse to and select the Project 
file you want to link to the Project. The Project 
component node is added below the Project node, or in 
a folder if a folder is selected in the Project browser.

Export Export the Project to disk. This command opens the 
Export dialog box where you specify the export 
settings.

If Design Center is connected to a VCS, you must use 
the Version Control > Create Release command 
instead.

Project Export 
Settings

Open the Project Export Settings dialog box, where 
you can configure input analyzer and notifications 
settings.

Rename Rename the selected item.

Settings Open the Project Settings dialog box, where you 
configure the overall Project settings.

File Properties Open the Properties dialog box. The Properties dialog 
box shows the path to the Design Center file of the 
selected Project browser node. It also displays VCS 
information about the same file.

Open/Activate view Activate the view of the selected Project node.

Remove from Project Remove the selected node and all its children from the 
Project. The corresponding Design Center files are not 
deleted.

Delete Physical Item Delete the selected physical layer. Applicable to 
physical Platform and Runtime configuration layer 
nodes. Note that this will delete both the physical 
Platform and Runtime configuration layers. 

Command Description
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Project Settings dialog box
In the Project Settings dialog box, you can configure the overall Project settings.

Figure 74 The Project Settings dialog box.

The settings are described in the table below.

Project Package information dialog box
In the Project Package information dialog box you specify whether to save a 
package as a Project package or as a Project template. You also specify/edit the 
category and description of templates in this dialog box.

Figure 75 The Project Package information dialog box.

Setting Description

Project name The name of the Project. 

Default code page The default code page in all code page drop-down lists in 
the Project.

Default Resource 
set

The default resource set of the Project. This resource set 
is automatically connected to all Platforms, Message 
configurations, and Runtime configurations you create 
from within the Project.

Project folder/
directory

The path to the Project file storage.
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The settings are described in the table below.

Unpack Project dialog box
In the Unpack Project dialog box, you specify how to unpack a Project Package. 
There are two modes to unpack a Project:

• Simple mode – use this mode if you want to create the same Project file/
folder structure as in the original Project.

• Advanced mode – use this mode if you want to modify the Project file/
folder structure used in the original Project.

Simple mode

Figure 76 The Unpack Project dialog box – Simple mode.

The settings are described in the table below.

Setting Description

Category The category label of a template. When you create a new 
Project using this template, you will find the template 
under the category you specify here.

Description A description of a template. When you create a new 
Project using this template, you see this description when 
you select the template.

Save as Project 
Package

Save the Project as a Project package.

Save as Project 
Template

Save the Project as a Project template.

Setting Description

Unpack to The path defining where to unpack the Project. The 
Project folder of the unpacked Project will be located 
here.
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Advanced mode

Figure 77 The Unpack Project dialog box – Advanced mode.

The settings are described in the table below.

Keep folder 
structure

Select to store the unpacked files in the same file and 
subfolder structure as in the original Project.

If you do not select this option, all unpacked files are 
stored directly under the Project folder

Overwrite existing 
files

Select to overwrite existing files.

Open Project after 
unpacking

Select to open the Project in Design Center after 
unpacking.

Setting Description

Unpack to The path defining where to unpack the Project. The 
Project folder of the unpacked Project will be located 
here.

By default, the sub folder structure is inherited from the 
original Project as displayed in the Location column in 
the Components in package list below. Use Target 
location for selected components below to specify 
alternate locations for selected files.

Overwrite existing 
files

Select to overwrite existing files.

Open Project after 
unpacking

Select to open the Project in Design Center after 
unpacking.

Setting Description
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Create Project from Template dialog box
In the Create Project from Template dialog box, you select which template to use 
when creating a new Project.

Figure 78 The Create Project from Template dialog box.

The settings are described in the table below.

Components in 
Package

List displaying all files in the package.

• Name – The name of the component. For example, 
msgInvoice.

• File name – The name of the corresponding Project 
file. For example, msgInvoice.dcmessage.

• Type – The type of component. For example, 
Message.

• Original location – The location of the original 
Project file. For example:

file://C:\Projects\ABC_COM\Invoice

• Location – The path where to store the unpacked 
file. For example:

file://H:\ABC_COM\Invoice

Target location for 
selected 
components

Select one or more files (Ctrl + SELECT or SHIFT + 
SELECT) in the Components in package list, and specify 
where to store the unpacked files.

Setting Description

Setting Description

Open the Project template information dialog box, where 
you can edit the name, category, and description of the 
selected template.
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Project Export Settings dialog box
In the Project Export Settings dialog box, you specify Project specific export 
settings.

Figure 79 The Project Export Settings dialog box.

Normally, the Project contains one Platform only. If there are Several Platforms 
in the Project, you select the Platform by clicking the appropriate Platform icon. 
Then you specify the settings for the selected Platform. The settings are described 
in the table below.

Delete the selected template.

Category The Project template category. Each category can contain 
several templates.

Available templates All available templates of the selected category. Here you 
select which template to use.

Description of 
selected template

A description of the selected template.

Go online to get 
more templates 
from StreamServe

A link to StreamServe’s template download site.

Setting Description

Setting Description

Activated Runtimes 
for selected 
Platform

Select the Runtime configurations to include in the 
export. All Runtime configurations built on the selected 
Platform are included in this list.

InputAnalyzer tab On this tab, you configure Input Analyzer settings for the 
selected Platform.
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InputAnalyzer tab
On this tab, you configure Input Analyzer settings for the selected Platform. See 
Configuring the Input Analyzer on page 69 for more information.

Figure 80 The InputAnalyzer tab.

The settings are described in the table below.

Notifications tab On this tab, you specify for which connectors, Events, 
Processes, Jobs, etc. to generate notifications.

Edit current 
Platform 
arguments

Shortcut to the Configure Platform Export dialog box 
where you specify the startup arguments to include in the 
export. You specify the startup arguments per physical 
layer of the selected Platform.

Setting Description

Setting Description

Available 
connectors

This list displays all available input connectors in the 
selected Platform. This is where you select the input 
connector for which to configure the Input Analyzer 
settings.

Input Analyzer 
configuration

This list includes one row for each input type handled by 
the selected input connector.

Input Type – This column displays the input types.

Filter Chain – This column displays, per input type, the 
filter chains connected to the input connector. 

Handle XML-based 
input before 
StreamIN

Specifies which input type category to have first in the 
list.

For Connectivity Packs. See the corresponding 
documentation.
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Notifications tab
On this tab, you specify for which connectors, Events, Processes, Jobs, etc. to 
generate notifications. See Managing notifications on page 71 for more 
information.

Figure 81 The Notifications tab.

The settings are described in the table below.

Display the names of all Events, of the selected input 
type, connected to the input connector.

Add a filter chain to the selected input type. See Applying 
filter chains per input type on page 154 for more 
information.

Move an input type down within a category.

Move an input type up within a category.

Remove the selected filter chain.

Setting Description

Setting Description

Generate 
notifications for 
these objects

Select to generate notifications.

Note: Notifications must be enabled for the selected 
Platform. See Configure Platform dialog box – 
Generic layer mode on page 215.
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Font Dependencies dialog box
In the Font Dependencies dialog box, you can see all fonts used in the Project. 
This applies to overlays, and to PageOUT and StoryTeller Processes.

Figure 82 The Font Dependencies dialog box.

All used fonts are displayed in a list. You can click the column labels to set the 
sort criterion. The settings are described in the table below.

Object list This list displays all objects for which the StreamServer 
can generate notifications. The check-boxes are used to 
enable/disable notifications for each object. By default, 
all check-boxes are checked.

Select All Select to check all check-boxes.

Clear All Select to uncheck all check-boxes.

Setting Description

Setting Description

Font The name of the font.

Dependencies The Process or overlay where the font is used.

Type PageOUT, StoryTeller, or Overlay.

Go to selected item • Activate the Message configuration that contains 
the Process where the font is used. The Process is 
highlighted in the Message view.

• Activate the resource set that includes the overlay. 
The overlay resource is highlighted in the resource 
set view.
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Edit Custom Fields dialog box
In the Edit Custom Fields dialog box, you You can add custom commands and 
keywords in order to use StreamServer functionality that cannot be configured via 
the standard Design Center GUI properties. See Using custom commands and 
keywords on page 72 for more information.

Figure 83 The Edit Custom Fields dialog box.

The settings are described in the table below.

Setting Description

Access point This is a browser that contains all configurable objects 
(connector, Message, etc.). Each object is divided into 
one node for the generic (Logical in the GUI) layer, and 
one node for each physical layer (Development, Test, 
etc.). You can browse through the folders and nodes in 
this browser the same way as you do in a file browser.

Custom This is where you enter the custom commands for the 
selected Access point browser node.
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Export dialog box
In this dialog box, you specify the export settings when exporting the Project to 
disk. To export the Project to a VCS you must use the File > Version Control > 
Create Release command.

Figure 84 The Export dialog box.

The settings are described in the table below.

Setting Description

Platform to export Normally, the Project contains one Platform only. If there 
are Several Platforms in the Project, you use this drop-
down list to select the Platform to export.

Physical layers to 
export

This list displays all physical layers in the selected 
Platform. The check-boxes are used to specify which 
layers to include in the export. 

By default, all physical layers will be included in the 
export. You can uncheck one or more physical layers to 
exclude them from the current export.

Save these settings Select this option if you want to save the modifications 
done in Physical layers to export. If you do not select 
this option, all physical layers will be selected the next 
time you open the Export dialog box.
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Scripts dialog box
In this dialog box, you can specify scripts (bat, pearl or similar) to be executed 
before and after the Project is exported.

Figure 85 The Scripts dialog box.

Specify export 
directory

The path to the export directory. The export file will be 
stored in this directory.

The Project will be 
exported to

The absolute path to the export directory is displayed 
here.

Add exported fonts 
to Platform’s 
default resource 
set

Select to add all used fonts to a resource set connected to 
the Platform. This ensures that all fonts are available if 
you move the Project to a new machine.

Scripts Opens the Scripts dialog box where you can specify 
scripts to be executed before or after the Project is 
exported.

Configuration 
conflicts

If there are any conflicts in the export configuration, this 
will be displayed here.

Setting Description
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The settings are described in the table below.

Variables set by Design Center

The following variables are set by Design Center, and can be used in the pre-
export and post-export scripts:

Use the following syntax to pass one or more variables to the script:

"<script_path> var1[ var2][ var3][ var4]"

Setting Description

Specify pre-export 
script

A script to execute before the export.

Usage examples

• Backup the previous export files before exporting 
the Project.

• Backup the deployed Project before exporting the 
Project.

Stop export if there is 
an error

Select if you want to stop the export if there are errors 
in the pre-export script.

Specify post-export 
script

A script to execute after the export. 

Usage examples

• Copy the export files to a remote machine.

• Check in the Project files to a VCS.

• Deploy the export file to a StreamServer 
application, and restart the StreamServer 
application. The script executes the command line 
Control Center tools for this purpose.

Display script results Select whether to display script results:

• Always

• Only if an error occurs

• Never

$(ExportPackage) The full path to the export file (*.export) created by 
the export.

$(ChecksumFile) The full path to the checksum file (*.sfv) created by 
the export.

$(ProjectName) The name of the Project.

$(ProjectPath) The path to the Project folder.
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Example 8 Passing $(ExportPackage) and $(ChecksumFile) to script.

"C:\scripts\copy.bat $(ExportPackage) $(ChecksumFile)"

Set Composition Center template version dialog box
In the Set Composition Center template version dialog box, you can update the 
versions of StoryTeller Processes that are used as templates in Composition 
Center.

Figure 86 The Set Composition Center template version dialog box.

Setting Description

Update all 
Composition 
Center template 
versions from file

Select to update all templates using version information 
generated after import to web content repository.

Version 
information file

Click Browse to select the template version information 
file located in:

<StreamServe 
Installation>\Applications\Management\
<version>\bin\Import

Set all Composition 
Center template 
versions to 1

Select to set all templates to version 1.
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Platform menu commands and dialog boxes
In this section

• Platform menu commands on page 212

• Platform view shortcut menu commands on page 213

• Configure Platform dialog box – Generic layer mode on page 215

• Configure Platform dialog box – Physical layer mode on page 216

• Manage Queues dialog box on page 224

• Manage Physical Layers dialog box on page 229

• Configure Platform Export dialog box on page 230

• Input Connector Settings dialog box – Generic layer mode on page 231

• Input Connector Settings dialog box – Physical layer mode on page 236

• Output Connector Settings dialog box – Generic layer mode on page 239

• Output Connector Settings dialog box – Physical layer mode on page 246

Platform menu commands
The Platform menu is available when the Platform view is activated. It includes 
the commands described in the table below.

Command Description

New Input 
Connector

Add a new input connector to the Platform.

New Output 
Connector

Add a new output connector to the Platform. You must 
select a category when you add a connector. Later, when 
you specify the connector type in the physical layers, you 
can select any type that belongs to the category you 
specify here. For example, to be able to select a File 
connector in the physical layers, you must select the 
Generic category when you add the connector to the 
Platform.

Manage Queues Open the Manage Queues dialog box, where you can 
configure settings for available queues, and add new 
queues to the Platform.

Configure Platform Open the Configure Platform dialog box, where you can 
configure Platform specific settings. 

Configure Export Open the Configure Platform Export dialog box, where 
you can specify startup arguments to include in the 
export. You specify this for each physical layer.
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Platform view shortcut menu commands
The Platform view shortcut menu (right-click the Platform view) includes the 
commands described in the table below.

Manage Physical 
Layers

Open the Manage Physical Layers dialog box where you 
can navigate between physical layers, add new layers, 
delete layers, and activate the appropriate layer. You can 
also use the Project browser shortcut menu to manage the 
physical layers.

Convert to 
Document Broker 
Plus

Convert Post-processor repository output connectors to 
Document Broker Plus output connectors.

Select Next Layer Activate the next layer in the Platform layer hierarchy.

Select Previous 
Layer

Activate the previous layer in the Platform layer 
hierarchy.

Command Description

Command Description

New Input 
Connector

Add a new input connector to the Platform.

New Output 
Connector

Add a new output connector to the Platform. You must 
select a category when you add a connector. Later, when 
you specify the connector type in the physical layers, you 
can select any type that belongs to the category you 
specify here. For example, to be able to select a File 
connector in the physical layers, you must select the 
Generic category when you add the connector to the 
Platform.

Configure Platform Open the Configure Platform dialog box, where you can 
configure Platform specific settings. 

Configure Export Open the Configure Platform Export dialog box, where 
you can specify startup arguments to include in the 
export. You specify this for each physical layer.

Manage Queues Open the Manage Queues dialog box, where you can 
configure settings for available queues, and add new 
queues to the Platform.
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Configure Platform dialog box
In the Configure Platform dialog box, you configure Platform specific settings. 
This dialog box has two modes:

• The Configure Platform dialog box – Generic layer mode, where you 
specify Platform settings that apply to all physical layers.

• The Configure Platform dialog box – Physical layer mode, where you 
specify Platform settings for each physical layer.

Manage Physical 
Layers

Open the Manage Physical Layers dialog box where you 
can navigate between physical layers, add new layers, 
delete layers, and activate the appropriate layer. You can 
also use the Project browser shortcut menu to manage the 
physical layers.

Convert to 
Document Broker 
Plus

Convert Post-processor repository output connectors to 
Document Broker Plus output connectors.

Add Resource Set Connect resource sets to the Platform. Opens the Select 
Resource Sets dialog box, where you select resource sets 
to connect.

Remove Resource 
set

Disconnect resource sets from the Platform. Opens the 
Remove Resource Sets dialog box, where you select 
which resource sets to disconnect.

Settings Open the Settings dialog box for the connector selected in 
the Platform view. For example, if you select an input 
connector, and select this command, the Input Connector 
Settings dialog box opens.

Copy Copy the selected connector.

Paste Paste the copied connector to the Platform view.

Delete Delete the selected connector.

Rename Rename the selected connector.

File Properties Open the Properties dialog box. The Properties dialog 
box shows the path to the Project file of the activated 
generic or physical layer. It also displays VCS 
information about the same file.

Command Description
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Configure Platform dialog box – Generic layer mode
This mode is activated in the Configure Platform dialog box when the generic 
Platform layer is activated in the Platform view.

Figure 87 The Configure Platform dialog box – generic layer.

In this mode, you can specify how and when to generate job status reports. See 
the Status Messenger documentation for more information about job status 
reports. 

You can also specify whether the job deletion thread for the runtime repository 
should delete successful/failed jobs in the runtime repository. Note that the 
scheduling of the job deletion thread is configured in repositorymanager.xml. 
The settings in this dialog box only specify a time after which the job deletion 
thread is allowed to delete jobs.

The settings are described in the table below.

Setting Description

Use notifications Select to enable generation of notifications.

Report status Specify when to generate a status report.

When input is received – Generate a status report when 
the input is received. This type of status report only 
guarantees that the StreamServer has received input. 

When output is queued – Generate a status report when 
the StreamServer has processed the input data, and sent 
the output to an output queue.

When delivered from the output queue – Generate a 
status report when the StreamServer has delivered the 
output from the output queue.
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Configure Platform dialog box – Physical layer mode
This mode is activated in the Configure Platform dialog box when a physical 
Platform layer is activated in the Platform view.

Figure 88 The Configure Platform dialog box – physical layer.

In this mode, the dialog box is divided into the following tabs:

• Recording Mode tab

• Log File tab

• Service Broker tab

• File Cache tab

• Statistics tab

Delete successful 
jobs

Specify whether the job deletion thread should delete 
successful jobs stored in the runtime repository.

Allow deletion after Specify the time successful jobs must be kept in the 
runtime repository. The job deletion thread is allowed to 
delete jobs that are older than the time specified.

Time unit Specify time unit for Allow deletion after (successful 
jobs).

Delete failed jobs Specify whether the job deletion thread should delete 
failed jobs stored in the runtime repository.

Allow deletion after Specify the time failed jobs must be kept in the runtime 
repository. The job deletion thread is allowed to delete 
jobs that are older than the time specified.

Time unit Specify time unit for Allow deletion after (failed jobs).

Setting Description
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Recording Mode tab
On this tab, you can activate recording of page formatted input data in order to 
create sample files.

Figure 89 The Recording Mode tab.

The settings are described in the table below.

Log File tab
The StreamServer application to which the Project is deployed can write log 
messages to a log file in the working directory. On this tab, you can specify 
whether to generate a log file, which type of information to include in the log file, 
log file truncation settings, etc.

Setting Description

Activate recording 
mode

Select to run the StreamServer in record only mode.

Lines The number of lines in the input data to record. 

Columns The number of columns in the input data to record. 

Input connector The input connector that receives the data to be recorded.
StreamServe Persuasion SP5 Design Center User Guide Rev B



218 Platform menu commands and dialog boxes
Menus, menu commands, and dialog boxes in Design Center
Figure 90 The Log File tab.

The settings are described in the table below.

Setting Description

Enable logging Select to enable logging.
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Log messages of 
type(s)

Select the type of messages to include in the log file.

Severe error messages

Only include severe error messages in the log. This is the 
recommended option for the production layer due to 
performance.

All error messages 

Include all error messages in the log. This can be used in 
the production layer to get more information.

All error and warning messages 

As the above, plus warning messages. This can also be 
used in the production layer to get even more 
information.

All error, warning and information messages 

As the above, plus information messages. This is the 
recommended option for the development and test layers.

All error, warning and extended information 
messages 

As the above, plus more information messages. This can 
be used in the development and test layers to get more 
information. Note that this option may complicate the 
search for relevant error messages, due to all information 
messages displayed in the log.

Log file name The name of the log file.

Remove log files 
when server starts

The StreamServer application normally appends log 
messages to the same log file after it is restarted. If you 
select Remove log file when server starts, a new log 
file is created each time the StreamServer application is 
restarted. The old log file is deleted, and not stored 
anywhere.

Age restrictions Select if you want to use the same log file for a limited 
number of days. Use Maximum age (days) and Create 
new log file at to specify when to start using a new log 
file. If you want to store the old log file, you must use 
Move old log files to and specify where to store the log 
file.

Maximum age 
(days)

The maximum number of days to write to the same log 
file.

Setting Description
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Service Broker tab
On this tab, you specify which Service Broker to connect to, and the security 
settings for the Service Broker communication..

Figure 91 The Service Broker tab.

The settings are described in the table below.

Create new log file 
at

The time of the day when to start writing to a new log file.

Size restrictions Select if you want to specify a maximum size for the log 
file, and to start writing to a new log file when the limit is 
exceeded. If you want to store the old log file, you must 
use Move old log files to and specify where to store it.

Maximum size (MB) The maximum size (MB) of the log file.

Move old log files 
to

The directory where to save the old log files.

Setting Description

Setting Description

Service Broker 
host

The host where the Service Broker is running.

Service Broker port The port number used by the Service Broker. Must be the 
same as IPport in the Control Center configuration of 
the Service Broker.
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Use SSL for output 
Service Channels

Select to use SSL for communication between Service 
Channel Submit (HTTP) output connectors and the 
Service Broker. This is used when the StreamServer is 
running as an SSL client requesting services from the 
Service Broker. 

Client Security 
Configuration

The security configuration to use when the StreamServer 
is running as an SSL client to the Service Broker. The 
security configuration must be included in a resource set 
connected to the Platform. See About encryption and 
authentication for more information. 

Client SSL version The SSL version to use when the StreamServer is running 
as an SSL client to the Service Broker.

Enable services Select to enable publishing of services in the Service 
Broker.

Port The port to use to publish services, and to receive input 
via the Service Broker.

Threads The maximum number of concurrent connections to the 
services available from the StreamServer. When all 
connections are busy, and a new client tries to connect to 
a service, the connection fails.

Idle time-out (ms) This time-out (milliseconds) is applied when the 
StreamServer has finished processing a request, and no 
more data related to the request is received or sent. It 
specifies the maximum time the connection remains 
open, and enables the client to send a new request without 
having to set up a new connection. 

Connection time-
out (ms)

This time-out (milliseconds) is applied when the 
StreamServer sends or receives data The purpose is to 
close dead connections. If no data is sent or received 
during the time specified, the connection is closed. 

Response time-out 
(ms)

This time-out (milliseconds) is applied when the 
StreamServer has received all data from the client. It 
specifies the maximum time the client is expected to wait 
for a response. Set this time-out to 0 if the client does not 
expect any response.

Use SSL for 
publish/unpublish

Select to use SSL when publishing/unpublishing services 
in the Service Broker. This is used when the 
StreamServer is running as an SSL client, publishing 
services in the Service Broker. 

Setting Description
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File Cache tab
On this tab, you specify how to cache external XML and DTD files. See the 
XMLIN documentation for more information.

Figure 92 The File Cache tab.

The settings are described in the table below.

Server Security 
Configuration

The security configuration to use when publishing/
unpublishing services. The security configuration must 
be included in a resource set connected to the Platform. 
See About encryption and authentication for more 
information. 

Server SSL version The SSL version to use when publishing/unpublishing 
services.

Use SSL for input 
Service Channels

Select to use SSL for communication between Service 
Channel (HTTP) input connectors and the Service 
Broker. This is used when the StreamServer is running as 
an SSL server invoked by the Service Broker. 

Security 
Configuration

The security configuration to use when the StreamServer 
is running as an SSL server. The security configuration 
must be included in a resource set connected to the 
Platform. See About encryption and authentication for 
more information. 

SSL version The SSL version to use when the StreamServer is running 
as an SSL server.

Setting Description

Setting Description

File cache base 
directory

The file cache base directory. You can use an absolute 
path, or a path relative to the working directory of the 
StreamServer. XML and DTD documents are cached in a 
sub directory called XML. 

Enable XML cache Select to enable caching of XML and DTD documents. 

XML cache size The maximum number of documents in the XML cache 
directory. When the limit is exceeded, the oldest 
document is removed. 
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Statistics tab
On this tab, you specify the settings for the usage statistics repository. This 
repository is used by the Communication Reporter. See the Communication 
Reporter documentation for more information.

Figure 93 The Statistics tab.

The settings are described in the table below.

XML cache time-
out

The "best before date" for a cached document. The 
StreamServer checks this date each time it retrieves a 
document from the cache. If the document is older than 
the cache time-out, it will be updated. 

Setting Description

Setting Description

Alias/Path An alias or path that points to the location of the 
repository. The repository is created the first time you run 
the Project. The default path is %(PlatformName)/
defaultRepository. The %(PlatformName) place 
holder is replaced by the name of the physical Platform 
layer. 

Server The host of the repository server.

User name A user name to access the repository server.

Password A password to access the repository server.
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Manage Queues dialog box
In the Manage Queues dialog box, you can configure settings for available 
queues, and add new queues to the Platform.

Figure 94 The Manage Queues dialog box.

The settings are described in the table below.

There are also shortcut menu commands (right-click the queue list) that you can 
use. The shortcut menu commands are described in the table below.

Setting Description

Queue list This list displays all available queues. This is where you 
select the queue you want to configure.

Add Add a new queue to the Platform.

Delete Delete the selected queue. The queue will be deleted from 
all connectors using it.

Queuing tab On this tab, you specify how to handle successful and 
failed jobs.

Advanced tab On this tab, you specify more advanced queue settings.

Command Description

Add Add a new queue to the Platform.

Delete Delete the selected queue. The queue will be deleted from 
all connectors using it.

Rename Rename the selected queue.
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Queuing tab
On this tab, you specify how to store successful and failed jobs. You can also 
specify when and how many times the StreamServer should try to resend a failed 
job from the queue.

Figure 95 The Queuing tab.

The settings are described in the table below.

Set as default input 
queue

Make the selected queue the default input queue. When 
you add a queue to an input connector, and select the 
option (Use default), this queue is selected.

Set as default 
output queue

Make the selected queue the default output queue. When 
you add a queue to an output connector, and select the 
option (Use default), this queue is selected.

Command Description

Setting Description

Store successful 
jobs

Select the type of data to store for successful jobs.

• No – Select to store nothing.

• Store information only – Select to store job 
information.

• Store information and job – Select to store job 
information and the job. This option enables jobs to 
be resent from the queue. Successful jobs remain in 
the queues as long as specified in the Platform 
configuration dialog box (see Configure Platform 
dialog box – Generic layer mode on page 215).
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Store failed jobs Select the type of data to store for failed jobs.

• No – Select to store nothing.

• Store information only – Select to store job 
information.

• Store information and job – Select to store job 
information and the job. This option enables jobs to 
be resent from the queue. Failed jobs remain in the 
queues as long as specified in the Platform 
configuration dialog box (see Configure Platform 
dialog box – Generic layer mode on page 215).

Retries The maximum number of times the StreamServer should 
try to resend a failed job from the queue.

Retry delay (ms) The time (milliseconds) the StreamServer should wait 
before it tries to resend a failed job from the queue.

Queue can be 
shared

Enable sharing of the queue.

If several StreamServer applications in the same 
application domain are used for load balancing and 
failover, they must be able to share queues. You must, in 
each Design Center Project (one Project per 
StreamServer application), enable sharing for all queues 
to be shared.

Note: If you disable sharing for a queue in Project A, 
and enable sharing for the same queue in Project 
B, then StreamServer B can consume 
StreamServer A’s jobs. StreamServer A cannot 
consume StreamServer B’s jobs in this case.

Setting Description
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Advanced tab
On this tab, you specify the number of job threads, when to process queued jobs, 
and schedule spooling of the queue.

Figure 96 The Advanced tab.

The settings are described in the table below.

Setting Description

Threads The maximum number of job threads the queue can use. 
The StreamServer can process several queued jobs in 
parallel. This is an advantage if a large job is followed by 
a small job. With one single thread, the small job must 
wait for the large job to be completed. Note that each 
thread consumes system resources.

Process jobs Specify when to process jobs.

• On arrival – Select to process the jobs as soon as 
possible when they arrive to the queue.

• When parent completed – Select to add the jobs to 
the queue after the parent job is successfully 
processed. For example, output jobs are added to 
the output queue after the parent job (delivered 
from the input queue) is successfully processed.

Schedule spooling Select to schedule spooling of the queue. For example, if 
an output queue contains fax jobs, you can schedule the 
queue to wait until 6 pm before delivering the jobs. By 
default, spooling stops when the queue is empty. 

Spooling interval Open the scheduler, and specify the spooling intervals.
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Spool for a limited 
time

Select to specify a time for when to stop spooling.

• If the queue still contains jobs after the specified 
time, the remaining jobs are handled in the next 
spooling interval. 

• If the queue is emptied before the specified time, 
the queue waits for new jobs to arrive. This means 
the new jobs can be handled in the same spooling 
interval. You can select Stop if the queue is 
empty to override this feature.

Days, Hours, 
Minutes, Seconds

The time when to stop spooling.

Store blobs on disk Select to store blobs as files on disk.

Documents in queued input/output jobs are by default 
stored as blobs (Binary Large Objects) in the runtime 
repository. You can, for each queue, select to store the 
blobs as files on disk instead. The runtime repository will 
in this case include references to the blobs stored on disk.

There are several reasons to store blobs on disk, for 
example to:

• Improve performance.

• Decrease the amount of runtime repository data to 
backup.

• Minimize the risk to reach maximum database and 
tablespace limits.

Note: All jobs must be finished before you change this 
setting and redeploy the Project.

Blob path Path to the folder where to store the files.

To store blobs on a network share, you must use UNC 
(Uniform Naming Convention) when you specify the 
path. You cannot use drive letters.

For example, you can use \\wtvs01\data\queues but 
not H:\data\queues when you specify the path.

Setting Description
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Manage Physical Layers dialog box
In the Manage Physical Layers dialog box, you can navigate between physical 
layers, add new layers, delete layers, and activate the appropriate layer. You can 
also use the Project browser shortcut menu to manage the physical layers.

Figure 97 The Manage Physical Layers dialog box.

The settings are described in the table below.

Setting Description

Available Physical 
Layers

This list displays all physical Platform layers.

Active Physical 
Layer

Displays the currently active physical layer.

Add Select to add a new physical layer to the Platform.

Rename Rename the physical layer selected in the Available 
Physical Layers list.

Set as active Select a physical layer in the Available Physical Layers 
list, and click this button to make the selected layer the 
active layer.

Delete Delete the physical layer selected in the Available 
Physical Layers list. Note that this will delete both the 
physical Platform and Runtime configuration layers.
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Configure Platform Export dialog box
In the Configure Platform Export dialog box, you can specify arguments that are 
read by the StreamServer at server startup, and used when running the Project. 
You specify the arguments per physical layer.

Figure 98 The Configure Platform Export dialog box.

The dialog box has two tabs:

• Arguments, where you specify startup arguments that are exported to the 
standard startup argument file. To change these arguments you must change 
the arguments in Design Center, export and redeploy the Project, and restart 
the StreamServer application.

• Administrator Arguments, where you specify administrator arguments 
that are exported to the file sysadmin.arg in the working directory of the 
StreamServer. To change these arguments, the administrator can edit 
sysadmin.arg and restart the StreamServer.

The settings described below apply to both the Arguments and Administrator 
Arguments.

Setting Description

Selected layer Use this drop-down list to select the physical layer to 
configure.

Name/Value list Used to select which standard arguments to include in the 
argument file. To select an argument you must check the 
corresponding check box. To add a value to an argument, 
you must select the argument, and enter the value in the 
argument field below the Name/Value list. 
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Input Connector Settings dialog box
In the Input Connector Settings dialog box, you configure the settings for the 
selected input connector. This dialog box has two modes:

• The Input Connector Settings dialog box – Generic layer mode, where you 
specify connector settings that apply to all physical layers.

• The Input Connector Settings dialog box – Physical layer mode, where you 
specify connector settings for each physical layer.

Input Connector Settings dialog box – Generic layer 
mode

This mode is activated in the Input Connector Settings dialog box when the 
generic Platform layer is activated in the Platform view.

Figure 99 The Input Connector Settings dialog box – generic layer.

Description Displays a short description of the selected argument. See 
the Startup arguments documentation for detailed 
descriptions of the arguments.

Edit Custom Opens the Custom Arguments dialog box, where you can 
add custom arguments that are not included in the Name/
Value list. Arguments that you add to the Before section 
are added before the standard arguments in the argument 
file. Arguments that you add to the After section are 
added after the standard arguments in the argument file.

Preview Opens a preview of the argument file.

Setting Description
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In this mode, the dialog box is divided into the icons and tabs shown in the table 
below.

Queue tab
On this tab, you specify which queue to add to the connector.

Figure 100 The Queue tab.

The settings are described in the table below.

Filter chain tab
On this tab, you can connect filter chains to the input connector. For example, you 
can apply a decompression filter to decompress input data. You must first add the 
filter to a filter chain, and then add the filter chain to the connector.

Figure 101 The Filter Chain tab.

Icon Tabs

Queue tab – On this tab, you specify which queue to connect to the 
connector.

Filter chain tab – On this tab, you can connect filter chains to the input 
connector.

General tab – On this tab, you can add notes to the connector.

Setting Description

Queue Select which queue to add to the connector.

Manage Queues Open the Manage Queues dialog box, where you can add 
new queues, configure queue settings, etc.
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The settings are described in the table below.

Setting Description

Look in Lists all available resource sets. Browse to, and select, the 
appropriate resource set.

The list below contains the filter chains and folders 
included in the selected resource set. You can double-
click a folder to display all items within. In this list, you 
select the filter chain to add to the connector.

Selected This is the filter chain that will be added to the connector 
when you click OK. You can only select one filter chain.
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Selection buttons

Editor buttons

Resource set buttons

Resource buttons

General tab
On this tab, you can add notes to the connector. You can also specify whether to 
process all documents extracted from the input file (or equivalent) in the same 

Adds the selected filter chain to the Selected field. This means you have 
specified the filter chain to add to the connector.

Removes the filter chain from the Selected field. This means you have 
not specified the filter chain to add to the connector.

Edit the selected filter chain.

Exit the filter chain editor.

Adds an existing resource set to the Platform. This new resource set will 
be available in the Look in list. Note that the resource set is not 
automatically added to the Project.

Creates a new resource set and connect it to the Platform. This new 
resource set will be available in the Look in list. Note that the resource 
set is not automatically added to the Project.

Creates a new empty filter chain and add it to the selected resource set. 
You can now edit the filter chain and add it to the Selected field.

Adds an existing filter chain to the selected resource set. You can now 
add the filter chain to the Selected field.

Not applicable to filter chains.
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input job, or process each extracted document as a separate input job.

Figure 102 The General tab.

The settings are described in the table below.

Setting Description

Note Add notes to the connector. For example, a short 
description of what it is used for. Use Font to specify the 
note font, and the alignment buttons to specify how to 
align the text.

Keep input Job 
structure in output

Specifies whether to process all documents extracted 
from the input file (or equivalent) in the same input job, 
or process each extracted document as a separate input 
job. This affects the usage of variables and Process output 
since all stored variables and Processes are removed 
when an input job is completed. For example, it is only 
possible to use variables and to sort Process output within 
the same input job. 

If selected, the StreamServer processes all extracted 
documents in the same input job. 

If not selected, the StreamServer processes each 
extracted document as a separate input job. This reduces 
the use of memory and disk space when handling large 
jobs, but the Process output and all stored variables are 
removed when the document is completed.
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Input Connector Settings dialog box – Physical layer 
mode

This mode is activated in the Input Connector Settings dialog box when a physical 
Platform layer is activated in the Platform view.

Figure 103 The Input Connector Settings dialog box – physical layer.

In this mode, the dialog box is divided into the icons and tabs shown in the table 
below.

Icon Tabs

• Connector Settings tab – On this tab, you select the type of input 
connector to use, and configure the connector type specific 
settings.

• HTTP Access tab – On this tab, you configure HTTP Access 
settings for the connector.

General tab – On this tab, you can add notes to the connector.
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Connector Settings tab
On this tab, you select the type of input connector to use, for example a Named 
pipe input connector. You also configure the connector type specific settings on 
this tab.

Figure 104 The Connector Settings tab (Named pipe connector in this example).

The settings are described in the table below.

HTTP Access tab
On this tab, you configure HTTP Access settings for the connector.

Figure 105 The HTTP Access tab.

You must configure HTTP Access settings in order to receive input via an HTTP 
or HTTPS input connector. The input received via the HTTP(S) input connector 
can also be passed on to another connector. In this case, you must also configure 
the HTTP Access settings for that connector.

Note: The connector must be connected to a queue.

Example 9 HTTP Access configuration for an HTTP connector and an Internal connector

This example includes one HTTP connector called HTTP_IN and one Internal 
connector called INTERNAL. The connectors have the HTTP Access 
configurations shown below.

Setting Description

Connector type Select the type of input connector to use. See Input 
connectors.

Property/Value list Configure the settings of the selected connector type.

- HTTP Connector URI

HTTP_IN HTTP_IN /
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A request sent to www.abc.com/ is received and handled by HTTP_IN. 

A request sent to www.abc.com/internal is received by HTTP_IN and forwarded 
to INTERNAL. 

The settings are described in the table below.

General Settings tab
On this tab, you can add notes to the connector.

Figure 106 The General Settings tab.

The settings are described in the table below.

INTERNAL HTTP_IN /internal

Setting Description

HTTP Connector All HTTP and HTTPS connectors in the Platform are 
available in this drop-down list. If you are configuring an 
HTTP or HTTPS connector, you must select that 
connector. For example, if you are configuring an HTTP 
connector called HTTP_IN, you must select HTTP_IN from 
the drop-down list. If you are configuring any other type 
of connector, you must select the HTTP or HTTPS 
connector to collect the input from.

URI The URI of the connector you are configuring.

- HTTP Connector URI

Setting Description

Note Add notes to the connector. For example, a short 
description of what it is used for. Use Font to specify the 
note font, and the alignment buttons to specify how to 
align the text.
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Output Connector Settings dialog box
In the Output Connector Settings dialog box, you configure the settings for the 
selected output connector. This dialog box has two modes:

• The Output Connector Settings dialog box – Generic layer mode, where 
you specify connector settings that apply to all physical layers.

• The Output Connector Settings dialog box – Physical layer mode, where 
you specify connector settings for each physical layer.

Output Connector Settings dialog box – Generic layer 
mode

This mode is activated in the Output Connector Settings dialog box when the 
generic Platform layer is activated in the Platform view.

Figure 107 The Output Connector Settings dialog box – generic layer.

In this mode, the dialog box is divided into the icons and tabs shown in the table 
below.

Icon Tabs

Code page Settings tab – On this tab, you can specify which code page 
to apply to the output data.

• Device Driver Settings tab – On this tab, you can specify which 
device driver to add to the output connector.

• Symbol Set tab – On this tab, you can override the symbol set 
specified for the connector. Only applicable when sending output 
to PCL printers.

Filter Chain Settings tab – On this tab, you can connect filter chains to 
the output connector.
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Code page Settings tab
On this tab, you can specify which code page to apply to the output data. See 
About code pages and Unicode support for more information about code pages.

Figure 108 The Code page Settings tab.

The settings are described in the table below.

Queue Settings tab – On this tab, you specify which queue to connect 
to the connector.

Output mode tab – On this tab, you specify the output mode for the 
connector.

General Settings tab – On this tab, you can add notes to the connector. 
You can also specify options for downloading files (soft fonts, 
overlays, etc.) to a printer.

Icon Tabs

Setting Description

Inherit code page Select to inherit the code page specified for the input, and 
use the same code page for both input and output.

Code page name Specify a different code page for the output. This code 
page must at a minimum cover all the characters covered 
in the code page for the input. 

Reorder BiDi 
output in visual 
order

Only for Arabic and Hebrew code pages, and for UCS-2 
and UTF-8. The StreamServer processes bidirectional 
text in logical order. If required, select this option to 
reorder the output to visual order.

Add byte order 
mark

Only for UCS-2 and UTF8. Select to include a byte order 
mark at the beginning of a UCS-2 (UTF-16) or a UTF-8 
encoded output file. The application that receives the 
output can use the byte order mark to automatically 
determine the encoding (UTF-8 or UTF-16 encoding 
scheme) and byte order for the data in the UTF-16 
encoding scheme.
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Device Driver Settings tab
On this tab, you can specify which device driver to add to the output connector.

Figure 109 The Device Driver Settings tab.

The settings are described in the table below.

Byte order Only for UCS-2. For the UTF-16 encoding schemes, each 
character code unit is represented by two bytes. When 
you select UCS-2 as code page, you must also specify the 
byte order. The byte order to select depends on the 
application that receives the output. 

Setting Description

Setting Description

Show all devices Select to show all available device drivers in the Device 
drop-down list.

If you do not select this option, the device Device drop-
down list only includes a selection of device drivers. You 
can configure this list in the Device tool by selecting the 
option Include in device filter for the device drivers to 
include.

Device Select which device driver to add.

Property/Value list Configure the settings of the selected device driver.

Alias Specify aliases for the driver settings. See Dynamic 
selection using aliases on page 143.

Use the following syntax in the lookup table:

Event.Process.Option.key_value   Value

For example:

ev1.pr1."Print Orientation:".DEN     Landscape
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Symbol Set tab
On this tab, you can override the symbol set specified for the connector. Only 
applicable when sending output to PCL printers.

Figure 110 The Symbol Set tab.

When sending output to a PCL printer, there you can override the symbol set in 
the code page specified for the connector, and specify a different symbol set for 
the printer. The settings are described in the table below.

Font substitution 
table

Select a font substitution table if you want to add new 
fonts or override font definitions in the selected device. 
The font substitution table must be added to a resource set 
connected to the Platform.

You can add new font entries to a font substitution table 
instead of editing the actual driver file. The new font 
entries are added to the exported driver file. You can also 
add font entries that override font entries in the driver 
file. The font entry syntax depends on the driver to be 
used. See Managing fonts for more information.

Setting Description

Setting Description

Override symbol 
set in default code 
page

Select to override the symbol set.

Static Select to use a static symbol set.

Lookup Select to use a lookup table to specify which symbol set 
to use. See Dynamic selection using aliases on page 143 
for information on how to use lookup tables.

Variable Select to use a variable to specify which symbol set to 
use. See Dynamic selection using aliases on page 143 for 
information on how to use variables for this purpose.
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Filter Chain Settings tab
On this tab, you can connect filter chains to the input connector. For example, you 
can apply a decompression filter to decompress input data. You must first add the 
filter to a filter chain, and then add the filter chain to the connector.

Figure 111 The Filter Chain Settings tab.

The settings are described in the table below.

Setting Description

Look in Lists all available resource sets. Browse to, and select, the 
appropriate resource set.

The list below contains the filter chains and folders 
included in the selected resource set. You can double-
click a folder to display all items within. In this list, you 
select the filter chain to add to the connector.

Selected This is the filter chain that will be added to the connector 
when you click OK. You can only select one filter chain.
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Selection buttons

Editor buttons

Resource set buttons

Resource buttons

Queue Settings tab
On this tab, you specify which queue to add to the connector.

Figure 112 The Queue Settings tab.

Adds the selected filter chain to the Selected field. This means you have 
specified the filter chain to add to the connector.

Removes the filter chain from the Selected field. This means you have 
not specified the filter chain to add to the connector.

Edit the selected filter chain.

Exit the filter chain editor.

Adds an existing resource set to the Platform. This new resource set will 
be available in the Look in list. Note that the resource set is not 
automatically added to the Project.

Creates a new resource set and connect it to the Platform. This new 
resource set will be available in the Look in list. Note that the resource 
set is not automatically added to the Project.

Creates a new empty filter chain and add it to the selected resource set. 
You can now edit the filter chain and add it to the Selected field.

Adds an existing filter chain to the selected resource set. You can now 
add the filter chain to the Selected field.

Not applicable to filter chains.
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The settings are described in the table below.

Output mode tab
On this tab, you specify the output mode for the connector. See Output modes on 
page 20 for more information about the different output modes.

Figure 113 The Output mode tab.

The settings are described in the table below.

General Settings tab
On this tab, you can add notes to the connector. You can also specify options for 
downloading files (soft fonts, overlays, etc.) to a printer.

Figure 114 The General Settings tab.

Setting Description

Queue Select which queue to add to the connector.

Manage Queues Open the Manage Queues dialog box, where you can add 
new queues, configure queue settings, etc.

Setting Description

Process Select output mode Process. See Output mode Process on 
page 20.

Document Select output mode Document. See Output mode 
Document on page 21.

Job Select output mode Job. See Output mode Job on page 
22.
StreamServe Persuasion SP5 Design Center User Guide Rev B



246 Platform menu commands and dialog boxes
Menus, menu commands, and dialog boxes in Design Center
The settings are described in the table below.

Output Connector Settings dialog box – Physical layer 
mode

This mode is activated in the Output Connector Settings dialog box when a 
physical Platform layer is activated in the Platform view.

Figure 115 The Output Connector Settings dialog box – physical layer.

Setting Description

Download File Select a resource, for example an overlay or soft font, to 
download to a printer.

Enable download Select to download the resource for each output page. If 
you do not select this option, the resource is downloaded 
only for the first page.

Include result in 
service response

Select to include the output data in the web service 
response to the client issuing the web service request.

Only used if the input is received via a Service Request 
input connector.

Note: This output connector must be queue enabled.

Note Add notes to the connector. For example, a short 
description of what it is used for. Use Font to specify the 
note font, and the alignment buttons to specify how to 
align the text.
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In this mode, the dialog box is divided into the icons and tabs shown in the table 
below.

Connector tab
On this tab, you select the type of output connector to use, for example a File 
output connector. You also configure the connector type specific settings on this 
tab.

Figure 116 The Connector tab (File connector in this example).

The settings are described in the table below.

General tab
On this tab, you can add notes to the connector.

Figure 117 The General Settings tab.

Icon Tabs

Connector tab – On this tab, you select the type of output connector to 
use, and configure the connector type specific settings.

General tab – On this tab, you can add notes to the connector.

Setting Description

Connector type Select the type of output connector to use. See Output 
connectors.

Property/Value list Configure the settings of the selected connector type.
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The settings are described in the table below.

Setting Description

Note Add notes to the connector. For example, a short 
description of what it is used for. Use Font to specify the 
note font, and the alignment buttons to specify how to 
align the text.
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Message menu commands and dialog boxes
In this section

• Message menu commands on page 249

• Message view shortcut menu commands on page 249

• Event Settings dialog box on page 250

Message menu commands
The Message menu is available when the Message view is activated. It includes 
the commands described in the table below.

Message view shortcut menu commands
The Message view shortcut menu (right-click the Message view) includes the 
commands described in the table below.

Command Description

Add Event Add a new Event to the Message view.

Add Process Add a new Process to the Message view.

Add Existing 
Process

Add an existing Process to the Message view. This 
command opens a dialog box where you browse to and 
select the Process you want to add.

Set Document Type Only applicable when using StreamStudio Composer and 
Composition Center. This command opens the Select 
document type dialog box, where you select the 
appropriate document type.

Command Description

Add Event Add a new Event to the Message view.

Add Process Add a new Process to the Message view.

Add Resource Set Connect resource sets to the Message view. Opens the 
Select Resource Sets dialog box, where you select 
resource sets to connect.

Remove Resource 
set

Disconnect resource sets from the Message view. Opens 
the Remove Resource Sets dialog box, where you select 
which resource sets to disconnect.
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Event Settings dialog box
In the Event Settings dialog box, you configure overall Event settings.

Figure 118 The Event Settings dialog box.

This dialog box is divided into the following tabs:

• Agent Settings tab – On this tab, you configure settings that apply to 
StreamIN and XMLIN Events.

Set Document Type Only applicable when using StreamStudio Composer and 
Composition Center. This command opens the Select 
document type dialog box, where you select the 
appropriate document type.

Open Open the configuration tool for the selected Event or 
Process.

Close Close the configuration tool for the selected Event or 
Process.

Script Open the Script editor. In the Script editor you can create 
new scripts, edit existing scripts, and specify when to 
trigger the script.

Settings Open the Event Settings dialog box, where you can 
configure settings for the selected Event.

Copy Copy the selected Event or Process.

Paste Paste the Event or Process to the Message view.

Delete Delete the selected Event or Process.

Rename Rename the selected Event or Process.

File Properties Open the Properties dialog box. The Properties dialog 
box shows the path to the Project file of the activated 
Message configuration. It also displays VCS information 
about the same file.

Command Description
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• Event Order tab – On this tab, you specify how to aggregate output from 
several Events in a Message configuration.

Agent Settings tab
On this tab, you configure settings that apply to StreamIN and XMLIN Events.

StreamIN settings

Figure 119 Agent Settings tab for StreamIN Events.

The settings are described in the table below.

XMLIN settings

Figure 120 Agent Settings tab for XMLIN Events.

Setting Description

Input type The input type of the StreamIN Event. Agent is only used 
for connectivity packs. StrsXML and XML are only used for 
3.0.1 and older versions.

Description 
resource

The description file used by the StreamIN configuration. 
This file must be included in a resource set connected to 
the Message configuration.

Description ID The FIELDIN or STREAMIN keyword in the description file 
(case sensitive). 
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The settings are described in the table below.

Event Order tab
On this tab, you specify how to aggregate output from several Events in a 
Message configuration. The output from the Events are appended to the same 
Message structure in the order specified on this tab. The Message structure is then 
passed on to the Process(es) in the Message configuration.

Figure 121 The Event Order tab.

Setting Description

Collect entire 
documents

Select to use the Document collection mode for the 
XMLIN Event. This collection mode collects the whole 
XML document before processing and parsing the data. 
See the XMLIN documentation for more information on 
how the StreamServer reads and processes XML 
documents.

Validation level The validation level of the XMLIN Event. See the 
XMLIN documentation for more information about 
validating XML input.

XSD mapping table The XSD mapping table to use when validating input 
against an XSD. The mapping table contains namespace 
to schema location mappings. This table must be 
included in a resource set connected to the Message 
configuration.

XML error 
connector

Output connector for sending error messages in case of 
validation errors. See the XMLIN documentation for 
information about creating XMLIN validation error 
messages.

Expand external 
entities

Select to expand and process document references.
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The settings are described in the table below.

Setting Description

First Output from a First Event starts the Message structure. 
If there are no more Events in the Message configuration, 
or if the following Event in the Message is also a First 
Event, the Message structure only includes output from 
this Event.

Repeating Output from a Repeating Event is appended to the 
Message structure.

• If there are no preceding Events in the Message 
configuration, this option is the same as the First 
option.

• If there are no following Events in the Message 
configuration, this option is the same as the Last 
option.

Last Output from a Last Event is appended at the end of the 
Message structure.

If there are no preceding Events in the Message 
configuration, the Message structure only includes output 
from this Event.
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Runtime configuration menu commands and 
dialog boxes

In this section

• Runtime menu commands on page 254

• Runtime configuration view shortcut menu commands on page 255

• Edit Event Sort Definition dialog box on page 257

• Set Job Sender dialog box on page 258

• Runtime Output Connector Settings dialog box – Generic layer mode on 
page 259

• Runtime Output Connector Settings dialog box – Physical layer mode on 
page 273

• Runtime Event Settings dialog box on page 275

• Runtime Process Settings dialog box on page 277

• Edit Output Connector Settings dialog box on page 280

• Connector Selection Method dialog box on page 280

• Process Link Target Settings dialog box on page 281

• Service – <Message name> dialog box on page 282

Runtime menu commands
The Runtime menu is available when the Runtime configuration view is 
activated. It includes the commands described in the table below.

Command Description

Edit Platform Activate the Platform view.

New Job Add a new Runtime job to the Runtime configuration 
view.

Add Message Add a Message configuration to the selected Runtime 
job.

New Post-
processor

Add a new Post-processor to the Runtime configuration 
view.

Add Process link Add a Process link to the selected Post-processor.

Document Broker 
Plus

Activate Document Broker Plus for the runtime 
configuration.

Collapse all Jobs & 
Post-processors

Collapse all Runtime jobs and Post-processors in the 
Runtime configuration view. When a job is collapsed, all 
its Events, Processes, and connector links are hidden.
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Runtime configuration view shortcut menu commands
The Runtime configuration view shortcut menu (right-click the Runtime 
configuration view) includes the commands described in the table below.

Expand all Jobs & 
Post-processors

Expand all Runtime jobs and Post-processors in the 
Runtime configuration view. When a job is expanded, all 
its Events, Processes, and connector links are displayed.

Select Next Layer Activate the next layer node (physical or generic) in the 
Runtime configuration view.

Select Previous 
Layer

Activate the previous layer node (physical or generic) in 
the Runtime configuration view.

Command Description

Command Description

Edit Platform Activate the Platform view.

New Job Add a new Runtime job to the Runtime configuration 
view.

New Post-
processor

Add a new Post-processor to the Runtime configuration 
view.

Document Broker 
Plus

Activate Document Broker Plus for the runtime 
configuration.

Add Resource Set Connect resource sets to the Runtime configuration. 
Opens the Select Resource Sets dialog box, where you 
select resource sets to connect.

Remove Resource 
set

Disconnect resource sets from the Runtime 
configuration. Opens the Remove Resource Sets dialog 
box, where you select which resource sets to disconnect.

Collapse all Jobs & 
Post-processors

Collapse all Runtime jobs and Post-processors in the 
Runtime configuration view. When a job is collapsed, all 
its Events, Processes, and connector links are hidden.

Expand all Jobs & 
Post-processors

Expand all Runtime jobs and Post-processors in the 
Runtime configuration view. When a job is expanded, all 
its Events, Processes, and connector links are displayed.
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Go To Source Activate the source of the selected connector, Event, 
Process, or Process Link:

• Opens the Platform view with the selected 
connector highlighted.

• Opens the Message view with the selected Event or 
Process highlighted.

Add Message Add a Message configuration to the selected Runtime 
job.

Script Open the script editor. You can add Before and After 
scripts to Runtime jobs and Post-processors.

Edit Sort Definition Open the Edit Event Sort Definition dialog box, where 
you can specify sort keys for sorting the input before the 
output is generated.

Set Job Sender Open the Set Job Sender dialog box, where you can 
specify users as senders of the output job.

Connector Settings Open the Runtime Output Connector Settings dialog box. 
This is where you configure runtime specific output 
connector settings.

Delete Job Delete the selected Runtime job.

Edit Message Activate the Message view of the selected Message 
configuration.

Remove Message Remove the selected Message configuration from the 
Runtime configuration.

Settings This command is applicable to the following Runtime 
configuration objects:

• Event – open the Runtime Event Settings dialog 
box.

• Process – open the Runtime Process Settings 
dialog box.

• Output connector – open the Edit Output 
Connector Settings dialog box.

• Process link – open the Process Link Target 
Settings dialog box.

Connector 
Selection

Open the Connector Selection Method dialog box, where 
you specify which connector to use to send the output 
from the selected Process.

Command Description
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Edit Event Sort Definition dialog box
In the Event Sort Definition dialog box, you specify sort keys for sorting the input 
before the output is generated. You can, for example, use a Document trigger 
variable to sort the input before the Documents are generated.

Figure 122 The Event Sort Definition dialog box.

If you add several sort keys, the sort keys will be applied in the order (top-down) 
they are added to the list. The settings are described in the table below.

Enabled Enable/disable the selected Message configuration, 
Process, or output connector. Only applicable to physical 
layers.

Add Process Link Add a new Process Link to the selected Post-processor. 

Delete Post-
processor

Delete the selected Post-processor.

Copy Connector 
Settings

Copy the connector settings in the selected output 
connector. All generic settings (except for notes) will be 
copied.

Paste Connector 
Settings

Paste the connector settings (see Copy Connector 
Settings above) to the selected output connector.

Rename Rename the Message or the selected Runtime job or Post-
processor.

File Properties Open the Properties dialog box. The Properties dialog 
box shows the path to the Project file of the activated 
generic or physical layer. It also displays VCS 
information about the same file.

Command Description

Setting Description

Key A variable specified in the Message configuration (Event 
or script).
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Set Job Sender dialog box
In the Set Job Sender dialog box, you can specify users as senders of the output 
job. A sender can be validated against the internal users repository.

Figure 123 The Set Job Sender dialog box.

The settings are described in the table below.

Type Numeric or String. Specifies whether to sort in numeric 
or alphabetical order.

Sort order The sort order. Specifies whether to sort in ascending or 
descending order.

Add a new sort key to the list.

Edit the selected sort key.

Delete the selected sort key.

Move up the selected sort key.

Move down the selected sort key.

Setting Description

Setting Description

Default value Select if you do not want to specify a specific user as 
sender of the output.

Other Select if you want to specify a specific user as sender of 
the output. You can use variables.
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Runtime Output Connector Settings dialog box
In the Runtime Output Connector Settings dialog box, you configure the settings 
for the selected output connector. This dialog box has two modes:

• The Runtime Output Connector Settings dialog box – Generic layer mode, 
where you specify connector settings that apply to all physical layers.

• The Runtime Output Connector Settings dialog box – Physical layer mode, 
where you specify connector settings for each physical layer.

Runtime Output Connector Settings dialog box – 
Generic layer mode

This mode is activated in the Runtime Output Connector Settings dialog box 
when the generic layer is activated in the Runtime configuration view.

Figure 124 The Runtime Output Connector Settings dialog box – generic layer.

Validate sender Select if you want to validate the sender against the 
internal users repository. If the sender is not found in the 
internal users repository, the output will not be delivered.

Setting Description
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In this mode, the dialog box is divided into the icons and tabs shown in the table 
below.

Icon Tabs

The Global Settings icon is the entry point to the following tabs:

• General Settings tab

• Post-processor tab

The Job Begin icon is the entry point to settings applied at the 
beginning of the input job. You configure these settings on the 
following tabs:

• Device driver settings tab

• Device Driver Symbol Set tab

• Sheet Layout tab

• Side by Side tab

• OMR tab

• Labels tab

The Document Trigger icon is the entry point to the Document Trigger 
tab where you specify which variable to use as Document trigger.

The Document Begin icon is the entry point to settings applied at the 
beginning of each Document (Document specified by a Document 
trigger, or a document retrieved from the Post-processor repository). 
You configure these settings on the following tabs:

• Device driver settings tab

• Device Driver Symbol Set tab

• Stored Variables tab

• Sheet Layout tab

• OMR tab

• Labels tab
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The Process Begin icon is the entry point to settings applied at the 
beginning of the output from the selected Process or Process Link. You 
configure these settings on the following tabs:

• Device driver settings tab

• Device Driver Symbol Set tab

• Stored Variables tab

• Sheet Layout tab

• OMR tab

• Labels tab

• Archiving tab

The Page Begin icon is the entry point to settings applied at the 
beginning of each logical page in the documents delivered by the 
selected Process or Process Link. You configure these settings on the 
following tabs:

• Device Driver Symbol Set tab

• Stored Variables tab

• Sheet Layout tab

• OMR tab

• Labels tab

The Document End icon is the entry point to settings applied at the end 
of each Document (Document specified by a Document trigger, or a 
document retrieved from the Post-processor repository). You configure 
these settings on the following tabs:

• Stored Variables tab

• Process Sort Definition tab

• Archiving tab

The Job End icon is the entry point to settings applied at the end of the 
input job. You configure these settings on the following tabs:

• Enveloping tab

• Document Sort tab

• Archiving tab

Icon Tabs
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If any settings are configured on a tab, this is indicated by bold labels on the tab 
and on the icon below which the tab is located.

Figure 125 Bold labels on Job End icon and Document Sort tab.

Post-processing scripts

You can apply post-processing specific scripts to documents retrieved from a 
Post-processor repository. To enable scripting, you must select the appropriate 
Process Link in the Post-processor job when you open the dialog box. You can 
add scripts at the following levels:

• Job Begin – scripts to run before the job.

• Document Begin – scripts to run before each document.

• Process Begin – scripts to run before or after each Process document.

• Page Begin – scripts to run before or after each logical page.

• Document End – scripts to run after each Document.

• Job End – scripts to run after the job.

To launch the script editor, right-click the corresponding icon and select Script.

General Settings tab
On this tab, you can add notes to the connector.

Figure 126 The General Settings tab.
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The settings are described in the table below.

Post-processor tab
On this tab, you enable document sorting, enveloping of documents, and post-
processing scripts.

Figure 127 The Post-processor tab.

The settings are described in the table below.

Document Trigger tab
On this tab, you specify which variable to use as Document trigger.

Figure 128 The Document Trigger tab.

The settings are described in the table below.

Setting Description

Note Add notes to the connector. For example, a short 
description of what it is used for. Use Font to specify the 
note font, and the alignment buttons to specify how to 
align the text.

Setting Description

Enable Document 
Broker

Select to enable document sorting, enveloping of 
documents, and post-processing scripts.

Setting Description

Document trigger 
variable

The variable to use as Document trigger.
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Device driver settings tab
On this tab, you can configure device driver settings. At Process Begin you can 
override the default driver settings specified in the Platform. For some driver 
types you can also configure driver settings at Job Begin and Document begin. 
Some driver types, for example the AFP driver, have specific settings that you 
must configure at Job Begin and Document Begin.

Figure 129 The Device driver Settings tab.

The settings are described in the table below.

Device Driver Symbol Set tab
On this tab, you can override the symbol set specified for the connector. Only 
applicable when sending output to PCL printers.

Figure 130 The Device Driver Symbol Set tab.

Setting Description

Property/Value list Configure the settings of the selected device driver.

Alias Specify aliases for the driver settings. See Dynamic 
selection using aliases on page 143.

Use the following syntax in the lookup table:

Event.Process.Option.key_value   Value

For example:

ev1.pr1."Print Orientation:".DEN     Landscape
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When sending output to a PCL printer, there you can override the symbol set in 
the code page specified for the connector, and specify a different symbol set for 
the printer. The settings are described in the table below.

Sheet Layout tab
On this tab, you can create a sheet layout for the output documents. See the Sheet 
layout documentation for more information about sheet layouts.

Figure 131 The Sheet Layout tab.

The settings are described in the table below.

Setting Description

Override symbol 
set in default code 
page

Select to override the symbol set.

Static Select to use a static symbol set.

Lookup Select to use a lookup table to specify which symbol set 
to use. See Dynamic selection using aliases on page 143 
for information on how to use lookup tables.

Variable Select to use a variable to specify which symbol set to 
use. See Dynamic selection using aliases on page 143 for 
information on how to use variables for this purpose.

Setting Description

Sheet layout The sheet layout resource to use. 

Partition Specifies how to print logical pages on the partitions 
specified in the selected sheet layout.

First partition The partition where to print the first logical page.
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Side by Side tab
On this tab, you can specify which sheet layout to use for side by side printing (2 
up printing). This can be used when printing on output media that is larger than 
the actual sheet size defined for the output pages. For example, when printing two 
A4 side by side on an A3. See the Sheet layout documentation for more 
information about sheet layouts.

Figure 132 The Side by Side tab.

The settings are described in the table below.

OMR tab
On this tab, you can specify OMR codes for the output documents. See the 
Document sorting and bundling documentation for information about OMR 
codes.

Alias Specify aliases for Sheet layout, Partition, and First 
partition. See Dynamic selection using aliases on page 
143.

Setting Description

Setting Description

Sheet layout The sheet layout resource to use. 

Partition Specifies how to print logical pages on the partitions 
specified in the selected sheet layout. Normally you keep 
this empty for 2UP printing.

Alias Specify aliases for Sheet layout and Partition See 
Dynamic selection using aliases on page 143.
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Labels tab
On this tab, you can specify labels for the output documents. See the Document 
sorting and bundling documentation for more information about labels.

Figure 133 The Labels tab.

The settings are described in the table below.

Setting Description

Name The name of the label. Used only as an internal reference.

X (mm) The distance (in millimeters) between the left edge of the 
label and the left border of the sheet.

Y (mm) The distance (in millimeters) between the top edge of the 
label and the top border of the sheet.

Rotation (degrees) The clock-wise rotation (in degrees) of the label.

Side The side of the sheet where to print the label.

• None – Do not print the label.

• Front – Print the label on the front side of the sheet 
only.

• Back – Print the label on the back side of the sheet 
only.

• Both – Print the label on both sides of the sheet.
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Place on sheets The sheets in a document where to print the label.

• First – Prints the label on the first sheet in the 
document only.

• Last – Prints the label on the last sheet in the 
document only.

• Between – Prints the label on all sheets between 
first and last sheet in the document. Does not print 
the label on the first and last sheet.

• Not first – Prints the label on all sheets except the 
first sheet in the document.

• Not last – Prints the label on all sheets except the 
last sheet in the document.

• All – Prints the label on all sheets in the document.

Font The label text font.

Font size The label text font size.

Text The label text. You can use a combination of static text 
and variables. You can also use the following post-
processing specific (case sensitive) variables: 

• <%NumSheets> – The total number of sheets in the 
current document.

• <%MailMach> – The name of the mailing machine.

• <%EnvelNr> – The number of the current envelope. 
Every envelope gets a unique number when it is 
created.

• <DOCUMENT> – The number of the current document. 
Documents are numbered per segment (if defined) 
and mailing machine.

• <PAGEINJOB> – The number of the current logical 
page. Pages are numbered per segment (if defined) 
and mailing machine.

• <SHEETINJOB> – The number of the current sheet. 
Sheets are numbered per segment (if defined) and 
mailing machine.

• <PAGESINDOCUMENT> – The total number of logical 
pages in the current document.

• <PAGEINDOCUMENT> – The number of the current 
logical page in the current document.

• <SHEETINDOCUMENT> – The number of the current 
sheet in the current document.

Setting Description
StreamServe Persuasion SP5 Design Center User Guide Rev B



Runtime configuration menu commands and dialog boxes 269
Menus, menu commands, and dialog boxes in Design Center
Stored Variables tab
On this tab, you can specify variables to store when storing documents in the Post-
processor repository.

Figure 134 The Stored Variables tab.

The StreamServer application that retrieves the documents from the Post-
processor repository has no access to the variables used when the documents were 
created. To be able to use these variables, they must be stored together with the 
documents. On this tab, you specify which variables to store and make available 
for post-processing of the stored documents. The settings are described in the 
table below.

Add a new label to the list.

Edit the selected label.

Delete the selected label.

Move up the selected label.

Move down the selected label.

Setting Description

Setting Description

Variable The list of variables to store.

Add a new variable to the list.

Edit the selected variable.
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Process Sort Definition tab
On this tab, you can specify how to order logical pages in a Document. Note that 
this is for Documents specified by Document Triggers.

Figure 135 The Process Sort Definition tab and Edit Process Sort definition 
dialog box.

The settings are described in the table below.

Delete the selected variable.

Move up the selected variable.

Move down the selected variable.

Setting Description

Setting Description

Edit Process Sort 
Definition

Opens the Edit Process Sort Definition dialog box, where 
you specify the sort keys for sorting the pages in a 
Document.

You can use several sort keys, for example country code, 
area code, and customer number. The StreamServer will 
start with the first sort key in the list. You can use the Up/
Down arrows to move the sort keys in the list. 

Add a new sort key to the list.

Edit the selected sort key.

Delete the selected sort key.
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Archiving tab
On this tab, you can assign a document type to the documents delivered via the 
connector, and specify whether to archive the documents.

Figure 136 The Archiving tab.

The settings are described in the table below.

Move up the selected sort key.

Move down the selected sort key.

Setting Description

Setting Description

Document type Select the document type definition to use for the 
documents delivered via the connector. The document 
types must be available in a resource set connected to the 
Runtime configuration. Each document type definition 
resource contains metadata for a specific document type 
(invoice, order, etc.).

Collector Archive Select whether to archive the documents delivered via the 
connector, and make the documents available from the 
Collector web application. Select Yes to archive all 
documents, or use a variable to determine which 
documents to archive.

When using variables and scripting to determine which 
documents to archive, the variable must be set to true to 
archive and false to not archive (true and false are 
case sensitive).
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Enveloping tab
On this tab, you can specify how to handle enveloping of documents. See the 
Document sorting and bundling documentation for information about enveloping.

Document Sort tab
On this tab, you can specify how to sort documents.

Figure 137 The Document Sort tab.

Documents in this context are either Documents defined per Runtime job (using 
a Document trigger) or documents retrieved by a Post-processor. 

If enveloping is enabled, sorting is applied to documents within an envelope. You 
can, for example, use the payment due date as sort key in this case. 

If enveloping is not used, sorting is applied to all documents in the job. You can, 
for example, use the customer name or customer number as sort key in this case. 
The settings are described in the table below.

Device 
independent copy

Select to store device independent LXF copies of the 
archived documents. The copy can later be used to 
reprocess the document via StreamStudio Collector.

Storing device independent copies requires more space in 
the storage since they are stored in addition to the 
archived document.

Compress 
document in 
archive

Select to compress archived documents and device 
independent copies of the documents. Compressing 
documents may affect performance when processing the 
output, but each document occupies less space in the 
storage.

Setting Description

Setting Description

Key A metadata key specified for documents retrieved from a 
Post-processor repository, or a variable specified for 
Runtime job documents.
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Runtime Output Connector Settings dialog box – 
Physical layer mode

This mode is activated in the Runtime Output Connector Settings dialog box 
when a physical layer is activated in the Runtime configuration view. The context 
is either Process Begin, Document End, or Job End depending on the output mode 
specified for the connector in the Platform.

Figure 138 The Runtime Output Connector Settings dialog box – physical layer.

In this mode, the dialog box is divided into the following tabs:

• Connector type (File, Spool, etc.) tab

Type Numeric or String. Specifies whether to sort the 
documents in numeric or alphabetical order.

Sort order The sort order of the documents. Specifies whether to sort 
the documents in ascending or descending order.

Add a new sort key to the list.

Edit the selected sort key.

Delete the selected sort key.

Move up the selected sort key.

Move down the selected sort key.

Setting Description
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• Receiver tab

If any settings are configured on a tab, the label on this tab is bold.

Connector type (File, Spool, etc.) tab
On this tab, you can override the connector settings specified in the Platform. You 
specify the connector type and default connector settings in the Platform.

Figure 139 The “connector type” tab.

The settings are described in the table below.

Receiver tab
On this tab, you can specify users as receivers of the output delivered through the 
connector. A receiver can be validated against the external users repository.

Figure 140 The Receiver tab.

The settings are described in the table below.

Settings Description

Property/Value list Configure the settings of the selected connector type.

Setting Description

Default value Select if you do not want to specify a specific user as 
receiver of the output.

Other Select to assign specific users as receivers of the output. 
You can use variables.

Validate receiver Select to validate the receiver against the external users 
repository. If the receiver is not found in the external 
users repository, the output is not delivered.
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Runtime Event Settings dialog box
In the Runtime Event Settings dialog box, you can configure runtime specific 
settings for the selected Event.

Figure 141 The Runtime Event Settings dialog box.

This dialog box is divided into the following tabs:

• General tab – On this tab, you specify general Runtime Event settings.

• Code Page tab – On this tab, you specify code page settings for the Event.

General tab
On this tab, you specify general Runtime Event settings.

Figure 142 The General tab.

The settings are described in the table below.

Setting Description

Priority The priority level for the Event. The higher the number, 
the lower the priority. Applicable only if several Events 
within the same Runtime job are triggered by the same 
pattern.

Select 
automatically

Select to trigger the Event automatically. If not selected, 
the Event must be triggered using the AtJobEnd scripting 
function at the end of a job.
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Code Page tab
On this tab, you specify code page settings for the Event. See About code pages 
and Unicode support for more information.

Figure 143 The Code Page tab.

The settings are described in the table below.

Agent driven Applicable only to Connectivity Packs. See the 
corresponding Connectivity Pack documentation. 

Ignore remaining 
data

Select to ignore the remaining data when the trigger 
pattern is found. For example, when transmitting the 
entire input job via a RedirectOUT Process. The pattern 
must be extracted to identify the data to be transmitted, 
but the actual data is sent in its original format to the 
RedirectOUT Process. 

Setting Description

Setting Description

No change Use the code page specified for the input. This is either a 
code page filter added to the input connector, or a 
retrieved script added to the Event.

Lookup Use a lookup table to specify which code page to use. See 
Dynamic selection using aliases on page 143. The lookup 
table has the following syntax:

<key>    <code page>

Lookup table example

"Western Europe"   ISO 8859-1 

"Eastern Europe"   ISO 8859-2 

Turkish            ISO 8859-9 

Variable Use a script to specify which code page to use. See 
Dynamic selection using aliases on page 143.
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Runtime Process Settings dialog box
In the Runtime Process Settings dialog box, you can configure runtime specific 
settings for the selected Process.

Figure 144 The Runtime Process Settings dialog box.

This dialog box is divided into the following tabs:

• Rule tab – On this tab, you can specify rules for when to trigger the Process.

• General tab – On this tab, you can specify general Runtime Process 
settings.

Rule tab
On this tab, you can specify rules for when to trigger the Process.

Figure 145 The Rule tab.

A rule accepts the operators AND, OR, and NOT.

Input order This Lookup and Variable parameter specifies the 
ordering of characters in bidirectional input text.

• Logical order – Select if the input does not contain 
Arabic or Hebrew text in visual order.

• Visual order – Select only if the input contains 
Arabic or Hebrew text in visual order. The text is 
reordered to logical order. 

Setting Description
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General tab
On this tab, you can specify general Runtime Process settings. Some settings are 
Process type specific.

General tab for all Process types but PageOUT and MessageOUT

General tab for PageOUT

Setting Description

Select 
automatically

Select to trigger the Process automatically. If not selected 
the Process must be triggered using the CallProc 
scripting function.

Note: Composition Center enabled StoryTeller 
Processes are always automatically triggered, 
even if this setting is not selected.

Setting Description

Select 
automatically

Select to trigger the Process automatically. If not 
selected, the Process must be triggered using the 
CallProc scripting function.

Mirror PageOUT Select to mirror the object layout in PageOUT. 

Mirroring variable Use a variable to determine whether to mirror the object 
layout. If no variable is specified, the layout is always 
mirrored. 

The variable must return 0 or 1: 

1 - layout is mirrored. 

0 - layout is not mirrored. 
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General tab for MessageOUT

General tab for StoryTeller and Adobe LiveCycle Designer ES

Setting Description

Select 
automatically

Select to trigger the Process automatically. If not 
selected, the Process must be triggered using the 
CallProc scripting function.

Include variables in 
output

Select to include scripting variables in the output. You 
cannot include arrays or variables specified in after 
Process and after Message scripts.

Setting Description

Select 
automatically

Select to trigger the Process automatically. If not 
selected, the Process must be triggered using the 
CallProc scripting function.

Automatic Doc 
Trigger

Select to create document boundaries automatically for 
each Process.

Discard output on 
failure

Select to discard the output when an error occurs in the 
Process (e.g. a substitution cannot be found, or an XFA 
template contains errors).

If selected, all output created by the Process (e.g. a PDF 
file) is discarded, and the job is marked as failed. 

If not selected, some output (or no output) is forwarded 
to the driver. The driver will try to process the output and, 
for example, create an empty PDF file or a PDF file that 
only contains the pages up to the page that failed.

In both cases the job is marked as failed, and 
StreamServer will retry to process the job depending on 
the settings on the input queue.
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Edit Output Connector Settings dialog box
The Edit Output Connector Settings dialog box opens when you double-click an 
output connector (or right-click and select Settings) in the Runtime configuration 
view. From this dialog box, you open the Runtime Output Connector Settings 
dialog box in the appropriate context.

Figure 146 The Edit Output Connector Settings dialog box.

There are different contexts for configuring the output connector – you can 
configure the connector per Runtime job, Process in a Runtime job, Post-
processor, or Process Link in a Post-processor. You specify the context by 
selecting an option in this dialog box and clicking OK.

Connector Selection Method dialog box
In the Connector Selection method dialog box, you can specify through which 
connector to deliver the output from the selected Process.

Figure 147 The Connector Selection Method dialog box.

The standard method to create a static connection between a Process and output 
connector is to draw a line between them (click-draw-release). In this dialog box, 
you have the option to create a dynamic connection using aliases (see See 
Dynamic selection using aliases on page 143). The settings are described in the 
table below.

Setting Description

None Select if you do not want to connect the Process to any 
output connector.
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Process Link Target Settings dialog box
In the Process Link Target Settings dialog box, you can view the target Message 
and target Process for the selected Process Link. If the selected Process Link is 
not a Default Process Link, you can edit the Process Link target.

Figure 148 The Process Link Target Settings dialog box.

The settings are described in the table below.

Static Select if you want to create a static connection between 
the Process and an output connector. Use Connector 
below to select the connector.

Connector Select the static connector. 

Lookup Use a lookup table to select the connector. The lookup 
table has the following syntax:

<key>    <connector>

Lookup table example

"Mike Jones"   Printer1 

"Jane Smith"   Printer2

Variable Use a script to select the connector.

Default connector Select the default connector. The output is sent to this 
connector if there is no match in the lookup table or 
script.

Setting Description

Setting Description

Target Message Displays the current target Message.

Target Process Displays the current target Process.

Set Process LInk 
Target

Select to change the target Message or target Process. A 
dialog box opens where you can select the appropriate 
Message and Process.
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Service – <Message name> dialog box
In the Service – <Message name> dialog box, you enable a Message to be 
invoked through service requests. Based on one Runtime configuration, external 
applications (for example, Ad Hoc Correspondence, Correspondence Reviewer, 
or Composition Center) then use services to create, preview, or release Messages. 
Depending on the type of service request, the service gateway invokes the correct 
service.

If the Message is to be paused by an exception rule, for example as for 
Correspondence Reviewer, you must select the rule resource in the dialog box.

Figure 149 The Service <Message name> dialog box

The settings are described in the table below.

Setting Description

Service Select to enable a Message to be invoked by service 
requests.

Use default 
preview 
connector

Applicable if the expected content type from the preview 
service request is application/pdf or image/tiff.

Select to use a default output connector for previewing the 
Message in the external application. 

The connector is pre-configured with certain settings (for 
compression, resolution, etc.) and uses output mode Job.

The connector is not visible in the Platform configuration.

Service name Enter a descriptive name of the service.

The name must be unique within the application domain.
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Rule Applicable if the Message is to be paused by an exception 
rule.

Select the exception rule resource that pauses the Message. 

If you select several rule resources, the exception rules are 
evaluated, one by one, until one rule is evaluated as true or 
all rules are evaluated.

Setting Description
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Resource set menu commands and dialog 
boxes

In this section

• Resources menu commands on page 284

• Resource set view shortcut menu commands on page 285

• Select Fonts dialog box on page 287

• Resource Type Settings dialog box on page 287

• Set Resource Editor dialog box on page 289

• Show Dependencies dialog box on page 291

Resources menu commands
The Resources menu is available when the resource set view is activated. It 
includes the commands described in the table below.

Command Description

New Resource Create a new resource, and add it to the resource set. The 
new resource is configured using a resource editor.

Add Resource Add an existing resource to the resource set. You must 
browse to and select the resource file.

Import Create a new resource, and add it to the resource set. The 
new resource is created by importing an existing source 
file.

Import Font Create new font resources and add them to the resource 
set. This command opens the Select Fonts dialog box 
where you select and import the fonts from the Fonts 
directory.

Import from Adobe 
LiveCycle 
Repository

Opens the Select resource browser. Used to browse for 
and select a resource in the LiveCycle ES2 repository. 
When a resource is selected, the Import Adobe LiveCycle 
Repository Resource dialog box opens.

Start Editor Open the editor of the selected resource.

Stop Editor Exit the editor of the selected resource.

Update From 
Origin

Update the selected resource with the changes made in 
the source file. Only applicable to resources created using 
the Import command.

Extract To File Extract the data embedded in the selected resource to a 
file.
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Resource set view shortcut menu commands
The resource set view shortcut menu (right-click nodes in the resource set view) 
includes the commands described in the table below.

Update all Adobe 
LiveCycle 
Resources

Opens the Update all Adobe LiveCycle Repository 
resources dialog box. 

Synchronize 
Document Types

Synchronizes Document type GUIDs. Used when 
upgrading.

Command Description

Command Description

New • Add a new folder to the resource set.

• Create a new resource, and add it to the resource 
set. The new resource is configured using a 
resource editor.

Add Resource Add an existing resource to the resource set. You must 
browse to and select the resource file.

Import Create a new resource, and add it to the resource set. The 
new resource is created by importing an existing source 
file.

Import Font Create new font resources and add them to the resource 
set. This command opens the Select Fonts dialog box 
where you select and import the fonts from the Fonts 
directory.

Import from Adobe 
LiveCycle 
Repository

Opens the Select resource browser. Used to browse for 
and select a resource in the LiveCycle ES2 repository. 
When a resource is selected, the Import Adobe LiveCycle 
Repository Resource dialog box opens.

Start Editor Open the editor of the selected resource.

Stop Editor Exit the editor of the selected resource.

Obtain Write Lock Lock the selected resource. If you lock a resource, only 
you can edit the resource.

Note: You can use write locks only if Design Center is 
connected to a Version Control System (CVS in 
this release).

Release Write Lock Unlock the selected resource. If you unlock a resource, 
you cannot edit the resource.
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Reload Component Revert to the latest saved version of the selected resource.

Update From 
Origin

Update the selected resource with the changes made in 
the source file. Only applicable to resources created using 
the Import command.

Extract To File Extract the data embedded in the selected resource to a 
file.

Copy Copy the selected resource.

Paste Paste the copied resource.

Delete Delete the selected resource.

Rename Rename the selected resource.

Update all Adobe 
LiveCycle 
Resources

Opens the Update all Adobe LiveCycle Repository 
resources dialog box. 

Synchronize 
Document Types

Synchronizes Document type GUIDs. Used when 
upgrading.

File Properties Display the path to, and VCS information about, the 
selected resource or resource set file.

Resource Type Open the Resource Type Settings dialog box, where you 
can specify the type of the selected resource.

Resource Editor Open the Set Resource Editor dialog box, where you can 
specify the editor to use when editing the selected 
resource.

Show 
Dependencies

Open the Show Dependencies dialog box, where you can 
see where the selected resource is used. Only applicable 
to the following resource types:

• Image

• Overlay

• Sheet Layout

• Metadata Group

• Rule

Command Description
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Select Fonts dialog box
In the Select Fonts dialog box, you can import fonts from the Fonts directory to 
the resource set.

Figure 150 The Select Fonts dialog box.

The settings are described in the table below.

Resource Type Settings dialog box
In the Resource type Settings dialog box, you can specify the resource type of the 
resources. The dialog box opens automatically when you create resources using 
the Import command. You can also use this dialog box to change the resource type 
of resources (right-click the resource and select Resource type). 

Figure 151 The Resource Type Settings dialog box.

The resource types are described in the table below.

Setting Description

Available fonts Lists all available fonts in your Windows Fonts 
directory. You select the fonts to import from this list.

Fonts to import These fonts will be imported to the resource set.

Add Add the selected fonts to Fonts to import.

Remove Remove the selected fonts from Fonts to import.

Resource type Description

Certificate Certificates used for encryption and authentication. The 
certificate files (*.cer, *.crt etc.) must be imported.
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Description Description files used by StreamIN configurations.

Document Type Document type resources. Document types are used to 
categorize documents, such as, invoices, account 
statements and letters. 

Filter Chain Filter chains that can be connected to input and output 
connectors. A filter chain can contain several filters.

Font Fonts.

Function Function files. A function file is a text file containing user 
created script functions.

Generic Imported files that do not belong to any of the standard 
types. This type is included in the export.

Image Image files (*.gif, *.jpeg, etc.).

Layout Template Layout template files.

Metadata Group A group of metadata that can be added to the appropriate 
document type.

Non-exportable Files that you do not want to include in the export. You 
may for example import a Word or Excel document to the 
Project as an attachment for information.

OutputPlus 
configuration

OutputPlus configuration files. Only applicable to SAP 
Output+.

Overlay LXF overlays that can be included in a PageOUT 
configuration.

Post-processor 
Query

Post-processor queries.

Printer Overlay Printer overlays that can be included in a PageOUT 
configuration. The printer overlay is a PRN, PCL, or PS file 
sent separately to the printer, and the preview file used in 
the PageOUT tool can be any type of image file (EMF, 
WMF, JPEG, etc.).

Private Key Private keys used for encryption and authentication. The 
private key files (*.pfx, *.p12, etc.) must be imported.

RDI Setting Used to import an existing incparam file. Only 
applicable to SAP E-docs.

Resource type Description
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Set Resource Editor dialog box
In the Set Resource Editor dialog box, you can specify which editor to use when 
editing resources.

Figure 152 The Set Resource Editor dialog box.

The settings are described in the table below.

Rule Rule functions used in rules. The rules can be used as 
exception rules to pause Messages before they are 
formatted and delivered. If imported into StreamStudio 
Composition Center, the rules can be used as selection 
rules on resources and document definitions. 

Sample Sample files 

Security 
Configuration

Security configurations used for encryption and 
authentication.

Sheet Layout Sheet layouts.

StoryTeller 
Document

StoryTeller documents.

SXD File SXD files.

Table Table files.

XDP Template XDP templates.

XML Stylesheet XML stylesheets.

Resource type Description

Setting Description

Use default 
resource editor

Select to use the default editor for the selected resource. 
Only native resource types have default resource editors. 
See Default resource editors below.

Pick resource 
editor

Select to specify an editor for the selected resource. You 
must browse to and select the appropriate resource editor.
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Default resource editors

The table below shows the default editors for the native resource types.

Resource type Default resource editor

Description file UTF8 Edit

Document Type Document Type Editor

Filter Chain Filter Chain Editor

Function file Script Editor

Layout Template UTF8 Edit

Metadata Group MetaData Group Editor

OutputPlus configuration UTF8 Edit

Overlay Overlay Editor

Post-processor Query Post-processor Repository Tool

RDI Setting UTF8 Edit

Rule Rule Editor

Sample UTF8 Edit

Security configuration Security Editor

Sheet Layout Sheet Layout Editor

StoryTeller Document StoryTeller tool

SXD file UTF8 Edit

Table file UTF8 Edit

XDP Template UTF8 Edit

XML Stylesheet UTF8 Edit
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Show Dependencies dialog box
In the Show Dependencies dialog box, you can see all objects (overlays, 
Processes, etc.) where the selected resource is used.

Figure 153 The Show Dependencies dialog box.

All objects are displayed in a list. You can click the column labels to set the sort 
criterion. The settings are described in the table below.

Setting Description

Name The name of the object where the resource is used.

Type The type of object (PageOUT, Sheet Layout, etc.) where 
the resource is used.

Location The location of the object where the resource is used.

Go to selected item Activate the view that contains the object where the 
resource is used. The object is highlighted in the view.
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Version Control menu commands and dialog 
boxes

In this section

• Version Control menu commands on page 292

• Manage Connections dialog box on page 293

• Add connection dialog box on page 294

• Edit connection dialog box on page 295

• Add to version control dialog box on page 296

• Check in dialog box on page 297

• Check out dialog box on page 298

• Check out multiple files or folders dialog box on page 299

• Release Locked Components in VCS dialog box on page 300

Version Control menu commands
The Version Control menu is available when selecting File > Version Control. 
This menu includes the commands described in the table below.

Command Description

Manage 
Connections

Open the Manage Connections dialog box, where you 
can:

• Create new VCS connections.

• Edit VCS connections.

• Rename VCS connections.

• Delete VCS connections.

• Select a VCS connection and connect to the VCS.

Connect to Connect to the VCS. Contains a sub menu, where you 
specify the VCS connection to use.

Disconnect Disconnect from the VCS.

Add Selected Opens the Add to version control dialog box, where you 
specify which Project nodes to add to the VCS. This 
command applies to the selected Project node and related 
nodes (nodes with dependencies to the selected node).

Add Multiple Opens the Add to version control dialog box, where you 
specify which Project nodes to add to the VCS. This 
command applies to all Project nodes.
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Manage Connections dialog box
In the Manage Connections dialog box, you manage all Design Center VCS 
connections.

Figure 154 The Manage Connections dialog box.

The settings are described in the table below.

Check In Selected Opens the Check in dialog box, where you specify which 
Project nodes to check in to the VCS. This command 
applies to the selected Project node and related nodes.

Check In Multiple Opens the Check in dialog box, where you specify which 
Project nodes to check in to the VCS. This command 
applies to all Project nodes.

Check Out 
Selected

Opens the Check out dialog box, where you specify 
which version of the selected Project node to check out. 
This command applies to the selected Project node.

Check Out Multiple Opens the Check out multiple files or folders dialog box, 
where you specify which Project nodes, and which 
version of the Project nodes, to check out. This command 
applies to all Project nodes.

Create Release Creates an export package, and checks in the export 
package in the VCS.

Command Description

Setting Description

Select connection All available VCS connections are displayed in this list.

Add Open the Add connection dialog box, where you can add 
a new VCS connection. Before this dialog box opens, you 
are prompted to select the type of connection, and to 
specify a name for the connection. Currently, only the 
type CVS is available.
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Add connection dialog box
In the Add connection dialog box, you specify the settings for the new VCS 
connection.

Figure 155 The Add connection dialog box.

Rename Rename the selected VCS connection. This option is 
disabled if the connection is active.

Edit Open the Edit connection dialog box, where you can edit 
the selected VCS connection. This option is disabled if 
the connection is active.

Delete Delete the selected VCS connection. This option is 
disabled if the connection is active.

Connect Connect Design Center to the VCS, and use the selected 
VCS connection.

Setting Description
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The settings are described in the table below.

Edit connection dialog box
In the Edit connection dialog box, you edit the settings for existing CVS 
connections. The settings are identical to the Add connection dialog box settings.

Setting Description

Protocol The access method to CVS.

• local – Access a CVS repository directory on the 
same machine. Used if Design Center and CVS 
runs on the same machine.

• pserver – Access a CVS repository on a remote 
machine via a password authenticating server.

• server – Access a CVS repository on a remote 
machine using an internal rsh client..

• ssh – Access a CVS repository on a remote 
machine using ssh.

• ext – Access a CVS repository on a remote machine 
using an external rsh program.

User name The user name to access the CVS server.

Host name The CVS server host.

Port The port number to access the CVS server.

CVSROOT The CVS repository address.

CVS module The base module for the Project in CVS.

Local module path The Design Center Project folder (working directory) 
that contains the Design Center files you are working 
with. 

Use CVSROOT 
environment 
variable

For CVS experienced users only. If you select this option, 
you only have to enter the CVS Module name. The 
CVSROOT environment variable is used for calls to CVS.
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Add to version control dialog box
In the Add to version control dialog box, you add new Design Center files to the 
VCS.

Figure 156 The Add to version control dialog box.

The settings are described in the table below.

Setting Description

Comment Comments for the added files.

Enable revision 
label

Select to specify a label for the checked in files.

Label The label for the added files.

Components to 
add

Lists all components you can add to the VCS. You must 
check all the components you want to add.
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Check in dialog box
In the Check in dialog box, you check in Design Center files to the VCS.

Figure 157 The Check in dialog box.

The settings are described in the table below.

Setting Description

Comment Comments for the checked in files.

Force check in Select to check in files that are older than the tip revision.

Enable revision 
label

Select to specify a label for the checked in files.

Label The label for the checked in files.

Components to 
check in

Lists all components you can check in to the VCS. You 
must check all the components you want to check in.
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Check out dialog box
In the Check out dialog box, you check out the Design Center file of the Project 
node selected in the Project browser.

Figure 158 The Check out dialog box.

The settings are described in the table below.

Setting Description

Force check out Select to overwrite any files with the same name in your 
working folder, even if they are more recent.

Current revision Check out the most current revision (the tip revision).

Revision Specify which revision to check out.

Label Specify a label, and check out the file with that label.

As of Check out the revision that was the tip revision at the 
specified date and time.
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Check out multiple files or folders dialog box
In this dialog box, you can check out multiple Design Center files.

Figure 159 The Check out multiple files or folders dialog box.

The settings are described in the table below.

Setting Description

Folders Displays all CVS folders that contain the files. You must 
select the folder that contains the files you want to check 
out. 

Components Displays all files in the selected folder. You can use 
Custom filter, Show all descendants, and Files of type 
below to determine which files to display.

Show all 
descendants

Select to display files in sub folders below the selected 
folder.

Custom filter Custom filter that enables you to specify which files to 
display in the Components list. For example, to display 
only files with names beginning with Invoice, you can 
enter Invoice* and press ENTER.

Files of type Select which file types to display.

Open checked out 
Design Center files

Select to open the Design Center files when they are 
checked out.

Force check out Select to overwrite any files with the same name in your 
working folder, even if they are more recent.
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Release Locked Components in VCS dialog box
In the Released Locked Components in VCS dialog box, you can release locked 
Design Center files when you exit Design Center.

Figure 160 The Released Locked Components in VCS dialog box.

The settings are described in the table below.

Check out method Opens the Check out method dialog box, where you 
specify which revision of the selected files to check out. 

• Current revision – Check out the most current 
revision (the tip revision).

• Revision – Specify which revision to check out.

• Label – Specify a label, and check out the file with 
that label.

• As of – Check out the revision that was the tip 
revision at the specified date and time.

Recursive check 
out

Select to check out all files in all sub folders below the 
selected folder.

Setting Description

Setting Description

Release Selected Click to release the locks from the selected files and then 
exit Design Center.

Release None Click to exit Design Center without releasing any locks.
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